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1. Introduction to MCUXpresso IDE

1.1

MCUXpresso IDE User Guide -

MCUXpresso IDE version 10.3.0 is a low-cost microcontroller (MCU) development platform
ecosystem from NXP. It provides an end-to-end solution enabling engineers to develop
embedded applications from initial evaluation to final production.

The MCUXpresso platform ecosystem includes:

. - a software development environment for creating applications for
NXP’s ARM Cortex-M based MCUs including “LPC”, “Kinetis” and iMX RT" ranges.

. (introduced in MCUXpresso IDE version 10.1), comprising
of Pins, Clocks and Peripherals Tools that are designed to work with SDK projects and are
fully integrated and installed by default.

. | each offering a package of device support and example software
extending the capability and part knowledge of MCUXpresso IDE.

e The range of LPCXpresso development boards, each of which includes a built-in “LPC-
Link”, “LPC-Link2", or CMSIS-DAP compatible debug probe. These boards are developed in
collaboration with Embedded Artists.

* The range of Tower and Freedom development boards, most of which include an OpenSDA
debug circuit supporting a range of firmware options.

e Therange of IMX RT Series EVK development board which include an OpenSDA debug circuit
supporting a range of firmware options, or high performance FreeLink (LPC-Link2 compatible)
debug probe.

¢ The standalone “LPC-Link2" debug probe.

This guide is intended as an introduction to using MCUXpresso IDE. It assumes that you have
some knowledge of MCUs and software development for embedded systems.

Note: MCUXpresso IDE incorporates technology and design from LPCXpresso IDE. This means
that users familiar with LPCXpresso IDE will find MCUXpresso IDE looks relatively familiar.

MCUXpresso IDE Overview of Features

MCUXpresso IDE is a fully featured software development environment for NXP's ARM-
based MCUs, and includes all the tools necessary to develop high-quality embedded software
applications in a timely and cost effective fashion.

MCUXpresso IDE is based on the Eclipse IDE and includes the industry standard ARM GNU
toolchain. It brings developers an easy-to-use and unlimited code size development environment
for NXP MCUs based on Cortex-M cores (LPC, Kinetis and iMX RT). The IDE combines the best
of the widely popular LPCXpresso and Kinetis Design Studio IDEs, providing a common platform
for all NXP Cortex-M microcontrollers.

MCUXpresso IDE is a free toolchain providing developers with no restrictions on code or
debug sizes. It provides an intuitive and powerful interface with profiling, power measurement
on supported boards, GNU tool integration and library, multicore capable debugger, trace
functionality and more. MCUXpresso IDE debug connections support Freedom, Tower, EVK,
LPCXpresso and custom development boards with industry leading open-source and commercial
debug probes including LPC-Link2, P&E and SEGGER.

The fully featured debugger supports both SWD and JTAG debugging, and features direct
download to on-chip and external flash memory.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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1.1.1

MCUXpresso IDE User Guide -

For the latest details on new features and functionality, please visit:

http://www.nxp.com/mcuxpresso/ide

Summary of Features

Complete C/C++ integrated development environment

« Eclipse-based IDE with many ease-of-use enhancements
 Built on Eclipse Oxygen 3 and CDT 9.4
e The IDE installs with Eclipse Plugins offering
e Git, FreeRTOS and support for P&E Micro debug probes
« The IDE can be further enhanced with many other Eclipse plugins
¢ Command-line tools are included for integration into build, test, and manufacturing systems

Industry standard GNU toolchain GCCv7 2018g2-update including:

¢ C and C++ compilers, assembler, and linker
e Converters for SREC, HEX, and binary

Advanced project wizards

¢ Simple creation of pre-configured applications for
» Extendable with
« Device-specific support for NXP’'s ARM-based MCUs (including LPC, Kinetis and iMX RT)

. of linker scripts for correct placement of code and data into Flash
and RAM

« Extended support for flexible placement of
Automatic generation of MCU-specific startup and device initialization code
Note: No assembler required with Cortex-M MCUs

Advanced multicore support

* Provision for for each core in multicore MCUs

¢ Debugging of within a single IDE instance, with the ability to link
various debug views to specific cores

Fully featured native debugger supporting SWD and JTAG connection via LinkServer

¢ Built-in optimized for internal and SPI Flash
¢ High-level and instruction-level

. and

* Views of CPU and on-chip

e Support for multiple devices on the JTAG scan-chain

Full install and integration of 3rd party debug solutions from:

* v3.6.7

¢ v6.34f

Library support
¢ Redlib: a small-footprint embedded C library

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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1.1.2

MCUXpresso IDE User Guide -

* RedLib-nf: a smaller footprint library offering reduced fprintf support
* RedLib-mb: a library variant offering enhanced semihosting performance
¢ Newlib: a complete C and C++ library
« NewlibNano: a new small-footprint C and C++ library, based on Newlib
¢ LPCOpen MCU software libraries
« Cortex Microcontroller Software Interface Standard (CMSIS) libraries and source code
« Extendible support per device via MCUXpresso SDKs

Trace functionality
« Instruction trace via Embedded Trace Buffer (ETB) on certain Cortex-M3/M4/M7 based MCUs
or via Micro Trace Buffer (MTB) on Cortex-M0+ based MCUs

» Providing a snapshot of application execution with linkage back to source, disassembly and
profile

e SWO Trace on Cortex-M3/M4 based MCUs when debugging via LPC-Link2, providing
functionality including:

* Profile tracing

« Interrupt tracing
« Datawatch tracing
e Printf over ITM

* NOTE now extended to work with P&E Micro and SEGGER J-Link, in addition to native
LinkServer

LinkServer Power Measurement

¢ On LPCXpresso boards, sample power usage at adjustable rates of up to 200 ksps; average
power usage display option

« Explore detailed plots of collected data in the IDE

« Export data for analysis with other tools

MCUXpresso Configuration Tools
¢ Introduced in MCUXpresso IDE version 10.1.0, | designed
to work with SDK projects are fully integrated and installed by default, comprising:
* Pins Tool
» Clocks Tool
 Peripherals Tool
« Note: Now updated to version 5.0

Supported Debug Probes

MCUXpresso IDE installs with built in support for 3 debug solutions. This support includes the
installation of all necessary drivers and supporting software.

Note: Certain mbed boards require a serial port driver to be recognised and this one exception
must be installed separately for each board. The driver is linked from Help -> Additional
Resources -> MBED Serial Port Driver Website

In normal use MCUXpresso IDE presents a similar interface and array of features for each of
the solutions listed below:s

Native LinkServer (including CMSIS-DAP) as also used in LPCXpresso IDE

« this supports a variety of debug probes including OpenSDA programmed with CMSIS-DAP
firmware, LPC-Link2 etc.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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¢ https://community.nxp.com/message/630896

P&E Micro

« this supports a variety of debug probes including OpenSDA programmed with P&E compatible
firmware and MultiLink and Cyclone probes

¢ http://www.pemicro.com/

SEGGER J-Link

e this supports a variety of debug probes including OpenSDA programmed with J-Link
compatible firmware and J-Link debug probes

¢ https://lwww.segger.com/

Please see for more details.

Note: Kinetis Freedom and Tower boards typically provide an on-board OpenSDA debug circuit.
This can be programmed with a range of debug firmware including:
* mBed CMSIS-DAP — supported by LinkServer connections

¢ DAP-Link — supported by LinkServer connections (DAP-Link is preferred to mBed CMSIS-DAP
when available)

¢ J-Link — supported by SEGGER J-Link connections
¢ P&E — supported by P&E connections

The default firmware can be changed if required, for details of the procedure and range of
supported firmware options please information visit: http://www.nxp.com/opensda

Tip

@ Under Windows 10, OpenSDA Bootloaders might experience problems and the
OpenSDA LED will blink an error code. The following article discusses the problem
and how it can be fixed: https://mcuoneclipse.com/2018/04/10/recovering-opensda-
boards-with-windows-10

1.1.3 Development Boards

NXP have a large range of development boards that work seamlessly with MCUXpresso IDE
including:

LPCXpresso Boards for LPC

These boards provide practical and easy-to-use development hardware to use as a starting point
for your LPC Cortex-M MCU based projects.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Figure 1.2. LPCXpresso Development Board (LPCXpresso54608)

For more information, visit: http://www.nxp.com/lpcxpresso-boards
Freedom and Tower Boards for Kinetis

Similarly, for Kinetis MCUs there are many development boards available including the popular
Freedom and Tower ranges of boards.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Figure 1.3. Tower (TWR-KV58F220M)

For more information, visit: http://www.nxp.com/pages/:TOWER_HOME

Figure 1.4, Freedom (FRDM-K64F)

For more information, visit: http://www.nxp.com/pages/:FREDEVPLA
iMX RT Crossover Processor Boards

iMX RT based boards bring the convergence of low power applications processors with high-
performance microcontrollers.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Figure 1.5. i.MX RT Series (MIMXRT1050-EVK)

For more information, visit: https://www.nxp.com/pages/:IMX-RT-SERIES
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2. New Features in MCUXpresso IDE 10.3.0

MCUXpresso IDE User Guide -

The MCUXpresso IDE team are pleased to bring a host of new features to this release continuing
our strategy of both customer focused and general product improvements, including:

Product

« Major product restructuring to support the roll out of (new features/bug
fixes) to existing installations via the Eclipse Software update mechanism

e Config Tools now updated to version 5
* SDK support now updated to version 2.50
« SDK installation improved options, see

¢ Windows version now uses Busybox (from the GNU MCU Eclipse Windows Build Tools project)
to provide Unix-like layer for GCC tools

« Scripts to create a command line environment now suplied in DOS and Bash forms

IDE

¢ New automatically displayed (for LinkServer) should a CPU fault occur

e Improved with enhanced display and grouping options

. are now only automatically generated for the selected build
configuration

e Project can now be edited in place for settings and wizards

* Project Explorer view enhanced to display current project build configuration for the selected
project (also displayed in Quickstart view)

¢ Support for new MCUs based on the ARM Cortex M33

Projects

¢ Project associated SDK (MCU) can now be flexibly managed, maintaining existing memory
configuration if desired see

Debug

¢ SWO trace features are now available for SEGGER JLINK and P&E Micro debug probes in
addition to LinkServer LPC-Link2

e LinkServer LPC-Link2 firmware now softloaded as v5.224 and offers faster operation and
improved flash programming performance

« LinkServer debug probes now support selection via their serial number (for commandline use)

LinkServer Flash Programming

. extended to support iMX RT MCUs
« Programming of data flash regions on certain Kinetis parts is now supported
« Improved flash programming performance and reliability

SDK

« SDK part support is now generated within the current workspace eliminating issues that could
arise if multiple IDEs were launched.

 part support is intelligently regenerated when required avoiding unnecessary delays
* SDK location can now be set via a workspace preference.
« Installed SDK view improved to display version information and enhanced tooltips

Please also see the supplied ReadMe document for further information and details of bug fixes
etc. This document is located within the products installation folder.
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2.1 New Features introduced in MCUXpresso IDE version 10.2.0
Product
¢ All previous Pro Edition features have been incorporated into the standard Free edition
and the Pro edition has been discontinued
« Built upon latest Eclipse Oxygen and offering significantly faster project builds
e includes a new
IDE
¢ Redesigned
 with links for for all supported Debug Solutions
e Support for new MCUs both via internal part support and also new version 2.4 SDKs
Debug
* Increased integration of our supported debug solutions including:
. is re-architected to provide support for LinkServer, P&E and
SEGGER debug solutions
« offering binary flash programming and erase capability for all supported debug solutions
» with a feature set integrated into the QuickStart panel, project Launch Configurations and
from the IDE as before
« Instruction trace is seamlessly supported by LinkServer, P&E and SEGGER debug solutions
. including printf are further optimised to deliver
approximately double the performance of the previous release
. via new library variant Redlib MB and
LinkServer which can deliver both a further increase in performance and no disruption to code
executing with time critical interrupts
e LinkServer
 Live global variable values can now be traced both in graphical and tabular forms
. to simplify complex peripheral views
Flash Programming
e LinkServer via self configuring flash
drivers using JEDEC SFDP (Serial Flash Discovery Protocol) for LPC18/43, LPC546xx,
LPC540xx (iMX RT to be made available post release)
Projects
* Many enhancements for improved includng:
» Drag and Drop of projects for import and export
« Options for project local inclusion of: SDK part support, flash drivers, and LinkServer connect
and reset scripts
. introduced to enable easy visibility and editing of project
configurations
. for all debug solutions delivered via project launch
configurations
Linker
« Enhanced managed linker support including:
. support for sophisticated boot strategies
. across multiple RAM regions
SDK
* SDK Manifest Analyser to provide visibility of SDK XML description
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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» Easy access to
« Extension of SDK Component Management to allow
e improved SDK Component Management

General Improvements in SDK Handling including:

« SDK version string now present and reported in SDK view (SDK version 2.4 only)
 user selection of versioned internal XML descriptions (enabled via preference)
 better automatic support for SDKs with overlapping capabilities

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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3. IDE Overview

The following chapter provides a high level overview of the features offered by the IDE itself.

3.1 Documentation and Help

MCUXpresso IDE is based on the Eclipse IDE framework, and many of the core features
are described well in generic Eclipse documentation and in the help files to be found on the
MCUXpresso IDE’s Help -> Help Contents menu. It also provides access to the MCUXpresso
IDE User Guide (this document), as well as the documentation for the compiler, linker, and other

underlying tools.

MCUXpresso IDE documentation comprises a suite of documents including:

* MCUXpresso IDE Installation Guide

« MCUXpresso IDE User Guide (this document)

e MCUXpresso IDE LinkServer SWO Trace Guide

« MCUXpresso IDE LinkServer Instruction Trace Guide

¢ MCUXpresso IDE LinkServer Power Measurement Guide
* MCUXpresso IDE FreeRTOS Debug Guide

e MCUXpresso (IDE) Config Tools User’s Guide

To obtain assistance on using MCUXpresso IDE, visit: http://www.nxp.com/mcuxpresso/ide

Related web links can be found at Help -> Additional resources as shown below:

Search

(7 Help Contents

MCUXpresso IDE User Guide

%’ Search

Show Contextual Help

Show Active Keybindings... 3L

Tips and Tricks...
Cheat Sheets...

@ Eclipse User Storage >
% Check for Updates

- Install New Software...

& Eclipse Marketplace...

EF Additional resources # Show welcome page
3 Product Information B MCUXpresso IDE website
@ MCUXpresso IDE support forum B MCUXpresso SDK website

B MCUXpresso SDK Builder
* LPCOpen Resources
» Code Bundles for LPCB0OO Family devices

» OpenSDA probe firmware
LPCScrypt - LPC-Link2 probe firmware
s LPC11U35 CMSIS-DAP probe firmware

SEGGER J-Link website

&3 PEMicro website

E3) MBED Serial Port Driver website
&) 'MCU on Eclipse’ blogs

When MCUXpresso IDE is launched, a Welcome page is displayed (usually within the Editor
view). This page contains product information including a link to the User Guide. If this page

MCUXpresso IDE User Guide -
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is not required on startup, it can be disabled via unticking the preference at Preferences ->
MCUXpresso IDE -> General -> Show welcome view.

3.2 Workspaces

When you first launch MCUXpresso IDE, you will be asked to select a Workspace, as shown
in Figure 3.1.

@ Eclipse Launcher
Select a directory as workspace

MCUXpresso IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | /Users/nxp/Documents/MCUXpressolDE_10.3.0/workspace] ] Browse...

} Recent Workspaces

~ Copy Settings
Workbench Layout
Working Sets
Preferences

)] Cancel

Figure 3.1. Workspace selection

A Workspace is simply a directory used to store projects and data. MCUXpresso IDE can only
access a single Workspace at a time.

Tip
@ It is possible to run multiple instances of the IDE in parallel with each instance
accessing a different Workspace

If you tick the Use this as the default and do not ask again option, then MCUXpresso IDE
will always start up with the chosen Workspace opened; otherwise, you will always be prompted
to choose a Workspace.

You may change the Workspace that MCUXpresso IDE is using, via the File -> Switch
Workspace option.

Note: you may choose to copy settings (preferences) from an existing workspace to the new
workspace using the various Copy Settings tick box options.

3.3 Perspectives and Views

The overall layout of the main MCUXpresso IDE window is known as a Perspective. Within
each Perspective are many sub-windows, called Views. A View displays a set of data in the IDE
environment. For example, this data might be source code, hex dumps, disassembly, or memory
contents. Views can be opened, moved (dragged), docked, and closed, and the layout of the
currently displayed Views can be saved and restored.

Typically, MCUXpresso IDE operates using the single Develop Perspective, under which both
code development and debug sessions operate as shown in Figure 3.3. This single perspective
simplifies the Eclipse environment, but at the cost of slightly reducing the amount of information
displayed on screen.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Alternatively, MCUXpresso IDE can operate in a “dual Perspective” mode such that the C/
C++ Perspective is used for developing and navigating around your code and the Debug
Perspective is used when debugging your application.

Note: when within the debug perspective, the concept of a selected project remains. The Blue
Debug button tool tip will display this selected project. Also, if a debug operation is started within
the Debug perspective and a switch is made to the Develop perspective, the IDE will automatically
open a debug stack view to display the active debug connection.

You can manually switch between Perspectives using the Perspective icons in the top right of
the MCUXpresso IDE window, as shown in Figure 3.2.

Figure 3.2. Perspective selection

E

MCUXpresso IDE User Guide -

New perspectives can be selected by clicking the view+ icon. Once a view has been selected, it
icon will appear within the horizontal section as highlighted above.

All Views in a Perspective can also be rearranged to match your specific requirements by
dragging and dropping. If a View is accidentally closed, it can be restored by selecting it from the
Window -> Show View dialog. The default layout for a perspective can be restored at any time
via Window -> Perspective -> Reset Perspective.
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3.4 Major Components of the Develop Perspective

0~ BR @ @-0iv > W3R B EMARROIS LS IKFN O UIdE I E @
& Profect Ex 82 2. Peripheral 1! Registers £ SymbolVi = O % Debug X
2 ®- - vBevkbimxrt1050 igpio_led_output LinkServer Debug (C/C++ (NXP Semiconductors) MCU Application]
¥ £ evkbimxrt1050_igpio_led_output v (2 evkbimxrt1050_igpio_led_output.axf (MIMXRT1052xxxxx (cortex-m7)]
v @ Project Settings v Thread #1 1 (Suspended : Breakpoint)
» = Associated SOK = main() at gpio_led_output.c:80 0x60002fee
» =i Libraries (and semihosting) 4 arm-none-eabi-gdb (8.0.50.20171128)
»@Mcu
» 4 Binaries t
Fiincudes G e L DAL DELAY.CONT; o)
» B CMSIS
» B board * delay *
> Sdrivers
¥ (B source 1
» £ gpio_led_output.c %
» (& semihost_hardfault.c * Gbrief Main funct
> (B startup
» Butilties
» @xip 1
>l betii /2 befine the init structure for the output LED pin®/
o~y » gpio_pin_config_t led_config = {KGPIO_DigitalOutput, O, KGPIO_Nolntmode};
{8 evkbimxrt1050_igpio_led_output LinkServer Debug.launch ck, debug console init *
[ evkbimxrt1050_igpio_led_output LinkServer Release.launch o1
ARD_Ini tPins ()
BOARD_BootCLockRUNO);
BOARD_In tDebugConsole();

O Quickst

PRINTEC\AAn GPIO
I MCUXpresso IDE - Quickstart Panel PROMECYR I LED 15 b1
e Project: evkbimxrt1050.igpio_led_output (Debug]

@mplexrin);
nking.\r\n");

/% Inik output LED GPIO. */
= GPIO_PinIni t(EXAMPLE_LED_GPIO, EXAMPLE_LED_GPIO_PIN, &led_config);
~ Create or import a project

B8 New project while (1)

delayO;
B sirtprcioct(s] fiom file 678088, GP10_PortToggle(EXAMPLE _LED_GPI0, 1u << EXAMPLE_LED_GPIO_PIN);
)

~ Build your project

» B Cores
Writable Smart Insert 80:1

= @ Installed SDKs 2 [ Properties ) Console [/ Problems () Memory @ Debugger Console § Instruction Trace &D Power Measurement Tool [ SWO Trace Config & Termina
4 Build
@ o/ Clean @ Installed SDKs
- Debug your project WGl Toinstallan SOK, simply drag and drop an SDK (zp fleffolder) into the Installed SOKs' view.
Name SOKVersion  Manifest Version  Location SPR DS
% SDK_2.x EVK-MIMXRT1020 2.40 320 = /SDK_2.0_EVK-MIMXRT1020
4 SDK_2.x_EVKB-IMXRT1080 234 320 (5 <Default Location>/Wed Apr__4_17_01_51.2018-windows-meu Beleciad EOK consat
@ SDK_2.x FROM-KB4F 2.20 320 @ JSDK 2.0_FRDM-K64F
@ @ SDK_2.x LPCXpresso54018 2.30 3.20 [y /SDK 2.3.0_LPCXpresso54018.zip v soards
% SDK_2.x LPCXpresso54628 230 /SDK_2.0_LPCXpresso54628 SEVID I SHT1080
» EVKB-IMXRT1050-AGMO1
» EVKB-IMXRT1050-0M13588
v B Devices
v B MIMXRT1052
& Build all projects [Debug! » B Packages

O NXP MIMXRT 106210000 (evkbimy..output)

Figure 3.3. Develop Perspective (whilst debugging)

1. Project Explorer / Peripherals / Registers / Faults / Views
* The Project Explorer gives you a view of all the projects in your current

« many editing and configuration features are available from this view including new

options and

« When debugging, the Peripherals view allows you to display a list of the
and project memory regions. Selecting a peripheral or memory region

will spawn a new window to display the detailed content. Note: depending on your MCUs
configuration, some peripherals may not be powered/clocked and hence their content will

not display.

« When debugging, the improved Registers view allows you to view the registers and their

content within the CPU of your MCU.

« Pseudo registers are also displayed here such as ‘cycle delta’ which shows the calculated

number of cycles since the last pause

< Not visible here is the new Faults view which will appear automatically if a CPU fault (such
as hard fault) occurs. This view decodes CPU registers to provide detailed information

indicating the reason for the fault occuring.

« Not visible here is the Symbol Viewer; this view displays symbolic information from a

referenced .axf file.
2. Editor

« Centrally located is the Editor, which allows modification and saving of source code. When
debugging, this is where you can see the code you are executing and can step from line to
line. By pressing the ' i->' icon at the top of the Debug view, you can switch to stepping by
assembly instruction. Clicking in the left margin will set and delete breakpoints.

3. Console / Installed SDKs / Problems / Trace Views / Power Measurement

* On the lower right are the Console, Installed SDK and Problems Views etc. The Console
View displays status information on compiling and debugging, as well as semihosted

program output.
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e The view enabled the management of installed SDKs. New SDKs can
be added using drag and drop. Other SDK management features are also provided from
this view including unzip, explore and delete.

* New — SDK Documentation can now be browsed and extracted

¢ The Problems View (available by changing tabs) shows all compiler errors and warnings
and will allow easy navigation to the error location in the Editor View.

 Sitting in parallel with the Console View are the various Views that make up the Trace
functionality of MCUXpresso IDE. For more information on Trace functionality, please see
the MCUXpresso IDE SWO Trace Guide and/or the MCUXpresso IDE Instruction Trace
Guide.

« The SWO trace Views allow you to gather and display runtime information using the SWO/
SWV technology that is part of Cortex-M3/M4 based parts.

* On some MCUSs, you can also view instruction trace data downloaded from the MCU’s
Embedded Trace Buffer (ETB) or Micro Trace Buffer (MTB).

 Sitting in parallel with the Console View is the Power Measurement View, a dedicated trace
View capable of displaying real-time target power usage. For more information please see
the MCUXpresso IDE Power Measurement Guide.

4. Quickstart / Variables / Breakpoints / Outline Views

¢ Onthe lower left of the window, the Quickstart Panel View has fast links to commonly used
features. From here you can launch various wizards including New Project, Import from
SDK and Import from File System plus options such as Build, Debug, and Import. The large
icon in each section will perform the first option in the group i.e. New project, Build, Debug.
Also, the Debug group contains debug solution specific

« Note: This Panel is essential to the operation of MCUXpresso IDE and so cannot be
removed from the perspective.
« Sitting in parallel to the Quickstart Panel, the Global Variables View allows you to see and
edit the values of Global variables.
* Variables can be monitored while the target is running using the LinkServer
and features.
¢ Sitting in parallel to the Quickstart Panel, the Variables View allows you to see and edit
the values of local variables.
e Sitting in parallel to the Quickstart Panel, the Breakpoints View allows you to see and
modify currently set breakpoints.
« Sitting in parallel to the Quickstart Panel, the Outline View allows you to quickly find
components of the source file with input focus within the editor.
5. Debug View
* The Debug View appears when you are debugging your application. This shows you the
stack trace. In the “stopped/paused” state, you can click on any function and inspect its local
variables in the Variables tab (which is located parallel to the Quickstart Panel View).
6. Quick Access
< Enables quick access to features such as views, perspectives etc. for example enter ‘Error’

to view and open the IDE’s Error Log, or ‘Trace’ to view and open the various LinkServer
Trace views.

7. Perspective Selection

* From here you can select and switch between the various perspectives, initially only the
perspective selector and the Develop perspective will be shown.
8. Quick Links

« Various useful shortcuts, for example to open a project’'s workspace or to open a terminal
at the projects location with the IDE’s environment.

3.4.1 Project Settings
Introduced in MCUXpresso IDE version 10.2.0 are Project Virtual Nodes contained within a
MCUXpresso IDE User Guide - Proiect Settinas virtua] fiofydesyprovided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. Al rights reserved.
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‘{3 Project Explorer 82 7, Peripherals+ it Registers .| Symbol Viewer
v =5 frdmkB4f_led_blinky

¥ & Project Settings

Figure 3.4. Project Settings

VENARQCINed 50N, = Edit Libraries »
o hame = 'SDK_2.x_FRDM-KB4F" e
o version = '2.4.0'

v =) Libraries (and semihosting) © Edit MCU
o Library (C) = 'Redlib (sepihost:
v@&mMcU EE——

i1 Edit memory
o chip = '"MKG4FN1MOxxx12" -
o package = 'MK64FN1TMOVLL12.
o processor = 'cotf
¥ ife Memory
o Flash name='PROGRAM_FLASH' typgs=
o RAM name="SRAM_UPPER'
o RAM2 name='SRAN_L
o RAM3 names
v [T Options
o Defined symbols (-D) (C) = '[_REDLIB__, CPU_MKB4FN1MOVLL12_cm4, CPU_MKB4FNTMOVLL1 2,
» 3 Binaries
> | Includes
> (2 CMSIS
» (£ board
» (B drivers
» [ source
» (2 startup
» (2 utilities
» (= Debug
» = doc
.frd mk64f_led_blinky LinkServer Debug.launch
.frd mk64f_led_blinky LinkServer Release.launch

[ Edit options

sh' address="0x0" size="0x100000"' FTFE_4K.cfx
AM' address="0x20000000" size='0x30000"

R' type='RAM' address="0x1fffO000" size="0x10000"

_RAM' type="RAM' address="0x14000000" size='0x1000"

3.4.2
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These are automatically generated for any project and provide a quick way to view many key
project settings. In addition, a right click on these nodes provides direct options to edit the
associated settings that otherwise require many more mouse clicks to reach.

Updating MCUXpresso IDE

New in MCUXpresso IDE version 10.3.0 is the facility to update an installation to incorporate
new features, updates and/or to roll out bug fixes etc. To facilitate this mechanism, MCUXpresso
IDE version 10.3.0 internals have been significantly restructured locating key components with
Eclipse style plugins.

Tip

Locating low level components is now more difficult due to both the complex directory
structure but also because component locations may change after an update is
performed. Therefore to simplify the experience a number of softlinks are available
within the install_dir/ide as discussed in section below “Locating IDE Components”

By default, when an update is released by NXP, a notification of the availability will appear at
the bottom of the screen.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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Updates Available X

Updates are available for your software.
Click to review and install updates.

You will be reminded in 4 Hours.
Set reminder preferences

Figure 3.5. Update Notification

Alternatively you can check for updates via Help -> Check for Updates. If updates are available
you will be presented with a dialogue similar to that below:

Figure 3.6. Updating MCUXpresso IDE Components

[ ] [ ] Available Updates
Available Updates

Check the updates that you wish to install. | -

’
Name Wersion Id
[§. GNU ARM PEMicro Interface Debugging Support 3.7.8.201810122006 com.pemicro.debug.gdbjtag.pne.feature.fe...
@ g MCUXpresso IDE base functionality 10.3.0.201810111056 com.crt.Ipcxpresso feature feature.group
(§- MCUXpresso IDE Configuration Tools Integration 1.1.0.201810111248 com.nxp.swtools.mcuxpressoide.feature.fe...
@ §:MCUXpresso IDE LinkServer and Pre-installed part support 10.3.0.201810151121 com.nxp.mcuxpresso.tools.core feature.fea...
@ g MCuXpresso IDE SDK handling 10.3.0.201810111544 Ccom.nxp.mcuxpresso.core.datamodels.feat...
[§-MCUXpresso IDE Trace and Power 10.3.0.201810111148 com.nxp.mcuxpresso.trace.feature.feature....
Select All Deselect All
Details
@ <eeck | (NN | Concel

3.4.3
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Simply, ensure the required updates are checked and click Next. At this point the components
will be downloaded and installed into MCUXpresso IDE. After installation a restart will be required
before new features are available.

Note: In addition to updates for MCUXpresso IDE, updates to the MCUXpresso Config tools and
PEMicro debug solution are also delivered using this mechanism.

Updating MCUXpresso IDE on Mac or Linux hosts

Applications installed under Mac or Linux do not grant users read write access to their installation.
Therefore, if an update is attempted, the available updates if selected will report ‘Insufficient
access privileges to apply this update’. One solution to this problem is to run MCUXpresso IDE
with root permissions to perform an update.

First ensure the IDE is not running, then open a terminal and start the IDE with the command
as below:

sudo / Appl i cati ons/ MCUXpr essol DE_10. 3. 0_xxxx/ i de/ MCUXpr essol DE. app/ Cont ent s/ MacOS/ ncuxpr essoi de

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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3.4.4

3.5
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Once requested, enter your SU password to allow the IDE to start with super user privilege. Now
you can perform the update as described above.

Tip
@ Since environment variables aren’t preserved in sudo, you must be sure to specify
the entire path to the executable.

Finally, be sure to restart the IDE with as a standard user, both for good practice and to ensure
user paths to projects and SDKs are restored.

Locating IDE Components

MCUXpresso IDE consists of many components, some of which may be used independently
from the IDE. Also included are documents, examples, scripts, drivers etc. that may need to be
referenced from within the IDE.

Due to the structural changes to MCUXpresso IDE version 10.3.0 as discussed above, the paths
for these items will be both different from previous releases, may change after a product update
and also be long. For example, the IDE bin folder will now be at a location of the form:

<install_dir/ide/plugins/com nxp. ncuxpresso.tools. bin. macosx_10. 3. 0. 201810111539/ bi nari es

Therefore, to simplify the location of certain folders, shortcuts (or symbolic links) are installed
into the products install_dir/ide/. These can be used directly to locate components or items, or
within script paths.

Shortcuts are available for:* bin -> install_dir/ide/bin * Examples -> install_dir/ide/Examples *
Wizards -> install_dir/ide/Wizards * tools -> install_dir/ide/tools

In practice, these link will allow paths to components to be unchanged from earlier version of
MCUXpressoIDE.

Help us improve MCUXpresso IDE

MCUXpresso IDE can send anonymous information to NXP on how you use the IDE, including
the built-in Config Tools, and with which MCUs. This information can help us to improve the
functionality of the tools as well as to resolve problems. You can turn this information collection
off at any time by unticking the workspace option:

Preferences -> MCUXpresso IDE -> General -> Help us improve the tool

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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4. Debug Solutions Overview

MCUXpresso IDE installs with built-in support for 3 debug (hardware) solutions; comprising the

as used in LPCXpresso IDE. Plus support for
both and . This support includes the installation of
all necessary drivers and supporting software.

The rest of this chapter discusses these different Debug solutions. For general information on
debugging please see the chapter

Note: Within MCUXpresso IDE, the debug solution used has no impact on project setting or build
configuration. Debug operations for basic debug are also identical.

4.1 Starting a Debug Session

With a suitable board and debug probe connected (usually via USB), to start a debug session:

1. select a project to debug within the MCUXpresso IDE Project View
2. click Debug from within the MCUXpresso IDE QuickStart View
() Quickst )= Globa Variable Breakp Outline = O

MCUXpresso IDE - Quickstart Panel
Cice )| Project: evkbimxrt1050_igpio_led output [Debug] |

~ Create or import a project

. New project...
ot
f Import SDK example(s)...
& Import project(s) from file system...

~ Build your project

&, Build

¢ Clean

~ Debug your project .' Ea' '

4 Debug
‘ﬁ" Terminate, Build and Debug

~ Miscellaneous

® Edit project settings

E Quick Settings>>

.@ Export project(s) to archive (zip)

.l Export project(s) and references to archive (zip)
are Build all projects [Debug]

« a debug probe discovery operation is automatically performed to display the available
debug connections (i.e. the detected debug probes), including LinkServer, P&E and J-Link
compatible probes.

3. select the required debug probe and click OK

« at this stage a project is automatically created within the project
containing debug specific configurations

« if the debug connection is successful a Debug view will appear typically showing the project
has stopped on main()

45 Debug ¢
".ﬁdmksnf_bubble LinkServer Debug [C/C++ (NXP i MCU Application]
v {2 frdmk64f_bubble.axf [MK64FN1MOxxx12 (cortex-m4)]
v @ Thread #1 1 (Suspended : Breakpoint)
= main() at bubble.c:246 Ox7ca
. arm-none-eabi-gdb (8.1.0.20180315)
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Tip

@ Once a project has been debugged, the launch configuration will contain details of
the debug probe used. Subsequent debug sessions with automatically select this
probe if it is available

From this point onwards, the low level debug operations are controlled by one of the debug
solutions mentioned above.

However, from the users point of view most common debug operations within the IDE will appear
the same (or broadly similar), for example:

¢ Automatic inheritance of part knowledge
¢ Automatic downloading (programming) of generated image to target Flash memory
¢ Automatic halt on main()

e Setting and
. (single, step in step out etc.)
¢ Viewing and editing local variables, registers, , memory

* Viewing and editing
« live global variables is a LinkServer only feature
¢ Viewing disassembly
e Semihosted 10
e Introduced in MCUXpresso IDE version 10.2.0 :
« Instruction Trace is supported for all debug solutions
. is supported for all debug solutions
¢ New in MCUXpresso IDE version 10.3.0 :
« SWO Trace is supported for all debug solutions including profiling, interrupt trace etc.
» Viewing details of execution faults via the
« automatically displayed for faults generated during LinkServer debug

Note: In addition MCUXpresso IDE will dynamically manage each debug solutions connection
requirements allowing multiple sessions to be started without conflict. For debug of Multicore
MCUs please refer to the section

However, it is important to note that advanced operations such as the handling of launch
configuration features may be very different for each debug solution. Furthermore, advanced
debug features and capabilities may vary between solutions and even similar features may
appear quite different within the IDE.

MCUXpresso IDE documentation will only describe the advanced features provided by native
LinkServer debug connection. These include:

¢ Flash programming
« please see the chapter
* Instruction Trace
* please see LinkServer Instruction Trace Guide
¢ Live Global Variable display (including Graphing)
 described later in this chapter
* Power Measurement
* please see LinkServer Power Measurement Guide
e FreeRTOS Debug
» please see FreeRTOS Debug Guide
e SWO Trace (Profiling, Interrupts, Data Watch) - LPC-Link2 Only
» please see LinkServer SWO Trace Guide

P&E Micro and SEGGER debug solutions also provide a number of advanced features, details
can be found at their respective web sites.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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4.2 An Introduction to Launch Configuration Files

The debug properties of a project in MCUXpresso IDE are held locally within each project in
Jaunch files (known as launch configuration files).

Launch configuration files are different for each debug solution (LinkServer, P&E, SEGGER) and
contain the properties of the debug connection (SWD/JTAG, and various other configurations
etc.) and can also include a debug probe identifier for automatic debug probe matching.

If a project has not yet been debugged, for example a newly imported or created project, then
the project will not have a launch configuration associated with it.

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found. Note: The Debug
Solutions searched can be filtered from this dialogue as highlighted, removing options that are
not required will speed up this process.

e Probes discovered
Connect to target: MK64FN 1MOxxx12

1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactu IDE Debug Mode

| [LPC-LINK2 CMSIS-DAP V5.183 [IQCOAXGV |LinkServelNXP SemiNon-Stop |

Supported Probes (tickjuntick to enable/disable}

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

@ cancel | (LN

Figure 4.1. Debug Probe Discovery

Once the debug probe is selected and the user clicks ‘OK’, the IDE will automatically create a
default launch configuration file for that debug probe (LinkServer launch configuration shown
below).

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
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{5 Projec 22 |2 Periph ili Regist % Faults L. Symb

J

¥ =5 frdmk64f_bubble
» € Project Settings
» # Binaries
» [l Includes
» (2 CMSIS
» (Zaccel
» (2 board
» (S drivers
¥ (Z source
» [¢ bubble.c
» [ semihost_hardfault.c
» (B startup
» (2 utilities
» =Debug
o dAo-

frdmk64f_bubble LinkServer Debug.launch ]

Figure 4.2. Launch Configuration Files

Note: a launch configuration will only be created for the build configuration being debugged

For most debug operations, these files will not require any attention and can essentially be
ignored. However, if changes are required, these files should not be edited manually, rather their
properties should be explored within the IDE.

The simplest way to do this is to click to expand the Project within the ‘Project Explorer’ pane,
then simply double click a launch configuration file to automatically open the launch configuration
Edit Configuration dialogue.

Note: This dialogue has a humber of internal tabs, the Debugger tab (as shown below) contains
the debug main settings. See also the
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Modify configuration and continue.

Name: |MKGAFN1MOxxx12_Project Li
[5 Main | & Source [ € GUI Flash 146I |5 Debugger , Common

B mcuxpresso IDE LinkServer Debugger

Edit Configuration

Stop on startup at: | main

Debugger Options

Request hardware breakpoint

{

Debug options for NXP MK64FNTMOxxx12 (cortex-m4)

Debug Connection | SWD |7

Configuration Option

aH[: Additional options

i| Attach only

b Connect Script

atf: Debug Level

i Debugger memory cache

-| Disconnect behavior

-| Flash Driver Reset Handling
-/ Load image

w| ] e

Miscellaneous
Emulator selection  LinkServer jul

Edit scripts...

Debug options template

Debug Configuration (*)

~ Value
False
kinetisconnect.scp
2
Disable
cont

True

M Show all

Revert Apply

concel (TR

Figure 4.3. Launch Configuration

Some debug solutions support advanced operations (such as the recovering of badly

programmed parts) from this view.

Note: Once a launch configuration file has been created, it will be used for the projects future
debug operations. If you wish to use the project with a different debug probe, then simply delete
the existing launch configuration and allow a new one to be automatically used on the next debug

operation.

Enhancement: Introduced in MCUXpresso IDE version 10.1.0 — to simplify this operation, a

probe discovery can be forced by holding the SHIFT key while launching a debug session

from the Quickstart panel. If the new debug connection is completed, a new project launch

configuration will be created replacing any existing launch configurations. Alternatively, the
are available to force the use of a particular debug solution.

MCUXpresso IDE User Guide -
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Tip

@ When exporting a project to share with others, launch configurations should usually
be deleted before export (along with other IDE generated folders such as build
configuration folders (Debug/Release if present)).

For further information please see the section

LinkServer Debug Connections

MCUXpresso IDE’s native debug connection (known as LinkServer) supports debug operation
through the following debug probes:

¢ LPC-Link2 with CMSIS-DAP firmware

¢ LPCXpresso V2/V3 Boards incorporating LPC-Link2 with CMSIS-DAP firmware

* CMSIS-DAP firmware installed onto on-board debug probe hardware (as shipped by default
on LPCXpresso MAX and CD boards)

< For more information on LPCXpresso boards see: http://www.nxp.com/lpcxpresso-boards
« Additional driver may be required:
 https://developer.mbed.org/handbook/Windows-serial-configuration

« CMSIS-DAP firmware installed onto on-board OpenSDA debug probe hardware (as shipped
by default on certain Kinetis FRDM and TWR boards)

* Known as DAP-Link and mBed CMSIS-DAP: http://www.nxp.com/opensda
« Additional driver may be required:
* https://developer.mbed.org/handbook/Windows-serial-configuration

e Other CMSIS-DAP probes such as Keil uLINK with CMSIS-DAP firmware: http://
www?2.keil.com/mdk5/ulink

¢ Legacy RedProbe+ and LPC-Link
« RDB1768 development board built-in debug connector (RDB-Link)
+ RDB4078 development board built-in debug connector

Note: MCUXpresso IDE will automatically try to softload the latest CMSIS-DAP firmware onto

LPC-Link2 or LPCXpresso V2/V3 boards. For this to occur, the DFU link on these boards must
be set correctly. Please refer to the boards documentation for details.

LinkServer Debug Operation

When the user first tries to debug a project, MCUXpresso IDE will perform a Debug Probe
Discovery operation and present the user with a list of debug probes found.

Note: To perform a debug operation within MCUXpresso IDE, select the project to debug within
the ‘Project Explorer’ view and then click Debug from the QuickStart View.

If more than one debug probe is presented, select the required probe. For LinkServer compatible
debug probes, you can select from Non-Stop (the default) or All-Stop IDE debug mode.

Non-Stop uses GDB’s “non-stop mode” and allows data to be read from the target while an

application is running. Currently this mechanism is used to support the Live Variables feature
within the Global Variables view.
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Connect to target: MK64FN1M0xx0t12
1 probe found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manutagtur IDE Debug Mode
. LPC-LINK2 CMSIS-DAP Vb5.18IIQCOAXGV LinkServe NXP S¢mi Non-Stop

Supported Probes (tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc, CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options

Search again

Remember my selection (for this Launch configuration)

( "3) Cancel oK
\£

Figure 4.4, Debug Probe Discovery Non-Stop

Click ‘OK’ to start the debug session. At this point, the projects launch configuration files will be
created. LinkServer Launch configuration files will contain the string ‘LinkServer'.

Note: If “Remember my selection” is left ticked, then the probe details will be stored within the
launch configuration file, and this probe will be automatically selected on subsequent debug
operations for this project.

For a description of some common debugging operations using supported debug probes see

45 LinkServer Global and Live Global Variables

MCUXpresso IDE provides a new Global Variables view for displaying the values of global
variables. This replaces the use of the “Expressions” view for displaying such variables, as used
in LPCXpresso IDE (and KDS). This view defaults to be located within the QuickStart panel.

This view can be populated from a selection of a projects global variables. Simply click the “Add
global” button to launch a dialogue:

Quickstar #J)= Global Va 23 Variables Breakpol Cutline = B
o R ] B =
iabl * e
] Tpe Acd global variables %

Figure 4.5. LinkServer Add Global Variables

This will then display a list of the global variables available in the image being debugged. Select
the ones of interest via their checkboxes and click OK :
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[ [ ] Select symbols.

Name ~ Address Size
_Ciob 0x2000007c 180
_end_of_heap 0x20000130 4
__heaps 0x20000134 4
_num_Ciob_streams 0x00006670 4
_Vectors 0x00000000 408
errno 0x20000138 4
Flash_Config 0x00000400 16
g.accel_address 0x00005974 4
g_MasterHandle 0x20000014 40
a_pfnVectors 0x00000000 408

~ g._xAngle 0x%2000003¢ 2
g_xDuty 0x20000040 2
g_xtal0Freq 0x20000044 4
g _xtal32Freq 0x20000048 4
g_yAngle 0x2000003e 2
g_yDuty 0x20000042 2

Select All Deselect All
(©) cancel | (SCTHNN

Figure 4.6. LinkServer Global Variable Selector

Note: to simplify the selection of a variable, this dialogue supports the option to filter (highlighted)
and sorts on each column.

Once selected, the chosen variables will be remembered for that occurrence of the dialogue.

For “All-Stop” debug connections, the Global Variables view will be updated whenever the target
is paused.

For “Non-Stop” debug connections, variables can be selected to be updated while the target is
running. These are known as " Live Variables".

For variables to be “Live™:

« the target must be running
« the enable/disable (run) button clicked (as shown highlighted below)

Once done, the display will update at the frequency selected (selectable from 500 ms to 10 s).

) Quickstart Panel ()= Global Variables 83 ()= Variables 9 Breakpoints E= Outline = 0
Variable Type Value Address

¥ (®array uint32_t [4] 0x20000018 <array> 0x20000018
G9=array[0] uint32_t 11 0x20000018
t-array[1] uint32_t 85 0x2000001¢
-array[2] uint32_t 10 0x20000020
®=array[3) uint32_t 7 0x20000024
9:g_xAngle volatile int16_t 25 0x20000120
¢d:g_yAngle volatile int16_t 1" 0x20000122

i Add new expression

Figure 4.7. LinkServer Global Variable Display

Introduced in MCUXpresso IDE version 10.2.0 is the ability to enter an expression (using
standard C notation) or symbol. The expression will be evaluated and the address displayed in
the Adresss column.
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Quickstart Panel = Global Variables &3 Variables 3reakpoints Outline o w
K& Q000 =M= v
Variable Type Value Address
> (Barray uint32_t [4] 0x20000018 <array> 0x20000018
9=g_xAngle volatile int16_t 86 0x20000120
ngle volatile int16_t 3 0x20000122
uint32_t 103 0x20000018

Figure 4.8. LinkServer Global Variable Display Expression

Live Variables like normal Globals can also be edited in place. Simply click on the variable value
and edit the contents. During the edit operation, the display will not update. This mechanism
provides a powerful way of interacting with a running target without impacting on any other aspect

of system performance.

Note: If you wish to have some global variables ‘Live’ and others not, then this can be achieved
by spawning a second Globals display via the ‘New View’ button and populating this without
enabling the ‘run’ feature for that view.

The usefulness of Live Variables reduces as the number of Globals monitored increases, and
ultimately there will be a limit as to how many variables can be updated at the selected frequency.
However, complex list of variables can be monitored if required. For example:

Figure 4.9. LinkServer Global Variable Display Complex

) Quickstart Pa )= Global Variabl &2 (4= Varighlg

Variable
©)=_random_j
0=_random_k
®:=b
©=f
®0=d
»p
=i
0=
6=k

¥ (®uni_a
©9-uni_a[0]
©9=uni_a[1]
69-uni_af2]
69=uni_a[3]
6d=uni_a[4]
v (&bi_a
v (= bi_a[0]
69=bi_a[0][0]
©9=bi_a[0][1]
©4-bi_a[0][2]
v (2 bi_a[1]
©9-bi_a[1][0]
¢9-bi_a[1][1]
63=bi_a[1][2]
> (2 bi_a[?]
» =5 _example
v (s exi
» (Zname
0d=s_|

Type

<data variable, no debug info> 25
<data variable, no debug info> 2

_Bool
float
double
wvoid *
volatile int
int

int
double [5]
double
double
double
double
double
float [3)[3]
float [3]
float

float

float

float [3]
float

float

float

float [3]
char [15]
struct Struct_example
char [§]
int

=0

< -

frue

62.9931755
-0.88162727834732613
0x20000130 <bi_a>

5

3

3

0x20000108 <uni_a>
0.64644408768343008
0.62534067329267975
0

0
-0.69493926395426475
0x20000130 <bi_a>
0x20000130 <bi_a>
77.4734955

92.8390503

46.7962074
0x2000013c <bi_a+12>
63.3472824

95.4246292

30.6657524
0x20000148 <bi_a+24>
0x20000154 <s_example>
-}

0x20000168 <s_ex1>

3
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MCUXpresso IDE defaults to the selection of “Non-Stop” mode when a LinkServer probe
discovery operation is performed. This can be disabled from an MCUXpresso IDE Preference via:

Preferences -> Debug Options (Misc)
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Debug Options (Miscellaneous) Dy iy w
> General com.crt.debugcommon v10.2.0.201804112303
BCiC++
» Help Debugger executable arm-none-eabi-gdb
* Install/Update Debugger timeout 10
> Java .
MCUXpresso Config Tools SWV Packet Timeout 0
¥MCUXpresso IDE Extended debug trace (DEBUG_TRACE)
o |
[ [ ey P — ] Stream all stub messages to Console
U PTODE DISCOVETY Show stub warnings as notes
Default Tool settings Show debug log when written to
General -
I Display asynchronous error messages
J-Link Options o ) piay asy 8
LinkServer Options Disable Auto-select device on multicore target
LPC-Link Options Always show JTAG selection dialog

LPC-Link2 SWO Trace
MCU settings

A . ™ dad dabug

Paths and Directories [rns
PEMicre Options Enable Non-Stop Mode ]
Quickstart Panal SWV Server Port 0
SDK Options
User Interface Enablement
Utilities

» Mylyn

» Run/Debug

» Team

» Terminal

Validation
XML Restore Defaults Apply

Show progress messages in log

Figure 4.10. LinkServer Non Stop Preference

For a given project, the Non-Stop mode option is stored within the project’s launch configuration.
For projects that already have launch configurations, these will need to be deleted before
proceeding.

4.6 LinkServer Live Global Variable Graphing

Introduced in MCUXpresso IDE version 10.2.0 is the capturing of live variable values over time.
This data can be displayed as raw values (which can be exported) or plotted as graphs directly
within the IDE.

To select a plot type, right click within the Globals view and choose one of the options:

View Memory
Number Format »
Find... 3®F

Launch ConﬁguratioJ 1 Trace global variables
Smart update ' +/ 2 Plot global variables
Utilities 3 Number Formats Viewer

S

#, Cast To Type...

=[1 Display As Array...
Restore Original Type
¥ Watch

« Trace Global Variables will sample values of the selected variables at the variable update
frequency. These values can be viewed within the panel or exported as tsv data.

* Plot Global Variables will sample and plot values of the selected variables at the variable
update frequency. These graphs can be viewed within the panel or saved as png.

* Number Format Viewer will display the selected variable values in various bases
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Variables can only be sampled if they have first been added to the Global Variable panel as
discussed in the previous section. The selection of variables to plot is simply made by clicking
to highlight the variable of interest.

Tip
@ multiple variables can be selected by normal host multiple selection scheme e.g.
ctrl/cmd click

Note: Once a variable has been selected, the timebase (uptime) will begin and variables values
will be sampled and displayed. If additional variables are selected, their values will join the
display at the current uptime. If a variable is unselected its values will no longer be sampled and
displayed. If however, it is selected again within the same debug session, it will be displayed
along with any previously captured values. During any period it was not selected its values will
show as zero.

Tip

@ if the display is paused, data will still be captured but the new values will not be
displayed, this can help detailed viewing of the data. Once un-paused, the captured
data will be added to the display.

Note: If the target is paused, time (x-axis) will continue to advance although the display will not
update until the target is resumed.

4.6.1 LinkServer Live Global Variable Graphing details

In the example below, two variables have been added to the Global variable view and both have
been selected.

) Quickstart Panel 9= Global Variables 2 (= Variables ©g Breakpoints o= Outline = 0
¥ s @)oo T BB e~
Variable Type Value Address
G)=yvar volatile int32_t -263 0x2000000¢c

©:=loop uint32_t 227 0x20000010
== Add new expression

) . [ i1 2 4
Plot of "yvar* from project ‘frdmk&4f_led_blinky" O O/; f

[ S - /\ /9e
| /\\\// \/%\\// \\/ \/ T

00:00.0 00:20.0 00:40.0 01:00.0 01:20.0 07:40.0 02:00.0 02:20.0 02:40.0 03:00.0

Uptime [mm:ss.S)

Details

yvar

Plot of 'loop' from project “frdmk84f_led_blinky"

00:00.0 00:20.0 00:40.0 01:00.0 01:20.0 01:40.0 02:00.0 02:20.0 02:40.0 03:00.0
Uptime [mm;s5.5]

Figure 4.11. LinkServer Global Variable Graphing major features

The highlighted features are discussed below:
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. Selected variables for graphing. Click to select, ctrl/cmd click to add additional variables. The

selected values will be remembered between debug sessions

* Once selected the variable will exist in the internal database of values and will remain until
the debug session is terminated (even if it is later unselected)

. Save: Click to save the display as a png. The size of the png will be proportional to the size of

the global view. Therefore, for more detail, increase the size of the global view before saving

¢ Other graphic formats are also supported. Note: in addition a tsv file containing the captured
data will also be saved

. Pause: Click to pause the graph display updated. Variables values will still be captured but

the screen will not update
¢ This may be useful if a portion of the display needs to be viewed in detail

. Multiple/Single Graphs: Click to toggle the display between separate graphs for each variable

and all variables plotted on a single graph

« when more than one variable is displayed on a single graph, the Y axis will display as hex
values

. Show Data Statistics: Click to add display of min, max, average information for each plotted

variable.

6. Clear all Data Statistics: Click to clear existing data from the Data Statistics values
7. Click onto the graph to view the actual variable value at that point

« it may help to pause the update to explore variable values

Below, is a view of two variables on a single graph with data statistics enabled.

Figure 4.12. LinkServer Multiple Global Variable Graph

L e~ Variable  min max av
Details lal | [0 = 4 g

yvar -3560.0 359.0 359.0
Plot of selected variables from project 'frdmkB4f_lad_blinky' loop 0.0 9.0 1708
-/". A\
300 [ f-\ f- \
1 | |I | \ II II
\ (i | I| | [ 1
200 [ -4 - [ |
| \ | | | | (
A | i | : \
100 -7+ {74 f-#-1 | 1
| | | |
o] Al |
| | | | |
a W [ .13
30 P -
» | | | | | |
| | | | \ | | II |
<1004 t-1 | {41 |-t
|| || | ! ki |
b | | || II | |
-200+4 | | i1 R |1 |1
T \ | ', I' N f
1 | 1 ] \ 1 II
-3004 | | \f \ b {
\ | \ \ | \/

T T T T T T
00:30.0 01:00.0 01:30.0 02:00.0 02:30.0 03:00.0
Uptime [mm:ss.S]

—_— var — loop
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Within a graph view there are a range of features that can be explored. Right click within the
graph to display the menu as below:
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Figure 4.13. LinkServer Multiple Global Variable Options

Details =] =]

Plot of salected variables from project "frdmk64f_lad_blinky”

I |" AN AN A
300 IHE--fH--THE--THA |!. JHE S 1.3
/ |."l||."|'|'|||.'IIII ."Il-'l'l"lll'l
f [l !.'II | |."I | ..'II [l |."I |I |:|' [l | |' | '.-.I
200 T T s Il
Adjust Axis Range > 1 || Jr
100 A
Zoom In > i
o Zoom Out il |
12 11
Save As...
4] ]
-1004 Properties... l I. | |
==l X_Axis u_nit » | | .l |
Time Window = T
Reset 1]
-300 - | R
Plot settings (‘yvar') L V

T T T T T T Plot settings ('loop’) e
00:00.0 01:00.0 02:00.0 03:00.0 04:00.0 05:00.0 vowvw vruww vewww wed0.0 10:00.0

Uptime [mm:ss.5]

— v —— loop
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Most options are self explanatory, however the Time Window option is discussed below:

Time Window offers 3 options; Small, Medium (default) and Wide. This setting controls the
number of samples that can be captured and displayed - where Smallis 100, Medium is 1000, and
Wide is 10000. If these samples were expressed as an amount of time, 1000 samples captured

at a frequency of 1 sample per second (default) would ultimately display a window spanning
1000 seconds.

Once the selected number of samples have been captured, the oldest samples will be discarded
as new samples are taken, and the display will scroll horizontally.

Also consider, due to the physical limitations of a monitor, 1000 samples will require roughly 1/2
the horizontal pixels available on a 1080p display to render without loss, so the Wide option will
only be of benefit if used in conjunction with zoom or a large screen.

Note: the Trace option will always capture up to 10000 samples per variable.

Finally, if you wish to explore the graph in more detail, you can simply drag within the display
to zoom into the view as below:
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Details (& =B
Plot of salected variables from project “frdmk641_led_blinky'
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Figure 4.14. LinkServer Multiple Global Variable Zoom

It is recommended that the display is paused for detailed exploration of this sort.
4.7 LinkServer Troubleshooting
4.7.1 Debug Log

On occasion, it can be useful to explore the operations of a debug session in more detail. The
steps are logged into a console known as the Debug log. This log will be displayed when a Debug
operation begins, but by default, will be replaced by another view when execution starts. The

debug log is a standard log within the IDE’s Console view. To display this log, select the Console
and then click to view the various options (as below):

B b LR ™ B~
# 1 FreeRTOS Task Aware Debugger Console version 1.0.3 (201804111610) ?

2 frdmk64f_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] gdb traces
&l 3 CDT Global Build Console

E 4 CDT Build Console [frdmk64f_bubble]
S RedlinkServer

| v [ 6 frdmk64f bubble Debug messages |

7 frdmk641_bubble LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application] frdmk6&4f_bubble.axf

The debug log displays a large amount of information which can be useful in tracking down
issues.

In the example debug log below, you can see that an initial Connect Script file has been run.
Connect scripts are required for debugging certain parts and are automatically added to launch
configuration files by the IDE if required. Next, the hardware features of the MCU are captured
and displayed, this includes the number of breakpoints and watchpoints available along with

details of various hardware components indicating what debug features might be available, for
example Instruction Trace.

Further down in this log you will see the selection of a Flash driver (FTFE_4K), the identification

of the part being debugged (in this case a K64), the programming progress and the speed of the
Flash programming operation (in this case 83.89 KB/sec).
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Tip

a line similar to flash variant ‘K 64 FTFE Generic 4K’ detected (1MB = 256*4K at
0x0) will be displayed for LinkServer Flash programming operations. The size of the
detected flash (in this example itis 1MB) and sector size (4KB) will be displayed here.
The sector size may be important since multiples of this size represent valid base
addresses for flash programming operations. For example, if the programming of
more than one image is required, the second image must begin on a 4KB boundary
beyond the end of any previously programmed image.

MCUXpr esso
Found part
Reconnect e

Connecti ng

Ki netis Co
Connecti ng
Thi s probe
This TAP =
This core

Dpl D = 2BA01477
Assert NRESET

Reset pin

Power up Debug

MDM AP AP
MDM AP Sys
MDM AP Con

MDM AP Status (Flash Ready) : 0x00000032

Part is no
MDM AP Con

Rel ease NRESET

Reset pin
MDM AP Con

MDM AP St at us: 0x0001003A

MDM AP Cor

Probe Firmnare: LPC-LINK2 CVSI S-DAP V5. 224 (NXP Semi conductors)
Serial Nunber: BSHWMLOT

VI D: PI D:
USB Pat h:
Usi ng neno
debug inte
processor
nurber of
nurber of
nurber of
Probe(0):
Debug prot
Cont ent of

RBASE EOOFF000: CI D B105100D PI D 04000BB4C4 ROM (type 0x1)

ROM 1 E000
ROM 1 E000
ROM 1 E000
ROM 1 E000

ROM 1 E0040000: CI D B105900D PI D 04000BB9A1 CSt TPIU type 0x11 Trace Sink - TPIU
ROM 1 E0041000: CI D B105900D PI D 04000BB925 CSt ETM type O0x13 Trace Source - Core
ROM 1 E0042000: CI D B105900D PI D 04003BB907 CSt ETB type 0x21 Trace Sink - ETB

I DE RedlinkMWulti Driver v10.3 (COct 18 2018 12:21:50 - crt_enu_cmredlink build 717)
description in XM. file MK64F12_internal . xm
d to existing link server

to probe 1 core 0 (using server started externally) gave 'K
=== SCRI PT: ki neti sconnect.scp =============
nnect Scri pt

to Probe Index =1

=1

0
=0

state: 00

D: 0x001C0000

tem Reset/ Hol d Reset/Debug Request

trol: 0x0000001C

t secured
trol: 0x00000014

state: 01
trol (Debug Request): 0x00000004

e Halted
=== END SCRI PT

1FC9: 0090
\\ 2\ hi d#vi d_1f c9&pi d_0090&ni _00#a&125cclf 1&0&0000#{ 4d1e55b2-f 16f - 11cf - 88cb- 001111000030}

ry fromcore 0 after searching for a good core

rface type = Cortex-M3/4 (DAP DP | D 2BA01477) over SWD TAP 0O
type = Cortex-M4 (CPU | D 00000C24) on DAP AP 0O

h/w breakpoints = 6

flash patches =2

h/w wat chpoints = 4

Connect ed&Reset . Dpl D: 2BA01477. Cpul D 00000C24. |nfo: <None>
ocol : SWD. RTCK: Disabled. Vector catch: Disabled.

Cor eSi ght Debug ROMs):

E000: CI D B105E00D PI D 04000BBOOC Gen SCS (type 0x0)
1000: CI D B105E00D PI D 04003BB002 Gen DWI (type 0xO)
2000: CI D B105E00D PI D 04002BB003 Gen FPB (type 0x0)
0000: CI D B105E00D PI D 04003BB001 Gen | TM (type 0x0)
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ROM 1 E0043000: CI D B105900D PI D 04001BB908 CSt CSTF type 0x12 Trace Link - Trace funnel/router
NXP:  MK64FN1MDxxx12

Inspected v.2 On chip Kinetis Flash nenory nodul e FTFE_4K. cf x

I mage 'Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE 4K cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Cl osing flash driver FTFE 4K cfx

Connected: was_reset=true. was_stopped=true

Awai ting telnet connection to port 3330 ...

GDB nonst op node enabl ed

Opening flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Witing 25856 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 25856)

00002000 done 31% (8192 out of 25856)

00003000 done 47% (12288 out of 25856)

00004000 done 63% (16384 out of 25856)

00005000 done 79% (20480 out of 25856)

00006000 done 95% (24576 out of 25856)

00007000 done 100% (28672 out of 25856)

Erased/ Wote sector 0-6 with 25856 bytes in 301lnsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 25856 bytes in 0.30 seconds (83.89 KB/sec)
Starting execution using systemreset and halt target

St opped: Breakpoint #1

4.7.2 Flash Programming

MCUXpresso IDE User Guide -

Most debug sessions begin with the programming of Flash, followed by a reset of the MCU. Note:
If flash programming should fail then the debug operation will be aborted.

Below is a brief discussion of the most common low level flash operations:

1.

Sector Erase: internally Flash devices are divided into a number of sectors (or blocks), where
a sector is the smallest size of Flash that can be erased in a single operation. A sector will be
larger than a page (see below). Sectors are usually the same size for the whole Flash device,
however this is not always the case. A sector base address will be aligned on a boundary that
is a multiple of its size. A sector erase is usually the first step in a flash programming sequence.

. Page Program: internally Flash devices are divided into a number of pages, where a page is

the smallest size that can be programmed in a single operation. A page will be smaller than a
sector. A page base addresses will be aligned on a boundary that is a multiple of its size.

. Mass Erase: a mass erase will reset all the bytes in Flash (usually to Oxff). Such an

operation may clear any internal low level structuring such as protection of Flash areas (from
programming).

The programming of an image (or data) comprises repeated operations of sector erase followed
by a set of program page operations; until the sector is fully programmed or there is no more
data to program.

One of the common problems when programming Kinetis parts relates to their use of Flash
configuration block at offset 0x400. For more information please see:

. Flash sector sizes on Kinetis MCUs range from 1KB to 8KB,

therefore the first Sector Erase performed may clear the value of this block to all OxFFs, if this is
not followed by a successful program operation and the part is reset, then it will likely report as
‘Secured’ and subsequent debugging will not be possible until the part is recovered.
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4.7.3

4.8

4.9
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Such an event can occur if a debug operation is accidently performed to the ‘wrong board’ so
a wrong Flash programmer is invoked.

Note: LinkServer mass erase operations will restore this Flash configuration block automatically
for Kinetis parts. However, if a Kinetis device is mass erased by sector, this mechanism will be
bypassed, therefore this operation should not be performed to Kinetis parts!

Should you need to recover a ‘locked’ part please see the section

LinkServer executables

LinkServer debug operations rely on 3 main debug executables.

e arm-none-eabi-gdb — this is a version of GDB built to target ARM based MCUs

e crt_emu_cm_redlink — this executable (known as the debug stub) communicates with GDB
and passes low level commands to the LinkServer executable (also known as Redlink server)

e redlinkserv — this is the LinkServer executable and takes stub operations and communicates
directly with the ARM Cortex debug hardware via the debug probe.

If a debug operation fails, or a crash occurs, it is possible that one or more of these processes
may fail to shut down correctly. Therefore, if the IDE has no active debug connection but is
experiencing problems making a new debug connection, ensure that none of these executables
is running. To simplify this process an IDE button % is provided to kill all low level debug
executables. Therefore should a debug operation fail or a crash occur, simply click this button
before starting a new debug operation.

P&E Debug Connections

P&E Micro software and drivers are automatically installed when MCUXpresso IDE installs. There
is no need to perform any additional setup to use P&E Micro debug connections.

Currently we have tested using:

e Multilink Universal (FX)

¢ Cyclone Universal (FX) (USB and Ethernet)

* P&E firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)

Note: Some Kinetis boards ship with OpenSDA supporting P&E VCOM but with no debug
support. To update this firmware visit the OpenSDA Firmware Update pages linked at: Help ->
Additional Resources -> OpenSDA Firmware Updates

P&E Debug Operation

The process to debug via a P&E compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart panel and select the P&E debug probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note: P&E
Launch configuration files will contain the string ‘PE’.

MCUXpresso IDE stores the probe information, along with its serial number in the projects launch
configuration. This mechanism is used to match any attached probe when an existing launcher
configuration already exits.
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To simplify debug operations, MCUXpresso IDE will automatically start P&E’s GDB Server and
select and dynamically assign the various ports needed as required. This means that multiple
P&E debug connections can be started, terminated, restarted etc. all without the need for any
user connection configuration. These options can be controlled if required by editing the P&E
launch configuration file.

For more information see

Note: If the project already had a P&E launch configuration, this will be selected and used. If
they are no longer appropriate for the intended connection, simply delete the files and allow new
launch configuration files to be created.

Important Note: Low level debug operations via P&E debug probes are supported by P&E
software. This includes, Part Support handling, Flash Programming, and many other features.
If problems are encountered, P&E Micro maintain a range of support forums at http://
www.pemicro.com/forums/

4.9.1 P&E Differences from LinkServer Debug
MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug.
When used with P&E debug probes, the debug environment is provided by the P&E debug server.
This debug server does not 100% match the features provided by native LinkServer connections.
However basic debug operations will be very similar to LinkServer debug.
For a description of some common debugging operations using supported debug probes see
Note: LinkServer advanced features such as Power Measurement, Live Global Variables etc. will
not be available via a P&E debug connection. However, additional functionality maybe available
using P&E supplied plugins.
4.9.2 P&E Micro Software Updates
P&E Micro support within MCUXpresso IDE is via an Eclipse Plugin. The P&E update site is
automatically added to the list of Available Software Update sites.
To check whether an update is available, please select:
Help -> Check for Updates
Any available updates from P&E will then be listed for selection and installation.
Note: P&E Micro may provide news and additional information on their website, for details see
https://www.pemicro.com
4.10 SEGGER Debug Connections
SEGGER J-Link software and documentation pack is installed automatically with the
MCUXpresso IDE Installation for each host platform. No user setup is required to use the
SEGGER debug solution within MCUXpresso IDE.
Currently we have tested using:
¢ J-Link debug probes (USB and Ethernet)
¢ J-Link firmware installed into on-board OpenSDA debug probe hardware (as shipped by default
on certain Kinetis FRDM and TWR boards)
¢ J-Link firmware installed onto LPC-Link2 debug hardware and LPCXpresso V2/V3 boards
« for details see https://www.segger.com/Ipc-link-2.html
« also for firmware programming see http://www.nxp.com/LPCSCRYPT
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4.10.1

SEGGER software installation

Unlike other debug solutions supplied with MCUXpresso IDE, the SEGGER software installation
is not integrated into the IDE installation, rather it is a separate SEGGER J-Link installation on
your host.

The installation location will be similar to:

On Wndows: C:./Program Files (x86)/SEGGER JLi nk_V630
On Mac: /Applications/ SEGGER/ JLi nk_V630
On Linux: /opt/SEGGER/ JLi nk

MCUXpressolDE automatically locates the required executable and it is remembered as a
Workspace preference. This can be viewed or edited within the MCUXpresso IDE preferences
as below.

Figure 4.15. Segger Preferences

e e Preferences
J-Link Options e vw

> General SEGGER J-Link probe preferences
FCiC++
*Help J-Link Server exacutable [Applications/SEGGER/JLink_V630k/JLinkGDBServerCLExe Browse...
¥ Install/Update i . .
»Java Enable discovering of SEGGER J-Link IP probes

MCUXpresso Config T [ Enable SEGGER J-Link user actions

¥MCUXpresso IDE
Debug Options (Ad'
Debug Options (Mis J-Link Server SWO: initial auto discover port | 2332
Debug Probe Disco
Default Tool setting

J=Link Server: initial auto discover port 2331

J-Link Server Telnet: initial auto discover port 2333

General J-Link port auto discover retries attempts 100
J-Link Options Enable Instruction Trace service

LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trz
MCU settings
Paths and Directori:
PEMicro Opticns
Quickstart Panel
SDK Options

User Interface Enat
Utilities

Restore Defaults Apply

? Cancel
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Note: this preference also provides the option to enable scanning for SEGGER IP probes (when
a probe discovery operation is performed). By default, this option is disabled.

From time to time, SEGGER may release later versions of their software, which the user could
choose to manually install. For details see https://www.segger.com/downloads/jlink

MCUXpresso IDE will continue to use the SEGGER installation path as referenced in a projects
workspace unless the required executable cannot be found (for example, the referenced
installation has been deleted). If this occurs:

1. The IDE will automatically search for the latest installation it can find. If this is successful, the
Workspace preference will automatically be updated

2. If a SEGGER installation cannot be found, the user will be prompted to located an installation

To force a particular workspace to update to use a newer installation location simply click the
Restore Default button.

To permanently select a particular SEGGER installation version, the location of the SEGGER
GDB Server can be stored in an environment variable.

For example, under Windows you could set:
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MCUX_SEGGER_SERVER="C: / Program Fi | es (x86)/ SEGGER/ JLi nk_V630k/ j Li nkGDBSer ver CL. exe"

This location will then be used, overriding any workspace preference that maybe set.
SEGGER software un-installation

If MCUXpresso IDE is uninstalled, it will not remove the SEGGER J-Link installation. If this is
required, then the user must manually uninstall the SEGGER J-Link tools.

Note: If for any reason MCUXpresso IDE cannot locate the SEGGER J-Link software, then the
IDE will prompt the user to either manually locate an installation or disable the further use of the
SEGGER debug solution.

SEGGER Debug Operation

The process to debug via a J-Link compatible debug probe is exactly the same as for a native
LinkServer (CMSIS-DAP) compatible debug probe. Simply select the project via the ‘Project
Explorer’ view then click Debug from the QuickStart Panel and select the SEGGER Probe from
the Probe Discovery Dialogue.

If more than one debug probe is presented, select the required probe and then click ‘OK’ to start
the debug session. At this point, the projects launch configuration files will be created. Note:
SEGGER Launch configuration files will contain the string ‘JLink’.

To simplify debug operations, MCUXpresso IDE will automatically start SEGGER’s GDB Server
and select and dynamically assign the various ports needed as required. This means that multiple
SEGGER debug connections can be started, terminated, restarted etc. all without the need for
any user connection configuration. These options can be controlled if required by editing the
SEGGER launch configuration file.

In MCUXpresso IDE, SEGGER Debug operations default to using the SWD Target Interface.
When debugging certain multicore parts such as the LPC43xx Series, the JTAG Target Interface
must be used to access the internal Slave MCUs. To select JTAG as the Target Interface, simply
edit the SEGGER launch configuration file and select JTAG.

For more information see

Note: If the project already had a SEGGER launch configuration, this will be selected and used.
If an existing launch configuration file is no longer appropriate for the intended connection, simply
delete the files and allow new launch configuration files to be created.

Tip

@ New in MCUXpressolDE version 10.3.0. If Reset before running is set in the Launch
configuration, then a default inteligent reset will be used. This reset automatically
supports running from Flash or RAM. A specific reset type can optionally be set
from the free form text field if required, please consult SEGGER'’s documentation
for available reset types

Important Note: Low level debug operations via SEGGER debug probes are supported by
SEGGER software. This includes, Part Support handling, Flash Programming, and many other
features. If problems are encountered, SEGGER’s provide a range of support forums at http://
forum.segger.com/

SEGGER Differences from LinkServer Debug

MCUXpresso IDE core technology is intended to provide a seamless environment for code
development and debug. When used with SEGGER debug probes, the debug environment is
provided by the SEGGER debug server. This debug server does not 100% match the features
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provided by native LinkServer connections. However basic debug operations will be very similar
to LinkServer debug.

For a description of some common debugging operations using supported debug probes see

Note: LinkServer features such as Power Measurement, Live Global Variables etc. will not be
available via a SEGGER debug connection. However, additional functionality maybe available
using external SEGGER supplied applications.

4.12 SEGGER Troubleshooting

When a debug operation to a SEGGER debug probe is performed, the SEGGER GDB server
is called with a set of arguments provided by the launch configuration file. The command and
resulting output is logged within the IDE SEGGER Debug Console. The console can be viewed
as below:

S hEECER ™B-
# 1 FreeRTOS Task Aware Debugger Console version 1.0.3 (201804111610)
El 2 CDT Global Build Console
£l 3 CDT Build Console [frdmk64f_bubble]

4 RedlinkServer
5 frdmkB4f bubble JLink Debug [GDB SEGGER Interface Debugging] gdb traces

v BA 6 JLinkServer JLink600102843 for frdmk84f_bubble
R Interface Debugging] frdmk64f_bubble.axf

Figure 4.16. Segger Server

The command can be copied and called independently of the IDE to start a debug session and
explore connection issues.

Below is the shortened output of a successful debug session to a Kinetis K64 Board.

[18-4-2018 02:22:11] Executing Server: /Applications/ SEGGER/ JLi nk_V630k/ JLi nkGDBSer ver CLExe /
-nosil ent -swoport 2332 -sel ect USB=600102843 -telnetport 2333 -singlerun -endian little /
-noir -speed auto -port 2331 -vd -device MK64FNLMDxxx12 -if SWD -halt -reportuseraction

SEGCER J-Link GDB Server V6.30k Cormmand Line Version
JLi nkARM dI | V6. 30k (DLL conpiled Apr 9 2018 18: 32: 22)
Command |ine: -nosilent -swoport 2332 -sel ect USB=600102843 -tel netport 2333 -singlerun /

-endian little -noir -speed auto -port 2331 -vd -device MK64FNIMDxxx12 -if SWD -halt /

-reportuseraction

GDBInit file: none
GDB Server Listening port: 2331
SWO raw out put |istening port: 2332
Terminal 1/0 port: 2333
Accept renote connection: yes

Generate logfile: of f

Verify downl oad: on

Init regs on start: of f
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Si | ent node: of f
Si ngl e run node: on
Target connection tineout: 0 s

J-Link Host interface: USB
J-Link script: none
J-Link settings file: none

—————— Target related settings------

Tar get devi ce: MK64FN1IMDxxx12
Target interface: SW

Target interface speed: aut o

Tar get endi an: little

Connecting to J-Link...

J-Link is connected.

Devi ce " MK64FNLMDXXX12" sel ect ed.

Fi rmware: J-Link V10 conpiled Mar 29 2018 17:45: 34
Har dwar e: V10. 10

S/'N: 600102843

Feature(s): RD, FlashBP, FlashDL, JFl ash, GDB
Checki ng target voltage...

Target voltage: 3.29 V

Li stening on TCP/IP port 2331

Connecting to target...lnitTarget()

Found SWDP with | D 0x2BA01477

Scanning AP map to find all avail abl e APs

AP[ 2]: Stopped AP scan as end of AP nmap has been reached
AP[ 0] : AHB-AP (I DR 0x24770011)

AP[1]: JTAG AP (I DR 0x001C0000)

Iterating through AP map to find AHB-AP to use
AP[0]: Core found

AP[ 0] : AHB- AP ROM base: OxEOOFF000

CPUI D regi ster: 0x410FC241. |nplenenter code: 0x41 (ARM
Found Cortex-M4 rOpl, Little endian.

FPUnit: 6 code (BP) slots and 2 literal slots

Cor eSi ght conponent s:

ROMTbI [ 0] @ EOOFF000

ROMIbl [0] [ 0] : EOOOEOOO, CID: B1O5E00D, PID: 000BBOOC SCS- M7
ROMIbI [0] [1] : EO0001000, CI D: B10O5E00D, PID: 003BB0O02 DWI
ROMIbI [0] [ 2] : EO0002000, CI D: B1O5EO00D, PID: 002BB0O03 FPB
ROMIbI [0] [ 3] : EO0000000, CID: B1O5EO00D, PID: 003BB00O1 | TM
ROMIbl [ 0] [ 4] : EO0040000, CI D: B105900D, PID: 000BB9A1 TPI U
ROMIbI [0] [ 5] : EO0041000, CI D: B105900D, PID: 000BB925 ETM
ROMIbI [0] [ 6] : EO0042000, CI D: B105900D, PID: 003BB907 ETB
ROMIbI [0] [ 7]: EO0043000, CI D: B105900D, PID: 001BB908 CSTF

I ni t Tar get ()

Found SWDP with | D 0x2BA01477

AP map detection skipped. Manually configured AP map found.
AP[ 0] : AHB-AP (IDR Not set)

Connected to target

Waiting for GDB connection...Connected to 127.0.0.1
Readi ng all registers

Read 4 bytes @ address 0x0000582C (Data = 0xB004BEAB)
Read 2 bytes @ address 0x0000582C (Data = OxBEAB)
Readi ng 64 bytes @ address 0x00005800

Recei ved nonitor conmmand: reset
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Reset: Halt core after reset via DEMCR VC CORERESET.

Reset: Reset device via Al RCR SYSRESETREQ

Af t er Reset Tar get ()

Resetting target

Downl oadi ng 16032 bytes @ address 0x00000000 - Verified OK
Downl oadi ng 10280 bytes @ address O0x00003EA0 - Verified OK
Downl oadi ng 12 bytes @ address 0x000066C8 - Verified OK
J-Link: Flash downl oad: Bank O @ 0x00000000: Skipped. Contents already match
Witing register (PC = 0x00000204)

Readi ng all registers

Read 4 bytes @ address 0x00000204 (Data = 0xB672B510)

Readi ng 64 bytes @ address 0x00000C40

Read 2 bytes @ address 0x00000C62 (Data = 0xF107)

Recei ved nonitor command: sem hosting enabl e

Sem - hosting enabl ed (Handl e on BKPT)

Recei ved nonitor conmmand: exec SetRestartOnd ose=1

Execut ed Set Restart OnCl ose=1

Setting breakpoint @address 0x00000C62, Size = 2, BPHandl e = 0x0001
Starting target CPU...

... Breakpoi nt reached @ address 0x00000C62

Readi ng all registers

Renovi ng breakpoi nt @ address 0x00000C62, Size = 2

Read 4 bytes @ address 0x00000C62 (Data = 0x0320F107)

Note: If a SEGGER debug operation is not successful, the IDE will generate an error dialogue,
the 'Details' button can be clicked to display a copy of the SEGGER server log. One possible
reason for a SEGGER debug operation to fail is due to a Device hame mismatch. MCUXpresso
IDE will try to supply the expected Device name to SEGGER server, however on rare occasions
this may not be the name expected. The SEGGER launch configuration Device entry can be
populated via a drop down list or via a user supplied device name.

If required, additional server options can be set within the SEGGER launch configuration. For
example to capture logging information to a file, you can set the additional server option:

-log $(CWD)/ ny. | og

where $(CWD) represents the current working directory of the debug connection, i.e. the
dynamically created project build configuration folder.
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5. SDKs and Preinstalled Part Support Overview

To support a particular MCU (or family of MCUs) and any associated development boards, a
number of elements are required. These break down into:
e Startup code

« This code will handle specific features required by the MCU
¢ Memory Map knowledge

e The addresses and sizes and types of all memory regions
« Peripheral knowledge

» Detailed information allowing the MCUs peripherals registers to be viewed and edited
¢ Flash Drivers

« Routines to program the MCU'’s on and off chip Flash devices as efficiently as possible
« Debug capabilities

« Knowledge of the MCU debug interfaces and features (e.g. SWO, ETB)

« Example Code (this is not strictly required or a part support element)

» Code to demonstrate the features of the particular MCU and supporting drivers
Collectively, this data is known as Part Support, MCUXpresso IDE uses these data elements for
populating its wizards, and for built in intelligence features, such as the automatic generation of
linker scripts etc.

MCUXpresso IDE delivers its part support through an extensible scheme.

5.1 Preinstalled Part Support
Firstly the IDE installs with an enhanced version of the part support as provided with LPCXpresso
IDE v8.2.2. This provides support for the majority of LPC Cortex-M based parts ‘out of the box'.
This is known as preinstalled part support.
Example code for these preinstalled parts is provided by sophisticated LPCOpen packages (and
Code Bundles). Each of these contains code libraries to support the MCU features, LPCXpresso
boards (and some other popular ones), plus a large number of code examples and drivers.
Version of these are installed by default at:
<install dir>/idel/ Exanpl es/ LPCOpen
<install dir>/idel/ Exanpl es/ CodeBundl es
Further information can be found at:
http://www.nxp.com/Ipcopen
https://www.nxp.com/LPC800-Code-Bundles
5.2 SDK Part Support
Secondly, MCUXpresso IDE’s part support can be extended using freely available MCUXpresso
SDK v2.x packages. These can be installed via a simple ‘drag and drop’ mechanism which will
then automatically enhance the IDE with new part and board knowledge (and usually a large
range of examples).
SDKs for MCUXpresso IDE can be generated and downloaded as required using the SDK Builder
on the MCUXpresso Tools website at:
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http://mcuxpresso.nxp.com/
SDK 2.x packages are used to add support for all Kinetis, iIMXRT and newer LPC MCUs.
Once an SDK has been installed, the included part support becomes available through the

New Project Wizard and also the SDK example import Wizard, and for use by

Important Note: Only SDKs built specifically for MCUXpresso IDE are compatible with
MCUXpresso IDE. SDKs created for any other toolchain will not work! Therefore, when
generating an SDK be sure that MCUXpresso IDE is specified as the Toolchain.

Differences in Preinstalled and SDK Part Handling

Since SDKs combine part (MCU) and board support into a single package, MCUXpresso IDE
is able to provide linkage between SDK installed MCUs and their related boards when creating
or importing projects.

For preinstalled parts, the board support libraries are provided within LPCOpen packages and
Code Bundles. It is the responsibility of the user to match an MCU with its related LPCOpen
board and chip library when creating or importing projects.

Creating and importing project using Preinstalled and SDK part support is described in the
following chapters.

Note: When exporting or sharing projects with Preinstalled part support, no special actions are

required, since other installations of MCUXpresso IDE will provide the required part support. For
sharing projects created from SDKs, please see

Viewing Preinstalled Part Support

When MCUXpresso IDE is installed, it will contain preinstalled part support for most LPC based
MCUs.

To explore the range of preinstalled MCUs simply click ‘New project’ in the QuickStart panel.
This will open a page similar to the image below:
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e ® SDK Wizard

| €3 Please select a target device or a board } y k /i ;'.

|
| . Board and/or Device selection page

~ SDK MCUs Available boards LA

MCUs from installed SDKs Please select an available board for your project.

Target

PNEV74628 LPCXpressoB12 LPC8NO4 Development Board

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
*LPC112x
FLPCT1AXX
»LPC11E6X
»LPC11Exx
FLPC11UBx LPCXpresso845-MAX LPCXpresso824-MAX LPCXpressoB02
»LPC11Uxx
FLPCT1xx

\rl.pm TxalV /

Selected Device: SDKs for selected MCU

Target Core: Name SDK Version  Manifest Versior Location

‘ Description:

-@ Cancel

Figure 5.1. New Project Wizard

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching LPCOpen
Library or Code Bundle is available.

For creating project with preinstalled part support please see:

If you intend to work on an MCU that is not available from the range of preinstalled parts, for
example a Kinetis MCU, then you must first extend the part support of MCUXpresso IDE by
installing the appropriate MCU SDK.

5.4 Obtaining and Installing an SDK

SDKs are installed and managed via the Installed SDKs view, which is located by default as the
first tab within the Consoles view. See item 3 for more information.

SDKs are free to download (login is required); MCUXpresso IDE offers a link to the SDK portal
(shown below) from the Installed SDK Console view. From this portal, required SDKs can
be downloaded onto the host machine. Alternatively, go to Help -> Additional Resources ->
MCUXpresso SDK Builder ... to open this portal in an external browser.
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[ ] - nxp.com - MCUXpresso IDE
(miid S @-iQw e A% N O Qi * iy T At ¢
LPE = J Welcome | MCUXpresso SOK Builder &8
= =
v (X |
A T

IDE ) (_SDK |

OQu=G -y = =a

MCUXpresso IDE - Qt

Ciee’) Mo project selected

OVERVIEW SOFTWARE AND TOOLS DEVELOPER RESOURCES
* Create or import a project
8 New project
mport SDK example(s)
# import project(s} from f Getting started with MCUXpresso SDK is simple.
~ Bulld your project
@ ) Do you have a development board?
Start by clicking on Select Development Board to download a customized SDK for that specific platform.

» Debug your project

Are you returning and seeking previously downloaded SDKs?

~ Miscellaneous Privacy Policy Terms of Use Contact @ 2018 NXP Semicd! Lors. All rights reserved.

¢ Quick Settings>> ) Installed SDKs £ | Problem: Memor Debugger Console nstruction Trace D Power Measurement T s SWO Trace Conf # Terminal

0 Installed SDKs

| [ Build all projects [1
Toinstall an SDK, simply drag and drop an SDK (zip fileffolder) inta the ‘Installed SDKs' view.

W workspace

Figure 5.2. SDK Import

Once downloaded, an SDK package(s) can be installed by simply dragging from the downloaded
location into the Installed SDKs view. Once released, you be prompted with a dialog asking you
to confirm the import — click OK. The SDK pagkage(s) will then be automatically installed into
MCUXpresso IDE part support repository.

Once complete the “Installed SDKs” view will update to show you the package(s) that you have
just installed.

7 Installed SDKs 52 [] Properties & Console [*| Problems [J Memory B3 Debugger Console 3 Instruction Trace ED Power Measurement Tool [ SWO Trace Config @ &. O

0 Installed SDKs

To install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs* vie\-l. [Common 'mcuxpresso’ folder] I

Name SDK Vi Manifest Version Location SDK Detalls

© 4 SDK_2.x_EVK-MIMXRT1020 2A40i1335b25148d 2018-06-12) 3.3.0 [ <Common>/SDK_2.4_EVK-MIMXRT1020.zip

11 SDK_2.%_EVKB-IMXRT1050  2.4.0 3.3.0 i /SDK_2.4-EVKB-IMXRT1050_max.zip Swiaclad SOt conte
11 SDK_2.x_FROM-KB4F 242 3.3.0 = /SDK_2.4.2_FRDM-KB4F

11 SDK_2.x_FRDM-KE1562 2.4.1 3.3.0 () /SDK_2.4_FRDM-KE16Z.zip > Bl Boards

i+ SDK_2.x_LPCXpresso54618 2.4.1 3.3.0 ] /SDK_2.4.1_LPCXpresso54618.zip » B Devices

» s Compilers

» 3 Toolchains

» B Toolchain Settings
» i} Components

Figure 5.3. SDK Import View

By default, SDKs will install into a Common folder and will therefore be available to any
MCUXpresso IDE instance. Alternatively SDKs can be installed into the current Workspace so

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.3.0 — 16 November, 2018 45




NXP Semiconductors MCUXpresso IDE User Guide

5.4.1

MCUXpresso IDE User Guide -

making their installation local to that Workspace. The selected install location is shown in the
SDK Window text as highlighted above. Also highlighted is the new version information string
(displayed in grey), this feature allows different SDK builds to be distinguishable. Please also
see for further information on SDK installation options.

SDK Notes:

¢ Released in parallel with MCUXpresso IDE version 10.3.0 are updated SDKs
(MCUXpressoSDK v2.5.x). These are indicated by their version 2.5.x and a manifest version
3.5.0 in the Installed SDK view. While older SDKs are still compatible with MCUXpresso IDE
version 10.3.0, it is recommended that users check and update to the latest available SDK
package.

« Installed SDK view tooltips display comprehensive version information

¢ MCUXpresso IDE can import an SDK as a zipped package or unzipped folder. Typically
importing as a zipped package is expected.

e The main consequence of leaving SDKs zipped is that you will not be able to create (or
import projects) into a workspace with linked references back to the SDK source files.

« When an SDK is imported via drag and drop, required files are copied and the original file/folder
is unaffected. The copied files are installed into a default location allowing imported SDKs to be
shared among different IDE instances/installations and workspaces. Data from imported SDKs
is populate wizards with available MCU and board information. In addition they are parsed to
generate part support and make example projects and drivers available etc.

« By default, SDKs (like workspaces) are located in user local storage, this means they will
only be available to the user who performed the installation. Please also see
for details of how a shared location could be used if needed.

¢ Once installed the part support provided by the SDKs is regenerated. This regeneration is
required because an MCUs part support may be specified (with different versions) within more
than one SDK. On rare occasions, it may be necessary to force a regeneration of SDK part
support, this can be done by clicking the Recreate and Reload button within the top right block
inside the Installed SDK view, or by right clicking within the view and selecting Recreate.

Installed SDKs Operations
Many operations are available from the Installed SDK view some from a right click menu options:
- Import archive...

<> Import folder...
(& Open Default Location

| G sDK Documentation > |
i SDK Info >
> Open Location
A& Unzip archive
¥ Delete SDK

2.+ Recreate

From here you can perform many actions such as view associated embedded SDK
documentation that would otherwise require the unzipping and exploration of the SDK structure.

The Installed SDKs display will show whether the SDKs are stored as zipped archives or regular

folders. MCUXpresso IDE offers the option to unzip an archive in place via a right click option
onto the selected SDK (as below).
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<2 Import archive...
~ Import folder...
= Open Default Location

[0 SDK Documentation >
i SDKInfo [S
> Open Location

I & Unzip archive |

& Delete SDK

2 Recreate

Note: Unzipping an SDK may take some time and is generally not needed unless you wish to
make use of referenced files or perform many example imports (where some speed improvement
will be seen).

Once an SDK has been unzipped, its icon will be updated to reflect that it is now stored internally
as a folder.

Figure 5.4. SDK Unzipped

() Installed SDKs %% [] Properties & Console [*! Problems [J Memory G Debugger Console @ Instruction Trace 2 Power Measurement Tool [ SWO Trace Config @ 2. O
0 Installed SDKs
To install an SDK, simply drag and drop an SDK (2ip fileffolder) into the 'Installed SDKs' view. [Common 'mcuxpresso’ folder]

Name SDK Version Manifest Version  Location

SDK Details
1 SDK_2.x_EVK-MIMXRT1020 2.4.0(1835b25f48d 2018-06-12) 3.3.0 [, <Common>/SDK_2.4_EVK-MIMXRT1020.zip

Selected SDK content

# SDK_2.x_EVKB-IMXRT1050 240 3.3.0 /SDK_2.4-EVKB-IMXRT1060_max.zip

41 SDK_2.x_FRDM-K64F 242 3.3.0 /SDK_2.4.2_FRDM-K64F

4 SDK_2.x_FROM-KE15Z 241 3.3.0 e ISDK_2.4_FRDM-KE15Z.zip » W@l Boards
41 SDK_2.x_LPCXpresso54618 241 3.3.0 ) /SDK_2.4.1_LPCXpresso54618.zip > B oevices

» b Compilers

» 8 Toolchains

» (8 Toolchain Settings
» g Components

MCUXpresso IDE User Guide -

Many other options are available such as examining SDK XML description files, and managing
the library of installed SDKs.

Tip

@ To edit (and save) SDK XML files, the SDK must first be unzipped and the following
preference changed: Preferences -> MCUXpresso IDE -> SDK Handling -> Misc,
uncheck the read only mode option. Once saved, changes will become permanent
for that SDK installation.

Finally, SDK part support automatically regenerates when a new SDK is installed. If a project is
imported and the expected part support is not available then select Recreate from the right click
menu option to force a recreation of the SDK part support.

Deleting an Installed SDK

If an SDK has been installed by the ‘Drag and Drop’ method, then a copy of the SDK will have
been installed into the Default Location. SDKs installed into this location can be deleted via a right
click option. Once an SDK has been deleted, then part support will automatically be recreated
for the remaining SDKs. Please see for more information.

Along side each installed SDK is a check box, if this is unchecked the SDK will be hidden
from MCUXpresso IDE until re-checked. If multiple SDKs are installed that contain shared part
support, then this feature may be useful to force the selection of part support from a particular
SDK. Please see for more information.

SDKs installed into non default locations must be manually deleted or hidden if they are no longer
required. Note: you may have to quit MCUXpresso IDE to delete these SDKs. Please see
for more information.
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5.4.2 Installed SDKs Features

You can explore each of the SDKs within the Installed SDKs view to examine content such as
Components, Memory Settings, included Examples etc.

({0 Installed SDKs &2 [ Properties Bl Console [*! Problems [J Memory &} Debugger Console € Instruction Trace ED Power Measurement Tool |5 SWO Trace Config @ 2. O = = <
@ Installed SDKs

Ta install an SDK, simply drag and drop an SDK (zip file/folder) into the 'Installed SDKs' view. [Common 'mcuxpresso’ folder]

Name SDK Version Manifest Version Location

i SDK_2.x EVK-MIMXRT1020  2.4.0 (1835b25f48d 2018-06-12) 2.3.0 [ <Common>/SDK_2.4_EVK-MIMXRT1020.2ip E0K Dasnds

B #SDK_2.x EVKB-IMXRT1050  2.4.0 3.3.0 i) /SDK_2.4-EVKB-IMXRT1060_max.zip Seiested SDis contont.

B i SDK_2.x_FROM-K64F 2.4.2 3.3.0 &= /SDK_2.4.2_FRDM-K64F

[ i SDK_2.x_ FROM-KE15Z 2.4.1 3.3.0 [} /SDK_2.4_FRDM-KE15Z.zip * [ Boaras

# SDK_2.x_LPCXpresso54618  2.4.1 3.3.0 [} /SDK_2.4.1_LPCXpresso54618.zip EEVIE N R 020 100
» 3 Debug Configurations
¥ =5 Examples

» = cmsis_driver_example:
» = demo_apps
» = driver_examples
lwip_examples
» E usb_examples
» ik Memory Settings
» ﬂ Devices

(2

i 000 o8

Figure 5.5. SDK Explore

5.4.3 Advanced Use: SDK Importing and Configuration

SDK importing via drag and drop incorporates two features. Firstly the location where the SDK
will be copied, and secondly the automatic scanning of this location to create the required
Part Support. The behaviour can be explored and changed via a preference Preferences ->
MCUXpresso IDE -> SDK Handling -> Installation leading to the window below:
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» General
»C/C++
»Help
» Install/Update
»Java
» Library Hover
MCUXpresso Config Tools
¥YMCUXpresso IDE
Debug Options (Advanced)
Debug Options (Miscellane
Debug Probe Discovery
Default Tool settings
General
J-Link Options
LinkServer Options
LPC-Link Options
LPC-Link2 SWO Trace
MCU settings
Paths and Directories
PEMicro Options
Quickstart Panel
¥ SDK Handling
Components
Misc
User Interface Enablement
Utilities
» Mylyn
*Run/Debug
> Team
» Terminal
Validation
| » XML

Figure 5.6. SDK Preferences

Preferences

Installation =R
Manage SDK usage within MCUXpresso IDE
SDK locations

SDK Drag&Drop install location

Workspace ° Common 'mcuxpresso’ folder User defined folder
User defined folder

SDK search roots:

Wﬁkﬂﬁﬂ New...
{Users/NXP/imcuxpresso/01/SDKPackages

SDK refresh policy on startup
Refresh and recreate part info

Other options
Always unzip SDK zipped files when installing

Do not ask for unzipping SDK on import

Do not ask for confirmation on SDK Drag and Drop install
Make missing SDK reference persistent
Do not ask user action for missing SDK reference in project

Enable SDK/manifest versions switch (needs an IDE restart)

Restore Defaults

Cancel

Note: You can see there are actually two default search locations specified but the highlighted

location will be used for new installations. Please see
for more information.

From here you can the see available the drag and drop locations:

* Workspace
e Common (the default)
e User Defined

The default Common install location can be changed to either the currently selected Workspace
or a User Defined location. Once this is done, a new SDK Search Root path will automatically
be added to the seach roots list.

Note: while other search roots can be removed if desired, the currently selected drag and drop
location root cannot.

In addition, from this dialogue you can add new search paths to folders where you have stored
or plan to store SDK folders/zips. Those SDKs will appear in the Installed SDKs View along with
those from the default location when the Installed SDK view is refreshed.

The main differences between having SDKs in the default location(s) or leaving them in other
folders are:
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« “Delete SDK” function is disabled when using non-default locations
* since these SDKs are not imported, they may be original files
¢ The knowledge of the SDKs and their part support is per-workspace

The order of the SDKs in the SDK location list may be important on occasion: if you have multiple
SDKs for the same part in various locations, you can choose which to load by reordering. If
multiple SDK are found, a warning is displayed into the Installed SDK view.

Note: Only the default SDK location(s) is persistent between workspaces. Any other locations
must be created for each Workspace as required.

Other SDK Options

Also from the previous dialogue, are two distinct sets of options; the first to control the handling
of adding (and removing) SDK components. Please see the section

for more information. The second set of ‘other options’ are a self describing
set of features.

Important notes for SDK Users

Installing an SDK into MCUXpresso IDE adds to its default capabilities, but SDKs come in many
different configurations, and versions. The section below discusses some of the issues that users
may experience when working with SDKs.

Only SDKs created for MCUXpresso IDE can be used

If an error of the form MCUXpresso IDE was unable to load one or more SDKs is seen, the most
likely reason is that the SDK was not built for MCUXpresso IDE. Within the SDK Builder, verify
that the Toolchain is set to MCUXpresso IDE. If necessary, reset the toolchain to MCUXpresso
IDE and rebuild the SDK.

SDK compatibility with earlier versions of MCUXpresso IDE

As mentioned earlier, a new SDK version 2.5.0 has been released in parallel with MCUXpresso
IDE version 10.3.0 however, this SDK format includes features that are not compatible with earlier
versions of MCUXpresso IDE. As a result, these new SDKs may fail to install or offer reduced
featured when used in older versions of MCUXpresso IDE.

To support users who might have both this and also older versions of MCUXpresso IDE installed
on their system, we have adopted a new default SDK installation location but also maintained
support for the default used by older versions (now effectively Read Only from version 10.1.0
onwards).

The result of this is that MCUXpresso IDE version 10.1.0 and later will automatically inherit any
SDKs installed into the (old) default location by previous versions of the IDE. While older versions
of the IDE will not ‘see’ any SDKs installed with MCUXpresso IDE version 10.1.0 or later.

Note: If there is no need to maintain compatibility with older versions of the IDE, it is
recommended that users migrate to using the latest SDKs where available.

Shared Part Support Handling

Each SDK package will contain part support for one or more MCUs, therefore it is possible
to have two (or more) SDK packages containing the same part support. For example, a user
might request a Tower K64 SDK and later a Freedom K64 SDK that both target the same
MK64FN1MOxxx12 MCU. If both SDKs are installed into the IDE, both sets of examples and
board drivers will be available, but the IDE will select the most up to date version of part support
specified within these SDKs. This means the various wizards and dialogues will only ever present
a single instance of an MCU, but may offer a variety of compatible boards and examples. Note: If
a board is selected (from one SDK) and part support is provided by another SDK, a message will
be displayed within the project wizard to show this has occurred but no user action is required.
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If two SDKs with matching part support are installed, and the SDK providing part support later
deleted, then part support will automatically be used from the remaining SDK.

Finally, if a project created with one SDKs part support — for example Freedom K64, and then:
- that SDK is changed to another SDK with compatible part support — for example TWR K64 -
the project is shared with another user who has a different SDK that includes compatible part
support (perhaps an SDK that has only device support)

a dialogue similar to the one below will be generated for each project where this occurs:

@ Project SDK management

1 The project '"MKB4FN1MOxxx12_My Shared_Project' SDK 'SDK_2.x_FRDM-KB4F' cannot be
found.
Please select a compatible SDK for chip ‘"MK64FN1MOxxx12' to use:

SDK_2.x_TWR-K64F120M [2.4.0] k4 [ Make SDK persistent

Cancel | SN

Where the option to Make persistent will permanently change the project to be associated with
the selected SDK. If unticked, the IDE will accept the change as temporary and no data will be
written back to the project.

Note: When this new association is made, the project will contain files from one SDK but be
associated with another. If the project is refreshed or the component management feature is
used, then incompatible code may be copied into the project.

Building a Fat SDK

An SDK can be generated for a selected part (processor type/MCU) or a board. If just a part is
selected, then the generated SDK will contain both part support and also board support data for
the closest matching development board.

Therefore, to obtain an SDK with both Freedom and Tower board support for say the Kinetis
MK®64... part, simply select the part and the board support will be added automatically.

If a partis chosen that has no directly matching board, say the Kinetis MK63... then the generated
SDK will contain:

e part support for the requested part i.e. MK63...

« part support for the recommended closest matching part that has an associated development
board i.e. MK64...

¢ board support packages for the above part i.e. Freedom and/or Tower MK64...
Uninstallation Considerations

MCUXpresso IDE allows SDKs to be installed and uninstalled as required (although for most
users there is little benefit in uninstalling an SDK). However, since the SDK provides part support
to the IDE, if an SDK is uninstalled, part support will also be removed. Any existing project built
using part support from an uninstalled SDK will no longer build or debug. Such a situation can
be remedied by re-installing the missing SDK. Note: if there is another SDK installed capable of
providing the ‘missing’ part support, then this will automatically be used.

Sharing Projects

Note: Also see below:
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If a project built using part support from an SDK and is then exported — for example to share the
project with a colleague who also uses MCUXpresso IDE, then the colleague must also install
an SDK providing part support for the projects MCU.

Enhanced Project Sharing Features

Introduced in MCUXpresso IDE version 10.2.0 are a range of features designed to improve the
ease of project sharing. These features combine to streamline the sharing and collaboration
process.

Project Drag and Drop

In addition to the existing project import and export capabilities available from the Quickstart
panel, a new set of features has been introduced to ease the transfer of projects.

Previously, the import of a project required the browsing to a project location followed by an
import ...

¢ Projects can now be imported into a Workspace by simply dragging and dropping a folder (or
Zip) containing one or more projects into the Project Explorer view

» Projects can be copied from one IDE instance to another by simply dragging and dropping
from one Project Explorer view to another

« Projects can also be exported by dragging from the Project Explorer view onto a host filer

» Warning: Care must be used here since the default Eclipse (Oxygen) behaviour is to
move files from the workspace rather than perform a copy. This behaviour can be
modified to copy on Mac via holding the Option Key, and on Windows via holding Ctrl.

Project Local SDK Part Support

One weakness of the SDK model of extending the capabilities of the IDE comes when sharing
projects with colleagues — since they must also have the same SDK installed to use this shared
project.

To avoid this problem, SDK projects (and examples) can be modified to contain a local copy of
the required SDK part support.

SDK project may be enhanced to contain local SDK part support

« SDK based projects can now import a cache of part knowledge from an installed SDK
< Simply right click on a project and select add SDK Part Support
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¥ 25 MKBAFN 1MOxxx12_My Shared_Project

Build Configurations
Build Targets
Index

Validate

Run As

Debug As

Profile As

Restore from Local History...
Launch Configurations
Smart update

v & MK64FN 1MOxxx12_My Shared_Project
» € Project Settings 4 l ¥ =i Project Part Support
[ 3 ﬁ' Binaries New > ¥ o SOK version 2.4.0 package for FRDM-KE4F board
» 5} Includes Go Into » il Boards
» B CMSIS * Open in New Window ¥ [uy Compilers
» (2 board ‘Show in Local Terminal > %Cnmmnen*s
» (D drivers S » 3 Devices
» (3 source — = Copy, » (% Toolchain Settings
Paste » & Toolchains
. stgft'up W e » € Project Settings
» 2 utilities Seiiie i g
» (= Debug Move... L gll:z:::;z
> (=doc Rename... F2 "
- » (2 CMSIS
™ iy Import... » (2 board
5 Export... » (Zdrivers
Build Project » (Zsource
Clean Project > (5 startup
7' Refresh Fs » (5 utilities
Close Project » = Debug
Close Unrelated Projects » (=doc

yrvy

SDK Management
Tools

e D S e Cade Anal

B MCUXpresso Config Tools

# Manage SDK Components
% Refresh SDK Components
™. Add SDK Part Support

YYRAY Y Y

Team
Compare With
Configure
Source

Properties

Figure 5.7. Add SDK Local Part Support

YR

¢ Such projects can then be used (in other users MCUXpresso IDEs version 10.2.0 or later)
without first downloading and installing the appropriate SDK

* In such cases, the project local part support will be visible as an installed SDK

) Installed SDKs £3 [T Properties B Console [2 Problems [J Memory [E3 Debugger Console € Instruction Trace &3 Power Measurement Tool 5] SWO Tra

@ Installed SDKs

Toinstall an SDK, simply drag and drop an SDK (zip file/felder) into the 'Installed SDKs' view. [Common ‘mcuxpresso’ folder]

Name SDK Version

Manifest Version  Location

7 SDK_2.x_EVK-MIMXRT1020 2.4.0 3.3.0 [} /SDK_2.4_EVK-MIMXRT1020.zip
. = 11050 240 330 G = o i
(= SDK_2.x_FRDM-K64F 2.42 3.3.0 (® <Workspace>/MKB64FN1MOxxx12_Project_My_Shared_Project
] & <KETOL 241 3.3.0 [ 4] = .ZIp
11 SDK_2.x_LPCXpresso54618 241 3.3.0 [} /SDK_2.4.1_LPCXpresso54618.zip

Figure 5.8. View SDK Local Part Support

Note: this feature is not designed to replace the need for ultimately installing an SDK, since there
are implications in project size etc. rather it is intended as short term solution to decouple projects

from the requirement for an SDK.
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Finally, local part support can be removed in the same way as it was added. Simply right click on
a project and select SDK Management -> Remove SDK Part Support. Once this has been done,
an appropriate SDK must be installed for the project to be used.

Project Local Support files

Supporting files required for debug such as flash drivers, LinkServer Connect and Reset scripts
will usually be found (automatically) either within an SDK or installed by default within the IDE.

However, on occasion, bespoke flashdrivers and/or scripts may be required. While these files
could be stored and referenced from various locations within the file system, to enhance project
sharing such files can now be included directly within a project and locally referenced.

To use script and flash driver files in this way, first they can simply be dragged into the local
Project structure:

v 25 MKB4FN1MOxxx12_My Shared_Project

» =i Project Part Support

» € Project Settings

» 4 Binaries

> 1t Includes

» (2 CMSIS

» (2 board

» (2 drivers

» 2 source

» (2 startup

» (2 utilities

» (= Debug

» (=doc

] MK64FN1MOxxx12_My Shared_Project LinkServer Debug.launch

2_My Shared_Project LinkServer Release.launch

=| my_connect.scp
= my_flash.cfx

|=| my_reset.scp

LinkServer launch configurations can now be used to directly browse to local scripts (connect
or reset) as shown below:
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LN

Modify configuration and continue.

Edit Configuration

Name: | MK64FN1MOxix12 My Snared Project LinkServer Debug
) Main |1 Common (3% Debuggers, '~ Source| € GUI Flash Tool
B MCuxpresso IDE LinkServer Debugger

Stop on startup at: | main

Debugger Options

Request hardware breakpoint

[T Toroet configuration

Debug options for NXP MK84FN1MOxxx12 (cortex-m4)

Debug Connection SWD [T

MCUXpresso IDE

| Select the elements from the tree:
- |

Configuation Option « Valve
< Additional cptions
[-ep Connect Seript L] l
i Debugger memory cache Disable. i
i Disconnect bahavior )
i Flash Driver Reset Handling
] Load image Connect script
. Maximum wire speed
Miscellaneous !
Emulator selection  LinkServer
T Script
Edit scripts...
Script

Debug options template

Debug Configuration ()

Figure 5.9. Local Script file

Browse scripts...

——

Browse project...

Cance!

Connect script

> (= .settings

¥ =CMSIS

¥ (= Debug

» (= board
(=doc

driye
|Z/ my_connect.scp
Y TESETSCD

>

¥ (= part-support
> (= source
¥ (= startup
> (= utilities

C?) Cancel
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Similarly a project local flash driver can be referenced by editing a projects memory configuration
and again browsing for the required flash driver within the project as below:
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Memory details (MK64FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...

Type Name Alias  Location Size

Oriye

Flash PROGRAM_FLASH Flash 0Ox0 0x10000@ ETFE 4K i '
RAM SRAM_UPPER RAM 0x20000000 0x30000

RAM SRAM_LOWER

RAM2 Ox1fff0000 0x10000 &
RAM FLEX_RAM RAM3 Oy ganannnn avanna

MCUXpresso IDE
LinkServer flash driver

Add Flash Add RAM
Import... Merge...
P 9 Flash Driver
Flash driver | ${workspace_loc}/S{ProiName}/MyFlash.cfx n Browse workspace...
@ @ LinkServer flash driver
- |

Select the elements from the tree:

. A

B MyFlash.cfx
Doard

(=doc

¥ (= drivers

¥ [ part-support

> (= source

> (= startup

¥ (= utilities

Selected flash driver: MyFlash.cfx

Figure 5.10. Local flash driver

See additionally

The features described above will rarely be required, but on the occasions where shared projects
have bespoke debug files, the above scheme should simplify the sharing and use of MCUXpresso
IDE projects.
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6. Creating New Projects using installed SDK Part
Support

For creating project using Preinstalled part support please see:

From the QuickStart Panel in the bottom left of the MCUXpresso IDE window there are two
options:

) Quicks Globa Variabl Breakp Outline = 0O

MCUXpresso IDE - Quickstart Panel

10e | No project selected

~ Create or import a project

B New project...
. Import SDK example(s)...

¥ Import project(s) from file system...

* Build your project

@ /

~ Debug your project E-EH-E-

|

* Miscellaneous

EJ- Quick Settings>>

o Build all projects []

Figure 6.1. SDK Projects

The first will invoke the New Project Wizard, that guides the user in creating new projects from
the installed SDKs (and also from preinstalled part support — which will be discussed in a later
chapter).

The second option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

This option will be explored in the next chapter.

Click New project to launch the New Project Wizard.

6.1 New Project Wizard

The New Project Wizard will begin by opening the “Board and/or device selection” page, this
page is populated with a range of features described below:
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[(D Creating project for device: MK64FN 1MOxxx12 with no board. ]4_ i f i } . \ f /

|
. Board and/or Device selection page

s from installed SDKs

Please select an available board for your project.

NXP MKB4FNTMOxix12
vKéx
MKB4FN1MOxxx12
»LPC540xx
»LPC546xx

» MIMXRT1050 FOMSTBE AR FROM ms(m\ o (H

./

frdmk64f agm04 frdmk64f agm01 evkbimxrt1050 om13588 evkbimxrt1050

aeinstalled MCUs
s from preinstalled LPC and generic

Cortex-M part support

Target

/' Al
»LPC1102 LSek ]
»LPC112x evkbimxrt1050 agm01 Cxpresso812 LPC8NO4 Development Board
FLPC11AxXX
»LPC11E6x
‘ »LPC11Exx
FLPC11UBx
»LPC11Uxx
»LPC11xx
‘ FLPCT 1xxLV
Selected Device: MK64FN1TMOxxx12 with no board. SDKs for selected MCU
Target Core: cortex-md Name SDK Version  Manifest Versjr Location
- 0B o ) i
Deseription: -+ SDK_2.x_FRDM-KB4F 2.4.0 3.3.0 (% <Default Location>/SDK_2.x_FRD
K64_120: Kinetis® K64-120 MHz, 256KB SRA opehtrollers
(MCUs) based on ARME@ Cortex®-M4 Core
® EEEE | coe

Figure 6.2. New Project Wizard first page

1. Adisplay of all parts (MCUSs) installed via SDKs. Click to select the MCU and filter the available
matching boards. SDK part support can be hidden by clicking on the triangle (highlighted in
the blue oval)

2. A display of all preinstalled parts (these are all LPC or Generic M parts). Click to select the
MCU and filter the available matching boards (if any). Preinstalled part support can be hidden
by clicking on the triangle (highlighted in blue)

3. A display of all boards from both SDKs or matching LPCOpen packages. Click to select the
board and its associated MCU.

* Boards from SDK packages will have SDK superimposed onto their image.

4. Some description relating to the users selection

5. A display to show the matching SDK for a chosen MCU or Board. If more than one matching
SDK is installed, the user can select the SDK to use from this list

6. Any Warning, Error or Information related to the current selection

7. An input field to filter the available boards e.g. enter ‘64’ to see matching MK64... Freedom
or Tower boards available

8. 3 options: to Sort boards from A-Z, Z-A or clear any filter made through the input field or a
select click.

Note: Once a project has been created the selected board and/or MCU will be remembered and
selected the next time the wizard is entered. To remove this selection, click the clear filter button
(or any background white space).
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This page provides a number of ways of quickly selecting the target for the project that you want
to create.

In this description, we are going to create a project for a Freedom MK64xxx board (The required
SDK has already been imported).

First, to reduce the number of boards displayed, we can simply type ‘64’ into the filter (7). Now
only boards with MCUs matching ‘64’ will be displayed.

[ XN ) SDK Wizard

‘ (@ Creating project for device: MKB4FN1MOxxx12 using board: FROM-K64F } el Va

|
. Board and/or Device selection page

= SDK MCUs Available boards |a Taz

MCUs from installed SDKs Please select an available board for your project.

NXP MKG4FN1MOxxx12
Y KEx
[ vKBaFNTMOXx12 )
FTPCHA0RK
» LPC546xx
» MIMXRT1060

e B ‘1 ¢
RO T2 T 3 FROM STEC.AGKE FROMKSE o
SDK « SDK |_SDK

)

frdmkE4f frdmk64f mult2b frdmk64f om13588 framk64f agm04

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
FLPC112x
FLPC11Axx
»LPC11E6x
‘ »LPCT1Exx
FLPC11UBX frdmk64f agm01
FLPCT1Uxx
FLPC11xx
‘ »LPC11xxLV

Selected Device: MK64FN1MOxxx12 using board: FRDM-K64F SDKs for selected MCU

Target Core: cortex-md4 Name SDK Version Manifest Versior Location
Description: 41 SDK_2.x FROM-KE4F  2.4.0 3.3.0 [ <Default Location>/SDK_2.x_FRD

‘ K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
(MCUs) based on ARM® Cortex®-M4 Core

| @ [ hex > IR

Figure 6.3. New Project Wizard selection

When the (SDK) board is selected, you can see highlighted in the above figure that the matching
MCU (part) and SDK are also selected automatically.

With a chosen board selected, now click ‘Next'...

6.1.1 SDK New Project Wizard: Basic Project Creation and Settings

The SDK New Project Wizard consists of two pages offering basic and advanced configuration
options. Each of these pages is preconfigured with default options (the default options offered
on the advanced page may be set based on chosen settings from the basic page).

Therefore, to create a simple ‘Hello World’ C project for the Freedom MK64... board we selected,
all that is required is simply click ‘Finish’.
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Note: The project will be given a default name based on the MCU name. If this name matches a
project within the workspace e.g. the wizard has previously been used to generate a project with
the default name, then the error field will show a name clash and the ‘next’ and ‘finish’ buttons
will be ‘greyed out’. To change the new project’s name; the blank ‘Project Name Suffix’ field can
be used to quickly create a unique name but retain the original prefix.

This will create a project in the chosen workspace taking all the default Wizard options for our
board.

However, the wizard offers the flexibility to select/change many build, library and source code
options. These options and the components of this first Wizard page are described below.

[ ESN ] SDK Wizard
. Configure the project 3
Project name:[ MKB4FN 1MOxxx12_Project b Project name suffix: [ b
Use default location 1 2
Location:
Device Packages Project Type roject Options 7
MKB4FNTMOVDC12 © Default board files © c Project C++ Project SDK Debug Console () Semihost (| UART
© MKBAFNTMOVLL12 Empty board files C Static Library () C++ Static Library CMSIS-Core
I MKB4FNTMOVLQ12 Copy sources
Import other files
0s == driver CMSIS_driver ~ b* F = utilities ¥ iﬁ E B middleware ] 2* 5 B
Name Version Name Version fame Version Name Version Name Version
- baremetal 1.0.0 Giadc 2.0.0 > ”5 Device @;assert 1.0.0 » = Graphics
4 freertos 10.0.1 <4 clock 2.1.0 «-arm_cortexM4lf 5.0.1 <} debug_console 1.0.0 E
Siemp 2.0.0 4+ CAN_CMSISIncli 5.0.1 44 debug_consale  1.0.0
] ‘:L cmt 2.01 4+ Common_CMSI£5.0.1 <1 notifier 1.0.0
< common 2.0.0 +Ethernet CMSIS 5.0.1 4 shell 1.0.0 I » = Network
gere 2.01 & Ethernet_MAC_( 5.0.1 4 virtual_com 1.0.0 > = WIiFi
< dac 2041 i+ Ethernet_PHY_C 5.0.1 4t lvhb 1.0.0
<4 dmamux 2.0.2 4% Flash_CMSISInc 5.0.1 arcmaf 1.0.0
& dspi 2.2.0 {12C_CMSISInclu 5.0.1 -ms'\gfox 1.0.0
i 4 dspi_edma 2.2.0 4+ MCI_CMSISInciL 5.0.1
4 dspi_free 2.2.0
i eg 2.1.2
§i g 223
e 2.0
i fladg 3.0.0
i} flexbus 2.01 4+ USB_Device_CN 5.0.1
<4 flexcan 2.2.0 4 USB_Host CMS|5.0.1
@ < Back Next > Cancel [ Finish |

Figure 6.4. New Project Wizard basic SDK settings

. Project Name: The default project name prefix is automatically selected based on the part
selected on the previous screen
« Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not
being found, particularly during the link step.
. Project Suffix: An optional suffix to append to a project name can be entered here
. Errors and Warnings: Any error or warning will be displayed here. The ‘Next’ option will not
be available until any error is handled — for example, a project name has been selected that
matches an existing project name in your workspace. The suffix field (2) allows a convenient
way of updating a project name
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4. MCU Package: The device package can be selected from the range contained with the SDK.
The package relates to the actual device packaging and typically has no meaning for project
creation

5. Board files: This field allows the automatic selection of a default set of board support files, else
empty files will be created. If a part rather than a board had been selected on the previous
screen, these options will not be displayed.

« If you intend to use board specific features such as output over UART, you should ensure
Default board files are selected

6. Project Type: C or C++ projects or libraries can be selected. Selecting ‘C’ will automatically

select RedLib libraries, selecting C++ will select NewlibNano libraries. See

7. Project Options:

* Enable Semihost: will cause the Semihosted variant of the chosen library to be selected.
For C projects this will default to be Redlib Semihost-nf. Semihosting allows IO operations
such as printf and scanf to be emulated by the debug environment.

¢ CMSIS-Core: will cause a CMSIS folder containing a variety of support code such as Clock
Setup, header files to be created. It is recommended to leave this options ticked

e Copy Sources: For zipped SDKs, this option will be ticked and greyed out. For unzipped
SDKs, projects can be created that use linked references back to the original SDK folder.
This feature is recommended for ‘Power Users’ only

8. Each set of components support a filter and check boxes for selection. These icons allow
filters to be cleared, all check boxes to be set, all check boxes to be cleared

9. OS: This provides the option to pull in and link against Operating System resources such as
FreeRTOS.

10driver: enables the selection of supporting driver software components to support the MCU
peripheral set.

11CMSISdriver: code and headers for standard arm hardware

12utilities: a range of optional supporting utilities.

e For example select the debug_console to make use of the SDK Debug Console handling
of IO

» Selecting this option will cause the wizard to substitute the (SDK) PRINTF() macro for C
Library printf() within the generated code

¢ The debug console option relies on the OpenSDA debug probe communicating to the host
via VCOM over USB.

13middleware: enables the selection of various middleware components

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively, select ‘Next’ to proceed to the Advanced options page (described next).

Important Note: Any components (OS, driver, utilities, middleware) selected by default within
this wizard will be linked into the final image. However, any additional components selected by
the user will only bring the corresponding sources into the project, these will only be linked into
the final image if subsequently referenced. Additionally, selecting a component will automatically
select any dependencies. Finally, please also note that this is an additive process, removing
components may leave unresolved dependencies resulting in a project that will not build.

Note: Some middleware components such as USB, are not currently compatible with the
New project wizard functionality and so will be hidden. The recommended approach if such
components are required is to import an example including the component and then modify this
as required. Please see for details of how this
might be done.

Note: By default, new project files are stored within the current MCUXpresso IDE workspace,
this is recommended since the workspace then contains both the sources and project
descriptions. However, the New Project Wizard allows a non default location to be specified if
required. To ensure that each project’s sources and local configuration are self contained when
using non standard locations, the IDE will automatically create a sub directory inside the specified
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location using the Project name prefix setting. The newly created project files will then be stored
within this location.

6.1.2 SDK New Project Wizard: Advanced Project Settings

The advanced configuration page will take certain default options based on settings from the

first wizard project page, for example a C project will pre-select Redlib libraries, where as a C+
+ project will pre-select NewlibNano.

[ JeN SDK Wizard

. Advanced project settings

W
A
(= CiC++ Library Settings O

Set library type (and hosting variant] = pediib (semihost-nf) B

_| Redlib: Use floating point version of printf

Redlib: Use character rather than string based printf J

Redirect SDK "PRINTF" to C library "printf” | Redirect printf/scanf to ITM
Include semihost HardFault handler Redirect printf/scanf to UART

[~ Hardware settings

Set Floating Pointtype | Fpy4 (HardABI)
\.

(~ MCU C Compiler ] ’

Language standard = Compiler default
\

[~ MCU Linker

L Link application to RAM
'ﬂemury Euﬂ‘lgumlmn Q
Memory details

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver =
Flash PROGRAM_FLASH Flash 0x0 0x100000 FTFE_4K.cfx i
RAM SRAM_UPPER RAM 0x20000000 0x30000 :
RAM SRAM_LOWER RAM2 Ox1fff0000 0x10000 #
RAM FLEX_RAM RAM3 0x14000000 0x1000

Add Flash Add RAM Split Delete

\mporl... Merge... Export... Generate... /

@ < Back cancel | (TN

Figure 6.5. New Project Wizard advanced SDK settings

1. This panel allows the selection of library variants. See . Note: if
a C++ project was selected on the previous page, then the Redlib options will be Greyed out.

Redlib (none)
Redlib (nohost)
Redlib (semihost)
Redlib (nohost-nf)

+ Redlib (semihost-nf) 1
Redlib (semihost-mb)
Redlib (semihost-mb-nf)
NewlibNano (none)
NewlibNano (nohost)
NewlibNano (semihost)
Newlib (none)

Newlib (nohost)
Newlib (semihost)
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« Also, based on the selection, a number of options may be chosen to modify the capability
(and size) of printf support

« Redlib Floating Point printf: If this option is ticked, floating point support for printf will
automatically be linked in. This will allow printf to support the printing out of floating point
variables at the expense of larger library support code. Similarly for Newlib.

¢ Redlib use Character printf: selecting this option will avoid heap usage and reduce code
size but make printf operations slower.

2. This panel allows options to be set related to Input/Output. See

¢ Redirect SDK “PRINTF": many SDK examples use a PRINTF macro, selecting this option
causes redirection to C library 10 rather than options provided by the SDK debug console.

¢ Include Semihost Hardfault Handler: selected by default, this option when checked will add

a hardfault handler to the project sources. This handler is specifically written to deal with

the situation that will occur if a semihosted function such as printf is executed when no

debug tools are attached to support the operation. If this occurs, this handler will catch

the operation and safely return to the executing application. Uncheck this option if you do

not wish to use semihosted libraries or you intend to use your own hardfault handler. See
for more information.

« Redirect printf/scanf to ITM: causes a C file 'retarget_itm.c to be pulled into your project.
This then enables printf/scanf 1/0O to be sent over the SWO channel. The benefit of this is
that 1/0O operations can be performed with little performance penalty. Furthermore, these
routines do not require debugger support and for example could be used to generate logging
that would effectively go to Null unless debug tools were attached. Note: This feature is not
available on Cortex MO and MO+ parts.

» More information can be found in the MCUXpresso IDE SWO Trace Guide.

¢ Redirect printf/scanf to UART: Sets the define SDK_DEBUGCONSOLE_UART causing the
C libraries printf functions to re-direct to the SDKs debug console UART code.

3. Hardware Settings: from this drop down you can set options such as the type of floating point

support available/required. This will default to an appropriate value for your MCU.

None
FPv4 (SoftABI)
Set Floating Point type v Fpy4 (HardABI)

~ Hardware settings

. MCU C Compiler: from this drop down you can set various compiler options that can be set

for the GNU C/C++ compiler.

~ Hardware sottil GNU C89 (-std=gnu99)
GNU C11 (-std=gnu11)
Set Floating Point{ SO C90 / ANS| C89 (-std=c90)
ISO C99 (-std=c99)
~ MCUC Compili SO C11 (-std=c11)
GNU C90 (-std=gnu80)
Language standar¢ » Compiler default

. Link Application to RAM checkbox reflects or sets the option to force the linker to ignore any

defined flash regions and link the application to the first RAM region defined. This option is
a copy of the flag at Properties -> C/C++ Build -> Settings -> Managed Linker Script -> Link
application to RAM Note: This setting is only sensible for projects under development, since
debug control or a bootloader is required to load the code/data into RAM and simulate a
processor reset.

. Memory Configuration: This panel shows the Flash and RAM memory layout for the MCU

project being created. The pre-selected LinkServer Flash driver is also shown. Note: this Flash
driver will only be used for LinkServer (CMSIS-DAP) debug connections.

« From this dialogue, the project’s default memory setting may edited in place if required and
hence also the automatically generated linker scripts. See
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6.2 SDK Build Project

To build a project created by the SDK New Project Wizard, simply select the project in the ‘Project
Explorer’ view, then go to the ' QuickStart' Panel and click on the build button to build the
project. This will build the project for the default projects ‘Debug’ configuration.

Note: MCUXpresso IDE projects are created with two build configurations, Debug and Release
(more can be added if required). These differ in the default level of compiler optimization. Debug
projects default to None (-O0), and Release projects default to (-Os). For more information
on switching between build configurations, see

The build log will be displayed in the console view as below.

CJI Installed SDKs [] Properties El Console £ [2! Problems [J Memory & Instruction Trace ;E_;ESWO Trace Config B2 Power Measurement Tool i 4 = il JE B MB-r-= 0
CDT Build Console [MKB84FN1MOxxx12_Project]

Building file: ../CMSIS/system_MKB4F12.c

Invoking: MCU € Compiler

arm-none-eabi-gec -DCR_INTEGER_PRINTF -DSDK_DEBUGCONSOLE-® -D__MCUXPRESSO -D__USE_CMSIS -DDEBUG -DSDK_OS_BAREMETAL -DFSL_RTOS_BM -DCPU_MKE4FNIM@VDC1Z -DCPU_MKGAFNIMAVDC1Z _cméd -|
Finished building: ../startup/startup_mk64f12.c

Finished building: ../source/MKB4FN1MOxxx12_Project.c

Finished building: ../(MSIS/system_MK64F12.c

Building target: MK6AFNIMBxxx12_Project.axf
finvoking: MCU Linker
brm-none-eabi-gcc -nostdlib -Xlinker -Map="MK64FN1MBxxx12_Project.map" -Xlinker --gc-sections -Xlinker -print-memory-usage -mcpu=cortex-md -mfpu=Fpvd-sp-d16 -mfloat-abi=hard -m

Memory region Used Size Region Size Xoge Used
PROGRAM_FLASH: 8216 B 1 M8 9.78%
SRAM_UPPER: 8302 B 192 KB 4.27%
SRAM_LOWER: @ GB 64 KB 9.00%
FLEX_RAM: @ GB 4 KB 9.00%

Finished building target: MKE4FNIM@xxx12_Project.axf

make --no-print-directory post-build
Performing post-build steps
arm-none-eabi-size "MKG4FNIM@xxx12_Project.axf"; # arm-none-eabi-objcopy -v -0 binary "MKG4FNIMBxxx12_Project.axf" "MKE4FNIMBxxx12_Project.bin” ; # checksum -p MKB4FNIMBxxx12 -
kext data bss dec hex filename
8212 4 8388 16604 4@dc MKBAFNIMAxxx12_Project.axf

15:15:30 Build Finished (took 669ms}

Figure 6.6. New Project Wizard Build

The projects memory usage as highlighted above is shown below:

Menory region Used Size Region Size %age Used

PROGRAM_FLASH: 8216 B 1 M 0. 78%
SRAM_UPPER: 8392 B 192 KB 4.27%
SRAM_LOVER: 0GB 64 KB 0. 00%
FLEX_RAM 0GB 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

By default, the application will build and link against the first Flash memory found within the
devices memory configuration. For most MCUs there will only be one Flash device available.
In this case our project requires 8216 bytes of Flash memory storage, 0.78% of the available
Flash storage.

RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. The above example build has reserved 4KB
each for the stack and the heap. Please See

for detailed information.
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7. Importing Example Projects (from installed SDKS)

In addition to drivers and part support, SDKs also deliver many example projects for the target
MCU.

To import examples from an installed SDK, go to the QuickStart panel and select Import SDK
example(s).

) Quicks Globa Variabl Breakp Outline = 0O

MCUXpresso IDE - Quickstart Panel

10e | No project selected

~ Create or import a project

New project...
. Import SDK example(s)... ]

¥ Import project(s) from file system...

* Build your project

A

+ Debug your project E-EH-E-

* Miscellaneous

&2 Quick Settings>>

o Build all projects []

Figure 7.1. SDK Example

This option invokes the Import SDK Example Wizard that guides the user to import SDK
example projects from installed SDKs.

Like the New Project wizard, this will initially launch a page allowing MCU/board selection.
However now, only SDK supported parts and boards will be presented.
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[} L ] SDK Import Wizard
@ Importing project(s) for device: MK64FN1MOxxx12 using board: FROM-K64F } s l i /
. Board and/or Device selection page

~ SDK MCUs Available boards ILE

MCUs from installed SDKs Please select an available board for your project

NXP MKB4FN1MOx0c12
TK6x
MKBAFNTMOxxx 12

»LPC540xx
»LPC546xx
»MIMXRT1020
»MIMXRT1050

FROWFESMULTZE

o 5
|_SPK )

FRONSTEC AGIE FROM KEaF
3

SDK )

SDK ) )

frdmk84f frdmk&4f mult2b frdmk64f om13588 frdmk8&4f agm04

frdmk64f agm01

Selected Device: MK64FN 1MOxxx 12 using board: FRDM-K64F SDKs for selected MCU

Target Core: cortex-m4 Name SDK Version  Manifest Versio Location
B SDK_2.x_FRDM-KB4F 2.4.0 £ <Default Location>/SDK_2.x_FF|

| Description:
K64_120: Kinetis® K64-120 MHz, 256KB SRAM Microcontrollers
(MCUs) based on ARM® Cortex®-M4 Core

Figure 7.2. SDK Example Board

7.1 SDK Example Import Wizard

Selection and filtering work in the same way as for the but please be
aware that examples are created for particular development boards, therefore a board must be
selected to move to the ‘Next’ page of the wizard.

7.1.1 SDK Example Import Wizard: Basic Selection

The SDK Example Import Wizard consists of two pages offering basic and advanced
configuration and selection options. The second configuration page is only available when a
single example is selected for import. This is because examples may set specific options, and
therefore changing settings globally is not sensible.

The first page offers all the available examples in various categories. These can be expanded to
view the underlying hierarchical structure. The various settings and options are explained below:
Note: The project will be given a default name based on the MCU name, Board name and
Example name. If this name matches a project within the workspace e.g. the wizard has
previously been use to generate an example with the default name, then the error field will show
a name clash and the ‘next’ and ‘finish’ buttons will be greyed out. To change the new example
name, the blank ‘Project Name Suffix’ field can be used to quickly create a unique name but
retain the original prefix e.g. add ‘1'.
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MCUXpresso IDE will create a project with common default settings for your chosen MCU and
board. However, the wizard offers the flexibility to select/change many build, library and source
code options. These options and the components of this first Wizard page are described below.

e ° SDK Import Wizard

€ Please select one or more examples to import } k L/_j,

. Import projects
[Projem name prefix: frdmk&4f_ [Prnject name suffix: i

Use default location

Location:

SDK Debug Console *
Copy sources
Import other files

Examples 5 2y 2 M% @ '_-]
n P -

Name Version
» £ aws_examples \‘ 6
» = cmsis_driver_examples

» = demo_apps
» = driver_examples
» S emwin_examples
» = Iwip_examples
~| » = mmcau_examples
» = multiprocessor_examples
» = rtos_examples
» £ se_hostlib_examples

» £ usb_examples /

[Prnie ct Type Project Options

‘?«‘ < Back Cancel

Figure 7.3. SDK Example Selection

1. Project Name: A project name is automatically created with the form:
boardname_examplename

2. Project Suffix: An optional suffix to append to a project name can be entered here. This is
particularly useful if you are repeating an import of one or more projects since an entry here
can make all auto generated names unique for the current workspace...

3. Project Type: These will be set by the pre-set type of the example being imported. If more
than one example is imported, then these options will appear greyed out.

4. Project Options:

« ‘SDK Debug Console’: Once an example(s) is selected, this option can be used to control
10 between semihost console or UART.

* ‘Copy sources’: For unzipped SDKs, you can untick this option to create project containing
source links to the original SDK files. This option should only be unticked with care, since
editing linked example source will overwrite the original files!

¢ ‘Import other files’: By default, non source files such as graphics are filtered out during
import, check this box to import all files.
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5. Examples Filter: Enter text into this field to find possible matches, for example enter ‘LED’ or
‘bubble’ to find examples present in many SDKs. This filter is case insensitive.

6. Examples: The example list broken into categories. Note: for some parts there will be many
potential examples to import

7. Various options (from left to right):

¢ Opens a filer window to allow an example to be imported from an XML description. This is
intended as a developer feature and is described in more detail below.

¢ Clear any existing filter

¢ Select (tick) all Examples

¢ Clear all ticked examples

¢ Open the example structure
¢ Close the example structure

Finally, if there is no error condition displayed, ‘Finish’ can be selected to finish the wizard,
alternatively if only one example has been selected the option to select ‘Next’ to proceed to the
Advanced options page is available (described in the next section).

Note: SDKs may contain many examples, 217 is indicated for the FRDM MK64 SDK example
shown below. Importing many examples will take time ... Consider that each example may consist
of many files and associated description XML. A single example import may only take a few
seconds, but this time is repeated for each additional example. Furthermore, the operation of the
IDE maybe impacted by a large number of project in a single workspace, therefore it is suggested
that example imports be limited to sensible numbers.

Note: Due to restrictions in the length of filenames accepted by the Windows version of the
underlying GCC toolchain, it is recommended that the length of project names is kept to 56
characters or less. Otherwise you may see project build error messages regarding files not being
found, particularly during the link step.
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| €3 Please select one or more examples to import

‘ . Import projects

Project name prefix: #rdmkgas /7 Project name suffix:

| Use default location

Location:

Project Type Project Options
SDK Debug Console #) Semihost
/' Copy sources
| Import other files

Examples [ ] MCUXpressao IDE

i You have selected '217' projects to import.
Name | e Import may take a considerable amount of time.

= ¥ = aws_examples
aws_remote_control_enet
aws_remote_control_wifi

aws_shadow_console_echo_ene

aws_subscribe_publish_enet
= aws_subscribe_publish_wifi

v = cmsis_driver_examples

v = dspi
cmsis_dspi_edma_b2b_transfer_master
cmsis_dspi_edma_b2b_transfer_slave
cmsis_dspi_edma_transfer
cmsis_dspi_int_b2b_transfer_master
cmsis_dspi_int_b2b_transfer slave
cmsis_dspi_interrupt_transfer
izc
= cmsis_i2c_edma_b2b_transfer_master

= rmais i?r adma h?h transfer slave

.5

JRDNRNNENRNDDEN®ER R

aws_shadow_console_echo_wifi —

TJUART

2 M% BB

@ < Back

Figure 7.4. SDK Example Selection Many

Cancel

7.1.2 SDK Example Import Wizard: Advanced options

The advanced configuration page (shown below) will take certain default options based on the
examples selected; for example, a C project will pre-select Redlib libraries, whereas a C++ project

MCUXpresso IDE User Guide -

will pre-select NewlibNano.
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. Advanced project settings

SDK Wizard

= =

Vs

> CiC++ Library Settings
Set library type (and hosting variant) = Rediib (semihost-nf) B

Redlib: Use floating point version of printf

Redlib: Use character rather than string based printf J

Mo~
©

Redirect SDK

Include semihost HardFault handler

PRINTF* to C library "printf* Redirect printf/scanf to ITM

Redirect printf/scanf to UART

(~ Hardware settings

Set Floating Pointtype  £py4q (HardABI) “
"
([~ Mcuc Compiler

Language standard = Compiler default H
\

[~ MCU Linker

Link application to RAM p

Default LinkServer

Type
Flash
RAM
RAM
RAM

Add Flash

9
~Memory Conliguration Q
Memory details

\mport... Merge... Export... Generate... /

Flash Driver Browse...
Name Alias Location Size Driver ~
PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx x
SRAM_UPPER RAM 0x20000000 0x30000 i
SRAM_LOWER RAM2 0x1fff0000 0x10000 @l
FLEX_RAM RAM3 0x14000000 0x1000

Add RAM Split Delete

«Q

Figure 7.5. New

< Back cancel I

Project Wizard advanced SDK settings

7.1.3

MCUXpresso IDE User Guide -

These settings closely match those in SDK New Project Wizard description. Therefore see

for a description of these options. Note: Changing
these advanced options may prevent an example from building or executing.

SDK Example Import Wizard: Import from XML fragment

This option works in conjunction with the ‘Project Explorer’ -> Tools -> Generate Example XML
(and is also used to import project created by the MCUXpresso Config Tools Project Generator).

The functionality here is to merge existing sources within a selectable board package framework.

To create an XML “fragment” for an existing project in your workspace, right click on the project

in the ‘Project Explorer’ (or just in the ‘Project Explorer’ view with no project selected) and choose
Tools->Generate examples.xml file

The selected project or all the projects in the workspace (if no projects are selected) will be
converted into a fragment within a new folder created in the workspace itself:
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[ Project Explorer 32 | 7. Peripherals+

==

==
==

Regi

-

v = boards
¥ (= frdmkB4f
¥ (= dummy
¥ (= Category
b MKBAFNIMOxxx12_Project
£ examples.xml
b (= frdmk64f_demo_apps_bubble

To create a project from a fragment, click on “Import SDK examples...” in the QuickStart Panel
view:

Then select a board and then click on the button “Import from XML...” (highlighted below and
described in the previous section). You will see the examples definitions from the external
fragment in list of examples as shown and selected below.

@8 SDK Import Wizard

v,

| @) You have selected '1' projects to import. } Y k
i. — .'I. b

. Import projects

Project name prefix:  frqmkg4f

=

i | Project name suffix: ML fragment Fel

Use default location

Location:

Project Type
© C Project

Project Options

Copy sources

«’& B

Examples

| Name Version

» = cmsis_driver_examples
» = demo_apps

b = driver_examples

= emwin_examples
mcau_examples

S multiprocessor_examples
» = rtos_examples

¥ = dummy
¥ £ Category

- MKB4AFN1MOxxx12_Project

@ < Back Next > [ Finish |

Cancel

Select the external examples you want to re-create and click on “Finish”. The project(s) will be
created in the workspace.
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7.1.4 Importing Examples to non default locations

By default, imported example sources will be stored within the current MCUXpresso IDE
workspace, this is recommended since the workspace then contains both the sources and
project descriptions. However, the Import SDK Example Wizard allows a non default location
to be specified if required. To ensure that each project’s sources and local configuration are self
contained when using non standard locations, the IDE will automatically create a sub directory
inside the specified location using the Project name prefix setting. Single or multiple imported
projects will then be stored within this location.
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8. SDK Project Component Management

Projects and examples created from SDKs contain a number of software components such as
peripheral drivers and/or middleware. In previous versions of MCUXpresso IDE, the option to
add components was only available when creating a new project and not possible for imported
examples. Introduced in MCUXpresso IDE version 10.1.0 is the ability to easily add (or remove)
SDK components to a previously created or imported example project via a new Manage SDK
components wizard. To launch the Manage SDK Components wizard, simply select the chosen
project in the Project explorer view and then click the package icon as indicated below:

[Z5 Projec 52 %, Periph il Regist £ Symbo = B

E) B~
¥ 25 MKBAFN1MOxxx12_Project -

» @ Project Settings e e Manage SDK components for project MK64FN1M0xxx12_Project
» fllincludes

r i
: jgg::f Y, Adding, 9 could ially break your project. Please use this feature carefully. J%l
» B drivers
» (@ source Available SDK components
» (B startup
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Figure 8.1. Manage SDK Components

Note: This powerful feature can add (or remove) SDK components and their dependencies at
a source file level, relying on meta data contained within the SDK. However the following points
should also be noted:

e The IDE can only maintain dependencies between SDK components. SDK component
functions referenced from user-created files or from sources such as an SDK example’s main()
function will not be taken into account when determining the safe removal of components.
Therefore, the IDE cannot always prevent users removing components that may actually be
required for a successful project build.

« Defined symbols will not be removed when components are removed, therefore users should
ensure only required symbols are present if components are removed. Failing to do this may
lead to project build failures.

8.1 SDK Project Component Management example

To demonstrate the use of this feature, the dac driver will be added to a project. To do this, launch
the Manage SDK components wizard, and click on the dac driver component then click ‘OK’.

Next, a dialogue will be presented listing all of the source files required by this component — as
below.
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3] [ ] SDK Component Management

1 The following files will be added or updated if required:
Component source Project Path(s) Infio
v

A

v -E;dac drivers 2.0.1
v =i devices/MKB64F12/drivers drivers SRC
£l fsl_dac.c
v =i devices/MKB4F12/drivers drivers C_INCLUDE
=| fsl_dac.h

Skip addfremove components confirmation in future

No -‘m

Figure 8.2. SDK Component Management

Note: Many of these files may already be included within your project.

Click ‘Yes’ to add these source files to your project.

Important Note: Since your project may contain edited or entirely new versions of the required
source files, MCUXpresso IDE will perform a comparison between the new files to be included

and any existing files already within the selected project.

Should a source file difference be found, then a dialogue as below will be launched:
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Figure 8.3. SDK Component Management file difference

The file 'system_MKG4F12.c' already exists in your project but is different from the SDK
component file.

MOTE: 'system_MKG4F12.c' could belong to the selected component(s) or one of its
dependent components.

Please select from the following options:

Remember my decision.

Replace Keep existing Compare

From here you can choose from the following options:

* Replace click to overwrite the projects file from the SDK version.
« Keep Existing click to keep the existing project file unchanged.

¢ Compare click to compare the two files — this will launch the Eclipse file compare utility so the
new SDK file can be compared with the projects copy.

In this example, we will click ‘Compare’ ...

Below, you can see that a user project source modification has been found:

Figure 8.4. SDK Component Management file compare

e @ Compare

C Compare

[€ Translation Unit

| | € Compare Viewer = b (@] Pt SN
| _V\!'orkspace: Workspace: [MKB4F...0ject/CMSIS/system _MKEB4F12.c ] E} SDK; de\{iceg[MK_SdF_‘l2_Isy_ste_mvwg64F12_.c |
| ) o | 110
| El RSB od e thanias e heen T ot hire: |
| 12 |
b, i3
1114/ -- Core clock
LTS memereme s e s e i i |
116] liie
117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK; 117 uint32_t SystemCoreClock = DEFAULT_SYSTEM_CLOCK;
118 118
e e e
[ SRS SystemInit() 1. SystemInit()
i R L2 st mm e R e B e R m e R e
122 22
123 void SystemInit (void) { (123 void SystemInit (void) {
124 #1F ((__FPU_PRESENT == 1) 3& (__FPU_USED == 1)) |Lza #1f ((__FPU_PRESENT == 1) &3 (__FPU_USED == 1))
| |25 GFR-ArDAFR 1= £ o 10%2Y | FRAN - 115233 | li7c  QFR-~CPAMR 1— FFRNN - 10%2% | CRU - 1162

Left: 116 : 1, Right: 111 : 1, no diff

Y
@ Cancel

The Compare utility allows any change to be examined and a decision made regarding which
code lines to choose or ignore. When the decisions have been made, click ‘Commit’ to use these
changes or ‘Cancel’ to leave the project file unchanged.

Finally please note the application build sizes before the addition;

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVER: 0 & 64 KB 0. 00%
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8.2

FLEX_RAM 0GB 4 KB 0. 00%
Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

Followed by the application sizes after the addition.

Menory region Used Size Region Size %age Used
PROGRAM_FLASH: 13348 B 1 MB 1.27%
SRAM_UPPER: 8444 B 192 KB 4.29%
SRAM_LOVNER: 0 &8 64 KB 0. 00%
FLEX_RAM 0 &8 4 KB 0. 00%

Fi ni shed buil ding target: MG64FNLM)xxx12_Proj ect . axf

These are exactly the same!

This is because although new source files have been added to the project, they will (probably)
not be referenced by any code in the project and hence no new functions or data will be included
in the final image. To make use of any new component, some of its new functionality must of
course be referenced.

Note: Some middleware components such as USB, are not compatible with the Add/Remove
component functionality and so will be hidden from the Add/Remove dialogue. The recommended
approach if such components are required is to import an example including the component and
modify as required. This restriction will be addressed in a future release.

SDK Project Refresh

Using the above technology, Introduced in MCUXpresso IDE version 10.2.0 projects can be
refreshed with updated SDK components.

When new SDKs are released for a particular MCU/Board, many source files will be updated,
bugs fixed, features added etc. If an existing SDK is replaced within MCUXpresso IDE by such a
new SDK, any updated (or changed) source files or source file sections can optionally be added
to existing project using an identical mechanism as described above.

To used this feature, simply select a project in the project explorer view and click to Refresh SDK
Components as indicated below.

Figure 8.5. SDK Component Management Project Refresh

{5 Project E 23 | =, Peripher (il Register

=]

» & frdmk64f_bubble

Ui " O OR Y37 A PO W 10 OO S sy |

MCUXpresso IDE User Guide -

The SDK Component Management wizard will guide you through the update process.
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9. Creating New Projects using Preinstalled Part Support

For Creating project using SDKs please see

To explore the range of preinstalled parts/MCUs simply click ‘New project’ in the QuickStart
panel. This will open a page similar to he figure below:

® o SDK Wizard

4 ' P
| € Please select a target device or a board } e L C‘ ;'l

|
\ . Board and/or Device selection page

~ SDK MCUs Available boards Al

MCUs from installed SDKs Please select an available board for your project

Target

PNEV74628 LPCXpresso812-MAX LPCXpressoB12

~ Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
Target
»LPC1102
FLPC112x
FLPCT1AXX
*LPC11E6X
»LPC11Exx
#LPC11UBx LPCXpressoBA45-MAX LPCXpressoB24-MAX LPCXpressoB02
*LPCT1Uxx
FLPCT1xx

k»u:m eV /

Selected Device: SDKs for selected MCU

Target Core: Name SDK Version  Manifest Versior Location

Description:

Cancel

Figure 9.1. New Project Wizard Preinstalled

The list of preinstalled parts is presented on the bottom left of this window.

You will also see a range of related development boards indicating whether a matching board
support library (LPCOpen or CodeBundles) is available.

For details of this page see:

9.1 New Project Wizard

This wizard page provides a number of ways of quickly selecting the target for the project that
you want to create.

In this description, we are going to create a project for an LPC4337 MCU. For this MCU an
LPCOpen library is available, so we can locate this MCU using the board filter. Note: Boards will
be displayed where either LPCOpen or CodeBundle projects exist.
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Note: LPCOpen is described in section

To reduce the number of boards displayed, we can simply type ‘4337’ into the filter so only boards
with MCUSs containing ‘4337’ will be displayed.

e.e o SDK Wizard
(@ Creating project for device: LPC4337 using board: LPCXpresso4337 } i .— 5
. Board and/or Device selection page

» SDK MCUs Available boards %R &

! lect an available board for your project.
4337]

LPCXpresso4337

= Preinstalled MCUs
MCUs from preinstalled LPC and generic
Cortex-M part support
NXP LPC4337

LPC4325

LPC4325-M0

LPC4327

LPC4327-M0

LPC4330

LPC4330-M0

LPC4333

LPC4333-M0

LPC4337

Selected Device: LPC4337 using board: LPCXpresso4337 SDKs for selected MCU
Target Core: cortex-m4 Name SDK Version Manifest Versior Location

Description: Multicore Cortex-M4/Cortex-MO based microecontroller, with up to 1MB
Flash and 136K8 RAM

| @ RN | cance

Figure 9.2. New Project Wizard selection for Preinstalled MCUs

When a board is selected as highlighted in the above figure, the matching MCU (part) is also
selected automatically.

Note: if no matching board is available, the required MCU can be selected from the list of
Preinstalled MCUs.

Note: Boards added to MCUXpresso IDE from SDKs will have an ‘SDK’ graphic superimposed
on the board image. Boards without the SDK graphic indicate that a matching LPCOpen package
(or Code bundle) is available for that board and associated MCU.

With a chosen board selected, now click ‘Next’ to launch the next level of wizards. These wizards
for Preinstalled MCUs are very similar to those featured in LPCXpresso IDE and are described
in the next section.

9.2 Creating a Project

MCUXpresso IDE includes many project templates to allow the rapid creation of correctly
configured projects for specific MCUs.

MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide Rev. 10.3.0 — 16 November, 2018 78




NXP Semiconductors MCUXpresso IDE User Guide

This New Project wizard supports 2 types of projects:
¢ Those targeting LPCOpen libraries

e Standalone projects

In addition, certain MCUs like the LPC4337 support multiple cores internally, for these MCUs,
Multicore options will also be presented (as below):

Figure 9.3. New project: wizard selection

@
New project..

LPC43xx (Cortex-M4 basic) -> C Project (Semihosted)

. Wizard selection page.

Wizard
YLPC1800 / LPC4300
¥ LPC43xx (Cortex-M4 basic
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project
PCOpen - atic Librarv Proje
C Project (Semihosted
C Static Library Project
C++ Project
C++ Static Library Project
VLPC43xx Multicore M4
LPCOpen - C Project
| PCOpen - C++ Project
C Project
C Project (Semihosted)
C++ F’rgect

@ EEEE | cancel

9.21
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You can now select the type of project that you wish to create (see below for details of Wizard
types).

In this case, we will show the steps in creating a simple C ‘Hello World’ example project.
Selecting the Wizard Type

For most MCU families MCUXpresso IDE provides wizards for two forms of project: LPCOpen
and non-LPCOpen. For more details on LPCOpen, see

. For both kinds, the main wizards available are:

C Project

¢ Creates a simple C project, with the min() routine consisting of an infinite wiie(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.

C++ Project
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9.2.2

9.2.3

MCUXpresso IDE User Guide -

¢ Creates a simple C++ project, with the mai n() routine consisting of an infinite wni1e(1) loop that
increments a counter.

« For LPCOpen projects, code will also be included to initialize the board and enable an LED.
C Static Library Project

¢ Creates a simple static library project, containing a source directory and, optionally, a directory
to contain include files. The project will also contain a “liblinks.xml” file, which can be used by
the smart update wizard on the context-sensitive menu to create links from application projects
to this library project. For more details, please see the FAQ at:

https://community.nxp.com/message/630594

C++ Static Library Project

¢ Creates a simple (C++) static library project, like that produced by the C Static Library Project
wizard, but with the tools set up to build C++ rather than C code.

The non-LPCOpen wizard families also include a further wizard:

Semihosting C Project

« Creates a simple “Hello World” project, with the mai n() routine containing a printf() call, which
will cause the text to be displayed within the Console View of MCUXpresso IDE. This is
implemented using “semihosting” functionality. See the section on for
more information.

Configuring the Project

Once you have selected the appropriate project wizard, you will be able to enter the name of
your new project, this must be unique for the current workspace.

Finally you will be presented with one or more “Options” pages that provide the ability to set
a number of project-specific options. The choices presented will depend upon which MCU you
are targeting and the specific wizard you selected, and may also change between versions of
MCUXpresso IDE. Note: if you have any doubts over any of the options, then we would normally
recommend leaving them set to their default values.

The following sections detail some of the options that you may see when running through a
wizard.

Wizard Options

The wizard will present a set of pages (that will vary based on the chosen MCU), many of these
pages will typically require no user change since the common default values are already preset.
The pages may include:

LPCOpen Library Project Selection

When creating an LPCOpen-based project, the first option page that you will see is the LPCOpen
library selection page.
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e
New project..

& Select an LPCOpen Chip library project within the current workspace
. Wizard properties page.

Select the LFCOpen Chip and {optionally) Board library project(s) that you want your new project to link against.

Selected library project(s) must be present in this workspace. If they are not, then click the

Import...
‘Import’ button to run the Import Wizard p

Select LPCOpen Libraries
LPCOpen Chip Library Project Ipc_chip_ 43xx y Browse...

LPCOpen Board Library Project ﬂ Browse.

If a Board Library Project Is selected, then the cerresponding Chip Library Project must also be selected

f'?) < Back Cancel

Figure 9.4. LPCOpen library selection

MCUXpresso IDE User Guide -

This page allows you to run an “Import wizard” to download the LPCOpen bundle for your target
MCU/board from http://www.nxp.com/lpcopen and import it into your Workspace, if you have not
already done so.

You will then need to select the LPCOpen Chip library for your MCU using the Workspace
browser (and for some MCUs an appropriate value will also be available from the drop down next
to the Browse button). Note: the wizard will not allow you to continue until you have selected a
library project that exists within the Workspace.

Finally, you can optionally select the LPCOpen Board library for the board that your MCU is fitted
to, using the Workspace browser (and again, in some cases an appropriate value may also be
available from the drop down next to the Browse button). Although selection of a board library is
optional, it is recommended that you do this in most cases.

CMSIS-CORE Selection

For backwards compatibility reasons, the non-LPCOpen wizards for many parts provide the
ability to link a new project with a CMSIS-CORE library project. The CMSIS-CORE portion of
ARM'’s Cortex Microcontroller Software Interface Standard (or CMSIS) provides a defined
way of accessing MCU peripheral registers, as well as code for initializing an MCU and accessing
various aspects of functionality of the Cortex CPU itself. MCUXpresso IDE typically provides
support for CMSIS through the provision of CMSIS library projects. CMSIS-CORE library projects
can be found in the Examples directory of your MCUXpresso IDE installation.

Generally, if you wish to use CMSIS-CORE library projects, you should use
CMBI S_CORE_<part fani | y> (these projects use components from ARM’s CMSIS v3.20 specification).
MCUXpresso IDE does in some cases provide libraries based on early versions of the CMSIS
specification with names such as cvsi svip3o_<partfani | y>, but these are not recommended for use
in new projects.

The CMSIS library option within MCUXpresso IDE allows you to select which (if any) CMSIS-
CORE library you want to link to from the project you are creating. Note: you will need to import
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the appropriate CMSIS-CORE library project into the workspace before the wizard will allow you
to continue.

For more information on CMSIS and its support in MCUXpresso IDE, please see the FAQ at:
https://community.nxp.com/message/630589

Note: The use of LPCOpen instead of CMSIS-CORE library projects is recommended in most
cases for new projects. (In fact LPCOpen actually builds on top of many aspects of CMSIS-
CORE.) For more details see

CMSIS DSP Library Selection

ARM’s Cortex Microcontroller Software Interface Standard (or CMSIS) specification also
provides a definition and implementation of a DSP library. MCUXpresso IDE provides prebuilt
library projects for the CMSIS DSP library for Cortex-M0/MO0+, Cortex-M3 and Cortex-M4 parts,
although a source version of it is also provided within the MCUXpresso IDE Examples.

Note: The CMSIS DSP library can be used with both LPCOpen and non-LPCOpen projects.
Peripheral Driver Selection

For some parts, one or more peripheral driver library projects may be available for the target
MCU from within the Examples area of your MCUXpresso IDE installation. The non-LPCOpen
wizards allow you to create appropriate links to such library projects when creating a new project.
You will need to ensure that you have imported such libraries from the Examples before selecting
them in the wizard.

Note: The use of LPCOpen rather than these peripheral driver projects is recommended in most
cases for new projects.

Enable use of Floating Point Hardware

Certain MCUs may include a hardware floating point unit (for example NXP LPC32xx,
LPC407x_8x, and LPC43xx parts). This option will set appropriate build options so that code is
built to use the hardware floating point unit and will also cause startup code to enable the unit
to be included.

Code Read Protect

NXP’s Cortex based LPC MCUs provide a “Code Read Protect” (CRP) mechanism to prevent
certain types of access to internal Flash memory by external tools when a specific memory
location in the internal Flash contains a specific value. MCUXpresso IDE provides support
for setting this memory location. See the section on for more
information.

Enable use of Rrondivide Library

Certain NXP Cortex-MO0 based MCUs, such as LPC11Axx, LPC11Exx, LPC11Uxx, and LPC12xx,
include optimized code in ROM to carry out divide operations. This option enables the use of
these Romdivide library functions. For more details see the FAQ at

https://community.nxp.com/message/630743
Disable Watchdog

Unlike most MCUs, NXP’s LPC12xx MCUs enable the watchdog timer by default at reset. This
option disables that default behaviour. For more details, please see the FAQ at

https://community.nxp.com/message/630654
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LPC1102 ISP Pin

The provision of a pin to trigger entry to NXP’s ISP bootloader at reset is not hardwired on the
LPC1102, unlike other NXP MCUs. This option allows the generation of default code for providing
an ISP pin. For more information, please see NXP’s application note, AN11015, “Adding ISP to
LPC1102 systems”.

Memory Configuration Editor

For certain MCUs such as the LPC18xx and LPC43xx, the wizard will present the option to edit
the target memory configuration. This is because these parts may make use of external SPIFI
Flash memory and hence this can be described here if required. For more information please
see: and also

Note: Memory configuration can of course also be edited after a project has been created.
Redlib Printf Options

The “Semihosting C Project” wizard for some parts provides two options for configuring the
implementation of printf family functions that will get pulled in from the Redlib C library:

¢ Use non-floating-point version of printf
« If your application does not pass floating point numbers to print () family functions, you can
select a non-floating-point variant of printf. This will help to reduce the code size of your
application.
« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr | NTEGER PRI NTF tO the project properties.

¢ Use character- rather than string-based printf

e By default printf() and puts() make use of maiioc() to provide a temporary buffer on the
heap in order to generate the string to be displayed. Enable this option to switch to using
“character-by-character” versions of these functions (which do not require heap space). This
can be useful, for example, if you are retargeting printf() to write out over a UART — since
in this case it is pointless creating a temporary buffer to store the whole string, only to print
it out over the UART one character at a time.

« For MCUs where the wizard does not provide this option, you can cause the same effect by
adding the symbol cr_pri NTF_cHAR tO the project properties.

Note: if you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

For more information see

Project Created

Having selected the appropriate options, you can then click on the Finish button, and the wizard
will create your project for you, together with appropriate startup code and a simple min. ¢ file.
Build options for the project will be configured appropriately for the MCU that you selected in
the project wizard.

You should then be able to build and debug your project, as described in Section 10.5 and
Chapter 11.
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10. Importing Example Projects (from the file system)

10.1
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MCUXpresso IDE supports two schemes for importing examples:

¢ From SDKs — using the QuickStart Panel -> Import SDK example(s). See

« From the filing system — using the QuickStart Panel -> Import project(s) from file System
« this option is discussed below:

Drag and Drop
@ Introduced in MCUXpresso IDE version 10.2, project(s) can be imported directly
into a workspace by simply dragging a folder (or zip) containing MCUXpresso IDE
projects onto the Project Explorer view. Note: this will import all projects within a
folder (or zip). Projects can also be exported by dragging directly from the Project
Explorer view onto a filer, or directly into another instance of the IDE. See
for more information.

Note: This option can also be used to import projects exported from MCUXpresso IDE. See

MCUXpresso IDE installs with a large number of example projects for preinstalled parts, that can
be imported directly into a workspace: These are located at:

<install_dir>/idel/ Exanpl es

and consist of:

+ CMSIS-DSPLIB
 asuite of common signal processing functions for use on Cortex-M processor based devices.
CodeBundles for LPC800 family

< which consist of software examples to teach users how to program the peripherals at a basic
level.

FlashDrivers

« example projects to create Flash driver used by LinkServer

e Legacy

» arange of historic examples and drivers including CMSIS / Peripheral Driver Library
LPCOpen

« High quality board and chip support libraries for LPC MCUs, plus example projects

Code Bundles for LPC800 Family Devices

The LPC800 Family of MCUs are ideal for customers who want to make the transition from 8
and 16-bit MCUs to the Cortex MO/MO+. For this purpose, we've created Code Bundles which
consist of software examples to teach users how to program the peripherals at a basic level. The
examples provide register level peripheral access, and direct correspondence to the memory
map in the MCU User Manual. Examples are concise and accurate explanations are provided
within any readme and source file comments. Code Bundles for LPC800 family devices are made
available at the time of the series product launch, ready for use with a range of tools including
MCUXpresso IDE.

More information on code bundles together with latest downloads can be found at:

https://www.nxp.com/LPC800-Code-Bundles
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10.3

MCUXpresso IDE User Guide -

LPCOpen Software Drivers and Examples

Note: LPCOpen is no longer under active development, new MCU'’s from NXP are supported by
SDKs. Certain parts such as some members of the LPC54xxx families are available with both
LPCOpen and SDK support.

LPCOpen is an extensive collection of free software libraries (drivers and middleware) and
example programs that enable developers to create multifunctional products based on LPC
microcontrollers. Access to LPCOpen is free to all LPC developers.

Amongst the features of LPCOpen are:

¢ MCU peripheral device drivers with meaningful examples

* Common APIs across device families

« Commonly needed third party and open source software ports

¢ Support for Keil, IAR and LPCXpresso/MCUXpresso IDE toolchains

LPCOpen is thoroughly tested and maintained. The latest LPCOpen software now available
provides:

« MCU family-specific download package

e Support for USB ROM drivers

« Improved code organization and drivers (efficiency, features)

¢ Improved support for MCUXpresso IDE

CMSIS / Peripheral Driver Library / code bundle software packages are still available, from
within your install_dir/ide/Examples/Legacy folder. However, these should only be used for
existing development work. When starting a new evaluation or product development, we would
recommend the use of LPCOpen if available.

More information on LPCOpen together with package downloads can be found at:

http://www.nxp.com/Ipcopen

Importing an Example Project

To import an example project from the file system, locate the QuickStart panel and select ‘Import
projects from Filesystem’
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Figure 10.1. Importing project(s)
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From here you can browse the file system.
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[ BaN ] Impaort project(s)

Import project(s) r

——
Select the examples archive file to import. / J

Projects are contained within archives (.zip) or are unpacked within a directory. Select your
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finishz.

Project archives for LPCOpen and 'legacy’ examples are provided.

Project archive {zip)

Archive \ Browse...

Project directory (unpacked)

Root directory Browse...

LPCOpen

LPCOpen is the recommended code base for Cortex-M based NXP LPC Micracontrollers.

MCUXpresso IDE includes the LPCOpen packages which can be imported directly by pressing the Browse
button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory.

Alternatively, press the butten below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

(?D' Cancel

Figure 10.2. Importing examples

10.3.1

MCUXpresso IDE User Guide -

* Browse to locate Examples stored in zip archive files on your local system. These could
be archives that you have previously downloaded (for example LPCOpen packages from
http://www.nxp.com/Ipcopen or the supplied, but deprecated, sample code located within the
Examples/Legacy subdirectory of your MCUXpresso IDE installation).

* Browse to locate projects stored in directory form on your local system (for example, you can
use this to import projects from a different Workspace into the current Workspace).

« Browse LPCOpen resources to visit http://www.nxp.com/lpcopen and download an
appropriate LPCOpen package for your target MCU. This option will automatically open a web
browser onto a suitable links page.

To demonstrate how to use the Import Project(s) functionality, we will now import the LPCOpen
examples for the LPCXpresso4337 development board.

Importing Examples for the LPCXpresso04337 Development Board

First of all, assuming that you have not previously downloaded the appropriate LPCOpen
package, click on Browse LPCOpen Resources, which will open a web browser window. Click
on LPC4300 Series, and then locate NXP LPCXpresso04337, and then download 2.xx version
for LPCXpresso Toolchain (LPCOpen packages created for LPCXpresso IDE are compatible
with MCUXpresso IDE).

Note: LPCOpen Packages for the LPC4337 are preinstalled and located at:

<install_dir>/idel/ Exanpl es/ LPCOpen/. ..

Once the package has downloaded, return to the Import Project(s) dialog and click on the Browse
button next to Project archive (zip); then locate the LPCOpen LPCXpresso4337 package
archive previously downloaded. Select the archive, click Open and then click Next. You will then
be presented with a list of projects within the archive, as shown in Figure 10.3.
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Figure 10.3. Selecting projects to import
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Select the projects you want to import and then click Finish. The examples will be imported into
your Workspace.

Note: generally, it is a good idea to leave all projects selected when doing an import from a zip
archive file of examples. This is certainly true the first time you import an example set, when you
will not necessarily be aware of any dependencies between projects. In most cases, an archive
of projects will contain one or more library projects, which are used by the actual application
projects within the examples. If you do not import these library projects, then the application
projects will fail to build.

Exporting Projects

MCUXpresso IDE provides the following export options from the QuickStart panel:

e Export project(s) to archive (zip)
« Export project(s) and references to archive (zip)

« choose this option to export project(s) and automatically also export referenced libraries
To export one or more projects, first select the project(s) in the Project Explorer then from the
QuickStart Panel -> Export project(s) to archive (zip). This will launch a filer window. Simply
select the destination and enter a name for the archive to be exported then click ‘OK’.

Also please see for information about dragging and
dropping projects.
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10.5 Building Projects

Building the projects in a workspace is a simple case of using the Quickstart Panel to “Build all
projects”. Alternatively, a single project can be selected in the ‘Project Explorer’ View and built.
Note: building a single project may also trigger a build of any associated or referenced project.

10.5.1 Build Configurations

By default, each project will be created with two different “build configurations”: Debug and
Release. Each build configuration will contain a distinct set of build options. Thus a Debug build
will typically compile its code with optimizations disabled ( - ) and Release will compile its code
optimizing for minimum code size ( -cs). The currently selected build configuration for a project
will be displayed after its name in the QuickStart Panel's Build/Clean/Debug options.

For more information on switching between build configurations, see
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11. Debugging a Project

11.1

11.1.1
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This chapter describes many of the common debug features supported by the debug solutions
within MCUXpresso IDE. Please also refer to the chapter for
more details of the supported debug solutions and management of debug operations.

Debugging Overview

A debug operation requires a physical connection between the host computer and the target
MCU via a debug probe. The debug probe translates the high level commands provided by
MCUXpresso IDE into the appropriate low level operations supported on the target MCU.

This connection to the debug probe is usually made via USB to the host computer (although IP
probes from P&E and SEGGER are also supported). Some debug probes such as LPC-Link2
or SEGGER J-Link Plus are separate physical devices, however many LPCXpresso, Freedom,
Tower, EVK boards also incorporate a built in debug probe accessed by one of the development
boards USB connections.

Note: If a separate debug probe is used, you must ensure that the appropriate cables are used
to connect the debug probe to the target board, and that the target is correctly powered.

Typically, an on board debug probe connection will also provide power to the development board
and target MCU. In contrast, an external debug probe will not usually power the target, and
a second connection (often USB) will be required to provide power to the board and MCU.
Some external debug probes such as the LPC-Link2 can also provide power to the target board
— this is enabled by connecting the link JP2. For other debug probes, refer to their supplied
documentation.

External debug probes will usually provide superior features and performance compared to on-
board debug probes, however please note that LPCXpresso V2 and V3 boards incorporate a full
featured LPC-Link2 debug probe.

Note: Some LPCXpresso development boards have two USB connectors fitted. Make sure that
you have connected the lower connector marked DFU-Link. Many Freedom and Tower boards
also have two USB connectors fitted. Make sure that you have connected to the one marked
‘OpenSDA’ - this is usually (but not always) marked on the board. If in doubt, the debug processor
used on these designs is usually a Kinetis K20 MCU, it is approximately 6mm square. The USB
nearest this MCU will be the OpenSDA connection.

Debug Launch

To debug a project on your target MCU, simply highlight the appropriate project in the ‘Project
Explorer’, and then in the Quickstart Panel click on the large Debug, as in Figure 11.1,

alternatively click the blue bug icon W to perform the same action.
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Figure 11.1. Launching a debug session

Note: The green bug icon should not be used because this invokes the standard Eclipse debug
operation and so skips certain essential MCUXpresso IDE debug steps.

For a newly created project a debug operation will perform a number of steps. By default, it will
first build the selected project and (assuming there are no build errors) launch a debug probe
discovery operation (see next section) to allow the user to select the required debug probe. A
launch configuration file will automatically be created with default options (per build configuration)
and will be associated with the project. Like a projects build configuration, launch configuration
files control what occurs each time a debug operation is performed. Please see the section

for more information.

Note: This default behaviour can be changed by editing the Workspace preference located at
Preferences -> Run/Debug -> Launching -> Build (if required) before launching. For individual
projects, the Main tab of the launch configuration allows the workspace preference to be
overridden.

By default, once a debug probe has been selected (and ‘OK’ clicked) the binary contents of
the .axf file will automatically be downloaded to the target via the debug probe connection.
Typically, projects are built to target MCU Flash memory, and in these cases, a suitable Flash
driver will automatically be selected to perform the Flash programming operation. Next a default
breakpoint will be set on the first instruction in nai n() , the application will be started (by performing
or simulating a processor reset), and code will be executed until the default breakpoint is hit. See
the section on for additional information.

11.1.2 Debug Probe Selection Dialog (Probe Discovery)

The first time you debug a project, the IDE will perform a probe discovery operation and display
the discovered Debug Probes for selection. This will show a dialogue listing all supported probes
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that are attached to the host computer. In the example shown in Figure 11.2, a LinkServer (LPC-
Link2), a P&E Micro Multilink and also a J-Link (OpenSDA) probe have been found.

Figure 11.2. Attached probes: debug emulator selection

e o Probes discovered
Connect to target: MK64FN 1IMOxxx12

3 probes found. Select the probe to use:

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode
B8 LPC-LINK2 CMSIS-DAP V5.18 IWFUA1EW LinkServe NXP SemiNon-Stop
4 USB1 - Multilink Universal Rev PEM834663 usBe1 P&E Micrc All-Stop
m J-Link OpenSDA 621000000 use SEGGER All-Stop

Supported Probes {tick/untick to enable/disable)

MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
P&E Micro probes

SEGGER J-Link probes

Probe search options
Search again
Remember my selection (for this Launch configuration)

) Cancel

2/
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Note: if only one probe is found, it will be selected automatically, so simply click OK or hit return
to use the probe displayed.

MCUXpresso IDE supports unique debug probe association.

Debug probes can return an ID (Serial number) that is used to associate a particular debug
probe with a particular project. Some debug probes will always return the same ID, however
debug probes such as the LPC-Link2 will return a unique ID for each probe — in our example
IWFUALEW.

For any future debug sessions, the stored probe selection will be automatically used to match the
project being debugged with the previously used debug probe. This greatly simplifies the case
where multiple debug probes are being used.

However, if a debug operation is performed and the previously remembered debug probe cannot
be found, then a debug probe discovery operation will be performed from within the same family
e.g. LinkServer, P&E or SEGGER.

See also

Sometimes a probe discovery will find no debug probes and return a dialogue as below:
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@ @ Probes discovered
Connect to target: LinkServer

€3 LinkServer not found.
This could be because it is disconnected, not powered, or already in use

Available attached probes

Name Serial number/ID Type Manufactur IDE Debug Mode

Supported Probes (tick/untick to enable/disable)
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Probe search options

Search for LinkServer again Search for any enabled probe

?) Cancel

Figure 11.3. LPC-Link2 no longer connected
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This might have been because you had forgotten to connect the probe, in which case simply
connect it to your computer and select Search again. If you are using a different debug probe
from the same family of debug probes, simply select the new probe and this will replace the
previously selected probe.

Notes:

« The “Remember my selection” option is enabled by default in the Debug Emulator Selection
Dialog, and will cause the selected probe to be stored in the launch configuration for the current
configuration (typically Debug or Release) of the current project. You can thus remove the
probe selection at any time by simply deleting the launch configuration.

« You will need to select a probe for each project that you debug within a Workspace (as well
as for each configuration within a project).

« If you wish to debug a project using a different family of debug probe(s), then the simplest
option is to delete the launch configuration files associated with the project and start a debug
operation. Please see the section "An Introduction to for more
information. Please also see

Controlling Execution

When you have started a debug session a default is set on the first instruction
in mai n(), the application is started (by simulating or performing a processor reset), and code is
executed until the default "breakpoint is hit.

Program execution can now be controlled using the common debug control buttons, as listed

in Table 11.1, which are displayed on the global toolbar. The call stack is shown in the Debug
View, as in Figure 11.4.
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1 Debug £2

v [ frdmk64f_driver_examples_gpio_led_output LinkServer Debug [C/C++ (NXP Semiconductors) MCU Application]
v :’;f'frdmkﬁdf_driver_examples_gpio_led_output.axf [MKBAFN1MOxxx12 (cortex-m4d)]
¥ o Thread #1 1 (Stopped) (Suspended : Signal : SIGINT:Interrupt)
= delay() at gpio_led_output.c:61 0x806
= main() at gpio_led_output.c:91 0x852
w arm-none-eabi-gdb (7.12.0.20161204)

Figure 11.4. Debug controls and Debug Call Stack

Table 11.1. Program execution controls

Button Description Keyboard Shortcut
& Restart program execution (from reset)

i Run/Resume the program F8

il Pause Execution of the running program

Terminate the debug Session Ctrl + F2
", Clean up debug

e I Run, Pause, Terminate all debug sessions

2 Step over a C/C++ line F6

S Step into a function F5

_® Return from a function F7

T T W Step in, over, out all debug sessions

= Show disassembled instructions

Tip

@ Clean up debug will kill all debug processes associated with LinkServer, P&E and
SEGGER debug connections. This button can be used in the event of a debugging
crash to remove any failed processes that remain. Note: a warning will be issued
with the option to cancel before any action is performed since this action will kill all
connected debug sessions.

Note: The debug controls for ‘all’ debug sessions will perform identically to their single session
counterparts if only one debug session exists.

Note: Typically a user will only have a single active debug session. However if there is more
than one debug session, the active session can be chosen by clicking within the debug call stack
within the Debug view. All debug views will reflect the selected session.

Setting a breakpoint

To set a breakpoint, simply double-click on the left margin area of the line on which you wish to
set the breakpoint (before the line number).

Restarting the application

If you hit a breakpoint or pause execution and want to start execution of the application from the
beginning again, you can do this using the Restart button.
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Stopping debugging

To stop debugging just press the Terminate/Stop button. This action will disconnect
MCUXpresso IDE from the target (board). The subsequent behaviour is controllable by the
Pause debugging

Typically, debugging is paused due to the action of a or

since these will be set to observe the target when an event of interest has occurred. However,
the pause button can be used to pause the target at an instant of time.

To pause debugging

If you are debugging using the Debug Perspective, then to switch back to the C/C++

Perspective when you stop your debug session, just click on the C/C++ tab in the upper right
area of MCUXpresso IDE (as shown in Figure 3.2).

11.2 Launch Configurations
Launch Configuration files will be automatically created within the root directory of a project the
first time a debug operation is performed. They will typically be named:
{proj nane} {debug sol uti on}Debug. | aunch
{proj nane} {debug sol uti on}Rel ease. | aunch
A file will be created for the build variant being debugged, and is used to store the settings for
the debug connection for that build configuration.
Normally, there is no need to edit launch configurations, as the default settings created by the
IDE will be suitable. However, in some circumstances, you may need to manage them — typically
under direction from an FAQ. In such cases this can be done via the “Launch Configurations”
entry on the context sensitive menu available from the Project Explorer view...
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Figure 11.5. Create a Launch Configuration
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Note: to view the contents or edit an existing launch configuration file, you can also simply double
click it.

A number of options are available here:

Edit...

< Allows various debug settings to be modified
» Typically not required since the default options will be correct for most debug operations

Create new...

« Create a launch configurations for a particular debug solution, if they do not already exist.

« Normally you will not need this option as it is carried out automatically the first time that you
debug your project. However, if you want the flexibility to debug a project with different debug
solutions for example, LinkServer and SEGGER, then both sets of launch configurations
can be created. On the next debug operation, the user can select the launch configuration
to use for that session.

Create and edit new...

¢ Allows new launch configurations to be created and immediately opened for editing.

Delete...

« Allows the launch configurations for the selected project (or projects) to be deleted.

e This can be useful as it allows you to put the debug connection settings back to the default
after making modifications for some reason, or if you are moving your project to a new version
of the tools, and want to ensure that your debug settings are correct for this version of the tools.
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11.21

Delete JTAG Configuration...

¢ Allows the JTAG configuration files for the selected project (or projects) to be deleted. These
files are stored in the Debug/Release subdirectories.

Editing a Launch Configuration (LinkServer)

WARNING: - Modifying the default settings for a launch configuration can prevent a successful
debug connection from being made.

After selecting the “Edit...” or “Create and edit New” launch configuration menu entry, you will
then see a new dialog box pop up, which looks similar to the following...

Figure 11.6. Edit a Launch Configuration

@ [ ] Edit Configuration
¢

Modify configuration and continue. @\

Name: | MK&4FN1MOxxx12_Project Ling s «

[5l Main 'k Source [ € GUI FJasn‘lCnmmnn

[ MCUXpresso IDE LinkServer Debugger
Stop on startup at: | main Request hardware breakpoint
Debugger Options
UC (| Target configuration
Debug options for NXP MK64FN1MOxxx12 (cortex-m4)

Debug Connection |SWD ¥

Configuration Option ~ Value

a4 Additional options

&/ Attach only False

) Connect Script kinetisconnect.scp

a4 Debug Level 2
i-| Debugger memory cache Disable
i:| Disconnect behavior cont
i| Flash Driver Reset Handling
i Load image True
Miscellaneous
Emulator selection | LinkServer v
Edit scripts...
Debug options template
Debug Configuration (%) ¥ [ Showall
Revert Apply
2 U Conine |
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Most settings that you may need to modify can be found in the Debugger tab, in the Target
configuration sub-tab (as shown in the above screenshot).

Some examples of modifications that you may need to make in particular circumstances are:

¢ Changing the initial on debug startup

* When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even
remove it completely.

* Modifying the Debugger connect behavior

 via a Connect Script e.g. kinetisconnect.scp
¢ Connecting to a target via JTAG rather than SWD

« if supported by the target, you can edit the Debug type
¢ Connecting to a running target
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» set Attach only to True (see also

Tip
@ New in MCUXpresso IDE version 10.3.0, multiple launch configurations are

supported for each build configuration. Multiple launch configurations may be
created using standard Eclipse functionality — for example from the main menus,
select Run -> Debug Configurations and double click on the C/C+ entry. Alternatively
you can clone an existing launch configuration. Once this has been done, a debug
operation will present the user will a list of available launch configurations. Simply
double click the required launch configuration to start the debug session

11.3 Common Debug Operations and Launch Configurations

Where possible MCUXpresso IDE attempts to provide a common debug experience regardless
of the debug solution being used. However some debug tasks require launch configuration
modifications and these will be different for each debug solution. In this section, some common

debug operations are discussed for each debug solution.

11.3.1 Debug Quickstart Shortcuts

Introduced in MCUXpresso IDE version 10.2 are Quickstart debug shortcuts. These buttons

request actions only from their respective debug solutions.

Figure 11.7. Debug Shortcuts
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~ Miscellaneous | B Program flash action using LinkServer
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‘L}‘ Quick Settings>> | 4
& Export project(s) to archive (zip)
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Each button provides the same 4 options for each debug solution:
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11.3.2
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Debug (default) : make a Debug connection to the chosen debug probe. A launch configuration
will be created if not present. The attach mode will be set to False. Note: a normal debug
operation will inherit a launch configurations attach setting, whereas this operation will force
attach mode to False. If a launch configuration already exists, its attach setting will be set to
False, no other changes will be made.

Attach : make an Attach connection to a LinkServer compatible debug probe. A launch
configuration will be created if not present. The attach mode will be set to True. The launch

configuration will be given a A decorator to show that Attach is the set configuration. # button.
If a launch configuration already exists, its attach setting will be set to True, no other changes
will be made.

Program Flash : perform the launch configuration Program action, by default this will program the
‘project’ into flash. The selected project will be built if required and a default launch configuration
will be created if one is not present.

Erase Flash : perform the launch configuration Erase action, by default this will erase the flash
memory via a mass erase. A default launch configuration will be created if one is not present.

Note: the selected action will be remembered for subsequent shortcut uses, the tooltip will show
the action to be performed.

Tip

@ If an attach operation is performed, the created launch configuration will have Attach
setto True. Therefore any subsequent debug operations will be in Attach Mode, until
either the launch configuration is edited to set Attach to false, or the Debug short cut
is used again to force the attach mode to false.

Connecting to a running Target (attach)

A typical debug session will begin by downloading code to Flash and then debugging from main()
onwards. However, to explore an already running system a debug connection (attach) can be
made to the target MCU without affecting the code execution (at least until the user chooses to
halt the MCU!).

Note: Source level debug of a running target is only possible if the sources of the project to be
attached exactly match the binary code running on the target.

Important Note: Please be sure to read and understand the section on
and also the implications in the related section on

LinkServer

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab and Target configuration view, then set the ‘Attach only’ setting to True as below:
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Modify configuration and continue.

|
| | Name: |MKG4FN1MQ

| |[[E) Main | [C] Comm

Stop on startup at: | main

| Debugger Options

; Debug Connection |SWD |¥

Contiguration Option

B MCuxpresso IDE LinkServer Debugger

Main:

Debug options for NXP MKE64FN1MOxxx12 (cortex-m4)

Edit Configuration

Request hardware breakpoint

~ Value

at[: Additional options

i-| Attach only True v
at: Connect Script True l
at]: Debug Level False

#| Debugger memory cache

il Disconnect behavior cont

Figure 11.8. Debug Launch Attach Mode

When a debug connection is made, the target will continue running until it is paused. However,

if the IDE Debug Mode is set to Non-Stop (the default) then Global variables values can be
explored and displayed.

Other operations such as ITM console 10 will also function. See the LinkServer SWO Trace
Guide for further information.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, then set the ‘Attach to a running target’ check box as below:

Modify configuration and continue.

Edit Configuration

¥

Name: MKB4FN1MOxxx12_Project PE Debug

[ 21 Main [¥5 Debugger | € GUI Flash Toq| |l Startup
Semihosting Settings

% Source | [] Common

Enable semihosting  Console routed to: Telnet GDB client

Enable Telnet console Telnet Port; 51794

Load Symbols and Executable
Load symbols
| | o Use project binary: MK&4FN1MOxxx12_Project.axf
| Use file:
Symbols offset (hex):
Load executable
° Use project binary: MK64FN1MOxxx12_Project.axf

Use file:
Executable offset (hex):

Runtime Options

[ Attach to Running Target ] Run on reset

Set PC (absolute hex address or symbol):

Set breakpoint at: main
GDB run commands:

Figure 11.9. Debug Launch Attach mode P&E

When a debug connection is made, the target will continue running until it is paused.
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SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the
Debugger tab, then set the ‘Attach to a running target’ check box as below:

Modify configuration and continue.

Edit Configuration

i, By using attach mode any 'monitor reset’ command will be ignored.

Project JLink Debug
gger | © GUI Flash Tool | # Startup | & Source| ] Common

JLink Interface Settings
JLink Interface ©Quss P

fixed

Device MKBAFN1MOx0ex12

Target Interface SWD

Speed adaptive () auto

GDB Server Settings

Server startup and port selection () auto manual

GDB Server Port
SWO Port
Telnet Port

Endianess

little 1?7
B

Enable Semihosting

Disconnect behaviour Run
Power Target
GDB Client Settings

Halt target on startup
GDB Client Port

Initialize CPU registers

Additional Options
Silent
Request hardware breakpoint for stop on startup symbol/address

Reset before running
Seript

Select RTOS plugin

Figure 11.10. Debug Launch Attach Segger

Verify [ Single run] 8 Attach to a running target

3

Browse

When a debug connection is made, the target will continue running until it is paused.

11.3.3

Controlling the initial Breakpoint (on main)

When the debugger starts, it automatically sets an initial (temporary) breakpoint on the first
statement in main(). If desired, you can change where this initial breakpoint is set, or even remove
it completely. One common requirement is to debug an application from startup. The entry point
(startup) in an standard example application can be identified by a symbol called ResetISR, a
breakpoint can be set on this symbol to halt execution at the first instruction within an application.

LinkServer

To debug from the start of the image, edit the project launch configuration by double clicking on
the launch config file, select the Debugger tab, replace main with ResetISR
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|5 Mai m__ GUI Flash Tool | [ Cornmoﬁ_'—‘} Seource._

® MCUXpresso IDE LinkServer Debugger

Stop on startup g | ResetiSH Request hardware breakpoint

Debugger Options

Figure 11.11. Debug Launch ResetISR

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Stop on startup at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Stop on startup at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

P&E

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR

Figure 11.12. Debug Launch ResetISR P&E

£ wain (3 Debuggor (@ U1 Flash TM I common

Semihosting Settings

{3 Enable semihosting  Console routed to: (4 Telnet | GDB client
Enable Telnet console Teinet Port: 51794

Load Symbols and Executable

Load symbols
© Use project binary: MK64FN1MOxxx12_Project.axf

Use file:
Symbols offset (hex):
Load executable
0 Use project binary: MKB4FN1MOwxx12_Project.axf

Use file:
Executable offset (hex):
Runtime Optians

Attach to Running Target Run en res
Set PC (absolute hex address or symbol):

GDB run commands:
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When a debug connection is made, the target should halt at this symbol.

To disable the intial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

SEGGER JLink

Edit the project launch configuration by double clicking on the launch config file, select the Startup
tab, replace main with ResetISR
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[ Main | 3 Debugger | € GUI Flash To Source | [T] Common
Initialization Commands

Reset and Delay (seconds): '3
Halt
monitor reset

Load Image and Symbols

Load image

© Use project binary: MKG4FN1MOxxx12_Project.axf
Use file:

Image offset (hex):

Load symbols

© Use project binary: MK64FN1MOxxx12_Project.axf
Use file:

Symbols offset (hex):

Run Commands

Set program counter at (hex):

| ResetISR |

Set breakpoint at:

Figure 11.13. Debug Launch ResetISR Segger

When a debug connection is made, the target should halt at this symbol.

To disable the initial breakpoint, uncheck the option ‘Set breakpoint at...". To restore the original
behaviour, replace the symbol ResetISR with main, and check the option ‘Set breakpoint at...".
Alternatively, you could delete the launch configuration and allow the IDE to create a new one.

11.3.4 Disconnect Behaviour

Once the user has completed a debug session, the debugger connection can be terminated via
the IDE’s Terminate button! The exact behaviour of the target will depend on the particular debug

solution.

LinkServer

For LinkServer, the launch configuration contains a set of options to control what the target should
do when terminated. The default option is for the target to continue running from the current PC
value, however this can be changed by selecting a new setting within the launch configuration.

] MCUXpresso IDE LinkServer Debugger
Stop on startup at: main

Debugger Options

Debug options for NXP MK84FN1MOxxx12 (cortex-m4d)

Debug Connection |SWD ¥

Configuration Option
st Additional options
| Attach only

ai: Connect Seript

- Debug Level

£l Load image

Miscellaneous

Figure 11.14. Debug Launch Disconnect Mode

Request hardware breakpoint

Mainz

~ Value

False
kinetisconnect.scp
2

Disahle

cont

nachange
stop

v

Where:
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* nochange - will leave the target in its current state

e stop - will leave the target in debug state i.e. halted

e cont - the default, will either start the image from its current PC value or leave it running
e run cont - will reset the target and let it run

P&E

The Terminate button will force the target to halt. Alternatively, for P&E debug the IDE supports
another option — to disconnect and force the target to run. This can be achieved via the IDE’s

disconnect ** button.
SEGGER JLink

The target will Run on disconnect by default. The launch configuration option, Disconnect
behaviour can be changed to Halt causing the target to halt on disconnect.

11.3.5 Project Flash Programming

Introduced in MCUXpresso IDE version 10.2.0 — launch configuration dialogues now contain
a GUI Flash Tool tab. This along with the and

provide access to the flash programming capabilities each of the supported
debug solutions.

For each debug solution, the options will vary slightly but the presentation is broadly the same
as shown below. These options are self describing.

[5] Main [ Debugger] | Startup | % Source | =] Common

GUI Flash™TBT
| Program e@h into flash Debug/MKG4FN1MOxxx12_Project.axf

Target: MK64F| 1S
J Main | %5 Debugger ¥ Startup | &~ Source | [C] Common
Targes Q’} i GUI FlashTool
ﬁ et fiesiey Program file into flash: Debug/MK64FN1MOxxx12_Project.axf
Erase; Ra @

Options
" Target: MK64j %\ 2
Select the optiens 18

Format to use ol Target Operftions e
Pl select the target flash [ (5] Main “’DE"“EQEV L] sourd (] Commen

Base Address W,“EL GUI Flash Tool

Reset target on Program file into @ Debug/MK64FN1MOxxx12_Project.axf

Actions.
Select the action tf

© Erase, blankd| To0et wsawm%

General Options.

Program andj| Target Op w—
Flash programming tool Veio s e m@ N —
Proview comm Erase | Resurrect locked Kinetis device
Options
s | Select the options Actions

Reset targadl Select the action te perform

© Frogram Program (mass erase first)
Verify only Check file areas blank
General Options Options
Flash programming tof Select the options to apply
Preview comman Format to use for programming @ axf ' bin
Base address
| Reset target on completion

General Options
Flash programming tool options

Preview command [ Clear console

Figure 11.15. Debug Launch Flash Programming

To perform the selected operation, simply click the Run button.

Important Note: By default, a launch configuration will be created with Program as the default
Program action, and Mass Erase as the default Erase action. When settings are changed by the
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user they will be stored within that project’s launch configuration and will remain until manually
changed (or the launch configuration is deleted). When are used, they
will action the current settings within the selected projects launch configuration (or if none exists,
create a new default launch configuration) - therefore if the Program action is set to Verify, a
Verify will be performed as the Program action.

Breakpoints

When viewing source (or disassembly) during a debug session, you can toggle breakpoints by
simply clicking/double clicking in the left most side of the source view, typically shown as a light
blue column. This is also where the breakpoint symbol is shown when one is set. This can be
done when the target is paused or running.

Breakpoints (and Watchpoints) are also displayed, and can be deleted or disabled in the
Breakpoints View. If you are using the “Develop” perspective, then by default it will be in the
bottom left of the MCUXpressolDE window tabbed with the Quickstart and other views

If you have closed the Breakpoint view at some point, then you can re-open it using the “Window
-> Show view” menu or ‘Window -> Perspective -> Reset Perspective".

Breakpoint Types

At a basic level there are 2 types of breakpoints:

« Hardware: these are limited in quantity but can be set on ROM (Flash) or RAM. These
breakpoints are provided by the debug hardware built into to the CPU.

« Software: these are implemented by a software instruction BKPT and can in normal
circumstances only be placed on addresses within RAM (since the underlying code must be
changed). These breakpoints can be applied in any quantity and are invisibly placed (and
removed) by the debugger.

Usually the debugger will automatically decide the best breakpoint to use for a particular memory
type or circumstance and this is invisible to the user.

Simplistically, software breakpoints will be placed in RAM and Hardware breakpoints are placed
in ROM (Flash).

Tip

@ On some systems, a bootloader may copy code from ROM into RAM for execution
— if a symbol within this code is breakpointed — such as main(), then the debugger
may select a software breakpoint since it knows that main() will reside in RAM.
A problem can arise if the software breakpoint is set by the debugger before the
bootloader has relocated the code. If this occurs, any software breakpoint will be
overwridden by the relocated code. Introduced in MCUXpresso IDE version 10.2.0
is support for - to ensure this problem does not arise in
this case, MCUXpresso IDE will force a hardware breakpoint onto main(). This will
not be overridden since this breakpoint type makes no changes to memory.

Breakpoints Resources

When debugging code running from Flash memory, the debugger is limited on how many
breakpoints it can set at any time by the number of hardware breakpoint units provided by the
ARM CPU within the MCU.

Note: Code located in RAM can use a different breakpoint mechanism offering the capability of
essentially unlimited breakpoints.
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Typically, the number of hardware breakpoints/watchpoints that can be set are as follows:

Cort ex- M)/ M+ (LPC) - 4 breakpoints, 2 watchpoints
Cort ex- M0/ MO+ (Kinetis) - 2 breakpoints, 1 watchpoints
Cortex- MB/ M4/ M7 - 6 breakpoints, 4 watchpoints

ARM does provide a level of implementation flexibilty, so always consult your MCU
documentation.

If you try to set too many breakpoints/watchpoints when debugging, then the precise behaviour
will depend on the debug solution you are using. For LinkServer an error of the form below will
be generated.

15: Target error from Set break/watch
Unabl e to set an execution break - no resource avail able.

To fix the problem, simply remove the excess breakpoint(s).

Also remember that a breakpoint will be (temporarily) required for the initial breakpoint set by
default on the function main() when you initially debug your application. A breakpoint may also
be required (temporarily) when single stepping code.

Note: When the target is paused, any number breakpoints may be set within the source or
disassembly views of the IDE, however only when the target is Resumed (Run) will the low level
debug hardware attempt to set the required breakpoints. Therefore it is possible to request many
more breakpoints that are supported by the target MCU leading to the error described above.

Skip All Breakpoints

You can use the “Skip all breakpoints” button ® in the Breakpoints view (or on the main toolbar)
to temporarily disable all breakpoints. This can be particularly useful on parts with only a few
breakpoints available, particularly when you want to reload your image, which will typically cause
the default breakpoint on main() to be temporarily set again automatically by the tools.

Watchpoints

Watchpoints are Breakpoints for Data and are often referred to as Data Breakpoints. Watchpoints
are a powerful aid to debugging and work by allowing the monitoring of global variables,
peripheral accesses, stack depth etc. The number of watchpoints that can be set varies with the
MCU family and implementation.

Watchpoints are implemented using watchpoints units which are data comparators within the
debug architecture of an MCU/CPU and sit close to the processor core. When configured they
will monitor the processor’s address lines and other signals for the specific event of interest. This
hardware is able to monitor data accesses performed by the CPU and force it to halt when a
particular data event has occurred.

The method for setting Watchpoints is rather more hidden within the IDE than some other
debugging features. One of the easiest ways to set a Watchpoint is to use the Outline View,
which by default this will be located within the IDE Quickstart panel.

From this view you can locate global and static variables then simply select Toggle Watchpoints.
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Figure 11.16. Toggle Watchpoint

Once set, they will appear within the Breakpoint pane alongside any breakpoints that have been

set.

Watchpoints can be configured to halt the CPU on a Read (or Load), Write (or Store), or
both. Since watchpoints ‘watch’ accesses to memory, they are suitable for tracking accesses to
global or static variables, and any data accesses to memory including those to memory mapped

peripherals.

Note : To easily distinguish between Breakpoints and Watchpoints within the Breakpoint view,
you can choose to group entries by Breakpoint type. From within the Breakpoints view, click the
Eclipse Down Arrow Icon Menu, then you can select to Group By Breakpoint Types as shown

below:

) Quic ®=Glo

& systick.c [expression: ‘counter1']
# systick.c [expression: ‘counter2']

* @brief

(*=Vari 0= Qutl (% Bre | = O € = .
B8 return
i

% @ 5w @E‘@f
ayout >

(=i}

€0 Add Event Breakpoint (C/C++)...
%% Add Watchpoint (C/C++)...
~~ Show Full Paths

& systick.c [line: &
. systick.c [line: 79 @ Add Line Breakpoint (C/C++)...
4 Add Function Breakpoint (C/C++)...

Group By >
oo Select Default Working Set...
Deselect Default Working Set

Working Sets...

Properties & Cor

nerinh svstick |inkServer Debua [C/C++ (N)

Installed SDKs

Figure 11.17. Watchpoints View
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®g 1 Breakpoints

v . 2 Breakpoint Types

oo 3 Breakpoint Working Sets
= 4 Files

= 5 Projects

(= 6 Resource Working Sets
% 7 Advanced...
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As you can see from the above graphic, the option to set a Watchpoint is also available directly
from the Breakpoint view. When set from here, you will be offered an unpopulated dialogue —
simply entering an address will cause a watchpoint to be created, monitoring accesses to that

location.

Another place to set Watchpoints within the IDE is from the context sensitive menu within a

Memory view.
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11.5.1

Note: Watchpoint resources are shared with other debug features, in particular an SWO Data
Watch item will require a dedicated watchpoint unit to monitor the value.

Note: Due to the way watchpoints are implemented, any monitored access will be performed
by the CPU before a halts occurs (unlike instruction breakpoints — which halt the CPU before
the underlying instruction executes). When a watchpoint is hit you will see some ‘skid’ beyond
the instruction that performed the watched data access. If the instruction after the data access
changes program flow (e.g. a branch or function return), then the IDE may not show the
instruction or statement that caused the CPU to halt.

Note: Application initialisation performed by the C library may write to monitored memory
locations, therefore you may see your application halting during startup if watchpoints have been
set on initialised global data.

Using Watchpoints to monitor stack depth
Watchpoints provide a very simply way of monitoring stack depth when an application is running.

Stacks on ARM based processors use a Full Descending scheme and so have the potential to
descend into areas of memory used for other purposes (typically holding global data or the heap).
Establishing the maximum depth of an applications stack can be a challenge especially since any
memory corruption due to excessive stack use may not be immediately apparent. Watchpoints
may be used to monitor and trap the stack exceeding a particular depth during execution enabling
positive reassurance that the true stack depth is understood.

The graphic below shows the use of the breakpoint view feature Add Watchpoint (C/C++) ...
where an address has been selected to watch for the Stack reaching 0x10007D00.

[ ] @ Properties for C/C++ Watchpoint
Common Common - v
Class: C/C++ Watchpoint

Expression to watch: | Ox10007D00
Range:

Read

Write
Enabled
Condition:
Ignore count: 0
@ concel | (ETHENN |

Figure 11.18. Watchpoint on Stack Depth

11.6
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Registers

The Register view, by default located next to the Project Explorer view, will display the internal
ARM CPU registers when the core is halted i.e. when there is an active debug connection but
the target is paused. The contents of the registers view will vary depending on the nature of the
ARM CPU inside the MCU being debugged, however the base register set will be available for
all MCUs.

The Register list as displayed is made up from, the Basic Register set (Core Registers), Fault
and Status Registers, Pseudo Registers, and finally Floating point Registers (for Cortex M4/M7
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etc.). Since the register set for many MCUs is large, individual register groups can now be hidden
if required to reduce screen usage.

Note: For many debug tasks, the values of the CPU registers will be of little concern, however
when debugging at the disassembly level (and single stepping), these values can be a powerful
debugging aid. For an in depth understanding of the ARM register set for the CPU within your
NXP MCU, please consult the documentation available from ARM.

Tip
@ Even when operating in LinkServer None Stop mode, registers cannot be read or

written when the target is executing and the register display may appear blank.

Basic Register set (Core Registers)

The basic register set comprises the CPU’s 16 32 bit core registers (rO — r15), plus the program
status register, certain registers have a special function:

r13 — SP Stack Pointer, this holds the address of the last entry on the stack
rl4 — LR Link Register, this holds the return address for a BL (branch with link) instruction
rl5 — PC Program Counter, this holds the address of the instruction (to be) executed

XpSr — program status register, this combines the Application (APSR), Interrupt (IPSR) and
Execution (EPSR) program status registers, reflecting the state of the CPU

flags — set by certain instructions performing arithmetic operations (contained within the APSR)

The register set (for a Cortex M4 CPU) is displayed below:
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i Project Explorer = Peripherals+ ! Registers 52 | 4% Faults . Symbol Viewer = ]
1L -
Name Value Description |
fF 5 MK64FN1MOxxx12 (cortex-m4) fr 4f_bubble.axf regi s 1
itk OxfFFFFiff Argument/Scratch Register 1
Wi 0xbff00000 Argument/Scratch Register 2
iiir2 ox1 Argument/Scratch Register 3
wiird ox1 Argument/Scratch Register 4
Wiird OxbffO0000 Variable Register 1
oot S Oxc0180000 Variable Register 2
ol 0x0 Variable Register 3
iirz 0x2002ffb0 Variable Register 4
W 0x0 Variable Register 5
367 Ox0 Variable Register 6
Wir10 0x0 Variable Register 7
Mir1l ox0 Variable Register 8
wir12 0x7fa1cO00 Intra-Procedure-Call Scratch Register
il sp 0x2002ffb0 Stack Pointer (r13)
it lr Oxad3 Link Register (r14)
Oxa78 | Program Counter (r15)
0x81000000 Program Status Register
B Tpscr O0x0 Floating Point Status Control Register
il msp 0x2002ffb0
i psp ox0
¥ iisi control Ox4
» iif faultmask O0x0
> il basepri 0x0
» i) primask 0x0
p AR L i m
[v 1\ Status Registers Status Registers for Cortex-M4 )
¥ iii'apsr Nzcvg Application Program Status Register
oN True Negative Flag
mZ False Zero Flag
L Ao False Carry (or NOT borrow) Flag
v False Overflow Flag
,,?. Q False Sticky Saturation Flag
o GE O0x0 Greater Than or Equal Flags
» iilipsr no fault Interrupt Program Status Register
L lisner L Exacution Drogram Status Dgoistar _J
» X4 Additi s Additional FPY Reisters for Cortex-M4
¥ %, DWT Registers Data Watchpoint and Trace Unit Registerd
iilicycles Oxaf4ifd Cycle Count Register
\__ilicycleDelta Ox31b8c Cucie Deltg
lame : pc
Hex:@xa78
Decimal:2682
Octal: 05170
Binary:101081111000
Default:@xa78 <main+692>

Figure 11.19. Registers View

Note: in this graphic the floating point registers have been hidden

Four blocks of registers are highlighted within the graphic

« registers r0 —r15 and the xpsr (the components of this are shown below in the status registers)

« status registers apsr ipsr and epsr, these registers together combine to form the xpsr

« certain bit fields such as the CPU flags are expressed alpha-numerically in this view

« Cycles is a memory mapped register that increments for each core clock tick. CycleDelta is a
pseudo register that records the cycles since the last pause (see more below).

« details view displays the selected register in various formats

When paused, all of these registers can be read (or written). The ability to write values to the
registers set is a powerful debug feature but should be used with care.

CycleDelta

CycleDelta holds the number of core clock ticks that have occurred since the last time the
CPU was paused. For example, if you run from the default breakpoint on main to a breakpoint,
cycledelta will contain the number of clock ticks that occurred while executing this section of code.
If a step is performed, the cycledelta will be the number of clock ticks for code being stepped. If
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stepping at the instruction level, this value will often be 1 because many instructions will execute
within a single clock cycle.

Vectpc

In previous versions of MCUXpresso IDE the pseudo register VectPC was used to display a
value when the CPU has experienced a Hard Fault. This functionality has been replaced by the

Faults

During application development, errors within a program or algorithm may lead to a CPU fault
(Hard Fault). These faults include:

» usage fault — such as a divide by zero

¢ bus fault — such as abort triggered by a memory controller

*« mem manage — such as a fault triggered by a memory protection unit

Such errors can be difficult to locate, so to aid the debugging of such problems MCUXpresso
IDE version 10.3.0 introduces a new Faults new.

If a fault occurs, the new Faults view will automatically appear and the CPU will halt (LinkServer).
The view offers a set of features including identifying the nature of the fault, the location (link) of
the code that caused the fault, the location (link) of the function that called the ‘fault’ function.

Note: for non LinkServer debug probes, a fault may leave the application running within the

default fault handler (usually implemented as a while(1)), hence a pause might be necessary to
see that a fault has occurred.
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ect Expl Peripherals+ Registers '%.‘;‘-Faults &3 Symbal Gt {m)

3+ Active faults @ main.c [line 195]

[ Hard Fault (HFSR)

Indicates a forced hard fault, generated by escalation of a fault with
4% FORCED (30) configurable priority that cannot be handled, either because of priority
\ or because it is disabled

[ Usage Fault (UFSR)

45 DIVBYZERO (9) Divide by zero
N

/;autt Status Registers

Name Value Description

XPSR 0x61000003 Exception Status Register

CFSR 0x02000000 Configurable fault Status Register
UFSR 0x0200 User fault Status Register

HFSR 0x40000000 Hard fault Status Register

DFSR 0x00000000 Debug fault Status Register
AFSR 0x00000000 Auxiliary fault Status Register

L

@ckeﬂ Registers (LRIEXC_RE&OXIHIMQ)

Name Value Description

RO 0x00000018B

R1 Ox1FFFO1B8

R2 Ox1FFFO1B8

R3 0x00000000

R12 0x00000011

LR 0x00000513 = main()

PC 0x0000261E = DivideByZero()
PSR 0x61000000

q Ox1FFFO1 CO/

Figure 11.20. Faults View major features

This view will be titled with the source file and line number that caused the error. The view
contains the following features:

1. The Fault that occured — in this example a Usage Fault of type Divide by Zero

 certain faults may need to be enabled within the CPU, for example Divide by Zero is enabled
in the Cortex M4 Configuration and Control register

. The Action that was taken — in this example a Hard Fault was generated
. Links to the source of the fault function and its caller function, located from stacked registers
. values of the registers automatically stacked on entry to the fault handler
. fault status registers that may offer further information
. additional options including:
¢ button to cause disassembly to be opened in parallel with sources (3)
 button to copy the fault details to the clip board
¢ button to display all fault registers and descriptions rather than the

o Ok WDN

In some circumstances, a hard fault might be caused early on during the initialisation of the
system before the breakpoint on main() is hit. This may mean that the fault is triggered before
the debugger can take action to display the faults view. If this happens, try setting a breakpoint in
the startup code — this might then allow your code to load without the hard fault being triggered.
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You should then be able to single step / run until the cause of the hard fault is hit. You will then
see Faults View displayed.

Tip

@ if a repeated fault occurs that is difficult to debug, instruction trace could be enabled
(when supported by the MCU) and the captured trace dumped when the fault is
trapped. Looking back at the captured instructions should help find the reason for the
fault condition. Please see the MCUXpresso IDE Instruction Trace guide for more
information.

Note: Typically a Fault on an embedded system will be fatal, however this view will also assist
for users developing and testing fault handlers for recoverable fault situations.

Peripherals

Peripherals is a generic term referring to both core peripherals, for example the System Timer
(SysTick) and SOC/MCU peripherals such as an ADC or UART. In both instances these hardware
blocks are exposed within the MCUs address space (known as memory mapped peripherals)
and so can be interrogated by accesses to their specific memory locations.

MCUXpresso IDE’s debug support (whether built in or provided by an SDK) includes knowledge
of an MCU'’s peripheral set, this is available via the Peripherals tab within the Project Explorer
pane (once a debug connection is made).

Highlighted in the view below are two peripherals that have been selected for detailed display.
Also highlighted are the device memory regions, if these memory regions are selected a standard
hex memory display will be created. Memory regions are not peripherals in the normal sense but
are included here so their memory space can be easily displayed.
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Project Explorer &, Peripherals+ 82 [f!f Registers Symbaol Viewer i]
ﬁm s il Losnnaris
s 2, ADCO 0x1c034000 12-bit ADC controller O ’
ROVSTSCUT v} C2w vrdoiviviv) s}
= &, ASYNCSYSCON 0x40080000 Asynchronous system configuration
1| =.CRC 0x1c010000 CRC engine
2, CT32B0 0x400b4000 Standard counter/ftimer O
| F.cT32B1 0x400b8000 Standard counter/timer 1
= &, CT32B2 0x40004000 Standard counter/timer 2
¥ 2. CT32B3 Ox40008000 Standard counter/timer 3
2. CT32B4 0x4000c000 Standard counter/timer 4
o 2. DCR 0xe000edf0 Debug Core Registers (v7M)
T DMA 0x1c004000 DMA controller
¥ 2 GINTO 0x40010000 Group GPIO input interrupt 0
2 GINT1 0x40014000 Group GPIO input interrupt 1
= = GPIO 0x1c000000 General Purpose I/0O
- 2 12C0 0x40084000 12C-bus interface O
L 2121 0x40098000 I12C-bus interface 1
| B12c2 0x4009c000 12C-bus interface 2
= 2 INPUTMUX 0x40050000 Input multiplexing
= 2, I0CON 0x4001c000 1/O pin configuration
L ZIT™ 0xe0000000 Instrumentation Trace Macrocell
T E MAILBOX 0x1c02c000 Mailbax
T E MPU 0xe000ed90 MPU (v7M)
T EMRT 0x40074000 Multi-Rate Timer
¥ 2 NVIC Oxe000e000 NVIC Control/Status Regsiters (v7M)
L PINT 0x40018000 Pin interrupt and pattern match en...
= ZRIT 0x40070000 Repetitive Interrupt Timer
- 2 RTC 0x4003c000 Real-Time Clock
L 2, SCTO 0x1c018000 State Configurable Timer/PWM O
2, SPI0 0x400a4000 SPI0
AN 0x40028000 SPI1
(v . svscon 0x40000000 System configuration )
T USARTO Ox20084000 USARTO
& USART1 0x40088000 USART1
Tl E USART2 0x4008c000 USART2
Tl . USART3 0x40080000 USART3
1| B UTICK 0x40020000 Micro-tick timer
2, VFIFO 0x1c038000 System FIFO for Serial Peripherals
- WWDT 0x40038000 Windowed Watchdog Timer
= MFlash256 0x0 Flash: size=0x40000 (256k)
Ram0_64 0x2000000 RAM: size=0x10000 (64k)
Ram1_32 0x2010000 RAM: size=0x8000 (32k)
Ram2_8 0x3400000 RAM: size=0x2000 (8k)

Figure 11.21. Peripherals View

[T
i

£}

v = "

From this view each peripheral is listed along with its base address and brief description. If
selected from the associated check box, a detailed memory view will be launched. This view
exposes the inner peripheral registers and offers bit field enumerations to greatly simplify both
reading existing configurations and setting new values.
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0 Memory 2
Monitors

% ADCO[LPC54102J256]
@ SYSCON [LPC54102J256]

Pk e |l BTG ISR BRe Y S 0
g X 5& SYSCON: 0x40000000 [LPC54102J256] &3 or New Renderings...
. Register Address Value
b il ASYNCAPBCTRL 0x40000020 Ox0
» il SYSRSTSTAT 0x40000040 0x0
b 1 PRESETCTRLO 0x40000044 0x0
» i PRESETCTRLY 0x40000048 0x0
b W PRESETCTRLSETO 0x4000004c <writeonly>
kI PRESETCTRLSET1 0x40000050 <writeanly>
» i PRESETCTRLCLRO 0x40000054 <writeonly>
* S PRESETCTRLCLR1 0x40000058 <writeonly>
» 118 PIOPORCAPO 0x4000005¢ 0xfoe33fff
» i PIOPORCAP1 0x40000060 Ox3ffff
» 418 PIORESCAPO 0x400000868 0x79e33fff
> i PIORESCAP 0x4000006c Ox3ffff
¥ 0ibi MAINCLKSELA 0x40000080 0x0
oo SEL [1:0] IRC OSCILLATOR
F il MAINCLKSELB 0x40000084 IRC_OSCILLATOR
b3 ADCCLKSEL 0x4000008c CLKIN
# i1 CLKOUTSELA 0x40000084 WATCHDOG_OSCILLATOR
> i CLKOUTSELB 0x40000088 RESERVED
» i SYSPLLCLKSEL 0x400000a0 0x0
> i3 AHBCLKCTRLO 0x400000c0 0x211b
i AHBCLKCTRL 0x400000cd 0x0
b i AHBCLKCTRLSETO 0x400000cB <writeonly>
> N AHBCLKCTRLSET1 0x400000cc <writeonly>
F it AHBCLKCTRLCLRO 0x400000d0 <writeoniy>
b 18 AHBCLKCTRLCLR1 0x400000d4 <writeonly>
F il SYSTICKCLKDIV 0x400000e0 0x0

Figure 11.22. Peripheral Register view

11.8.1
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Important Note: When an MCU powers up, many peripherals will be unavailable because they
are unpowered/not clocked. Attempting to access a peripheral in this state will result in failure, and
the detailed peripheral view will simply display their base address in red. Certain peripherals may
be partially available, unavailable sections will again display in red. Entries that have changed,
will display in yellow.

Tip

Even when operating in LinkServer None Stop mode, peripherals can not be read or
written when the target is executing. The main peripheral display may appear blank
when the target is executing regardless of LinkServer mode

Warning: It is strongly advised that only peripherals that are well understood are accessed
in this manner since attempting to view certain peripherals can break a debug connection or
perform other unexpected actions. MCUXpresso IDE’s debug features cannot offer protection
from such occurrences.

Peripheral Filters

Introduced in MCUXpresso IDE version 10.2.0 is the ability to filter the displayed peripheral view.
Peripherals may contain a large number of internal registers, and these registers may contain
many fields, to reduce screen clutter and to help locate peripheral registers (and fields) of interest,
one or more filters can be applied.

To create a filter, right click inside the peripheral rendering and select Edit Filters. This will launch
a dialogue as below.
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MCUXpresso IDE
Filter
Hide registers/fields not containing the filter string m

Filters configurations
| Regular Expression ) Contains

Case sensitive

Filters
| [Text Field
PERIF iféi Register M
)
Field
Add Filter Remove Selected Filters

Cancel oK

Figure 11.23. Peripherals Filter

For each piece of text to match, you can select whether the filter applies to Register Names or
Field names. To restore the view, right click inside the peripheral rendering and select Remove
all filters.
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12. Configuring a Project

When a project is imported or generated using a wizard, there are many configuration options
available at creation time. However, once a project has been created or if a project is shared by
other means, then there still may be a requirement to make changes.

The range of possible project changes is almost infinate but below we will discuss a number
of common changes that may be required and the potential rammifications that may be
encountered. Note that many of these changes can be started from a projects

Note: This section only discusses a few of the common changes that may be made. Please also
see the sections on | ]

and the additional Config Tool documentation for a more comprehensive
description of the options available.

12.1 Changing the MCU (and associated SDK)

All projects are associated with a particular MCU at creation time. The target MCU determines
the project memory layout, startup code, LinkServer flash driver, libraries, supporting sources,
launch configuration options etc. etc. so changing a project’'s assiciated MCU should not be
undertaken unless you have a total grasp of the consequence of this change.

Therefore rather than changing a project’s associated MCU, it is strongly recommended
that instead a new project is generated for the desired MCU and this new project is edited
as required.

However, on occasion it may be expedient to reset a projects MCU (and associated SDK) and
this can be achieved as follows. From the project virtual nodes, select Edit MCU.

v € Project Settings
¥ =i Associated SDK
o name = 'SDK_2.x_FRDM-KB4F'
o version ='2.4.2'

¢ Edit MCU o

¢ Change Package 3

0
o processor = ‘cortex-m4’

> 314 Memory

» [ Options

Figure 12.1. Edit MCU

You will then be preseted with the MCU Setting dialogue (as below)
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SDK MCUs Preinstalled MCUs
MCUs from installed SDKs MCUs from preinstalled LPC and generic

NXP MKB4FNTMOxxx12 Cortex-M part support

P K32WO0x2S Target
YKBX »LPC1102
MKB4FN1TMOxxx12 PLPC112x%
PKE1X FLPC11AXX
P KW3x »LPC11EBx
FLPC5411x BLPC11Exx
» LPCE46xx FLPC11UBx
» MIMXRT1020 FLPC11Uxx
FMIMXRT1050 FLPC11xx
»MIMXRT1064 PLPC1 1xxLV
[N NaTalk Relalal
Target architecture: cortex-md

Preserve memory conﬁguration]

Figure 12.2. Select MCU

From here, an alternative MCU can be selected but note, there are two check boxes that must
be set as required before this is done:

* Preserve Memory Configuration — it set (the default) the original project memory settings will
be preserved, otherwise the MCU setting for the chosen MCU will replace the original settings

« Preserve Project Configuration — if not set (the default) the new MCUs configurations (such as
Cortex Architecture) will replace the original settings

When the new MCU is selected, a warning dialogue as below will be generated:

%] MCUXpresso IDE =32

' C ) Changing selected MCU to a different one will modify project settings and may
prevent successfull project building and debugging.
Are you sure?

Figure 12.3. Select MCU Warning

Project changes will only be made if Yes is selected.

12.2 Changing the MCU (SDK) package type

MCUs are commonly available in a range of package types. Different packages may impact the
options available on the MCU external pins, for example the number of GPIO lines. MCUXpresso
IDE makes no use of this package type however it is signigicant to the included “MCUXpresso
Config Tools #configtools .

As shown in the previous section, from the project virtual nodes, select Edit MCU.
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v ©& Project Settings
» =) Associated SDK
» =i Libraries (and semihosting)

BEE ¢ it mcu .

+#: Change Package MK64FN1MOVDC12

o processor = ‘cortex-m4’ v MKG4FNIMOVLL12

» 101 Memory MKGB4FNTMOVLQ12

» [ Options MK64FNTMOVMD12
rt;f' Binaries MKB64FN1MOCAJ12

Figure 12.4. Edit Package

then select Change Package and choose the package required.

12.3 Changes available via QuickStart Quick Settings

MCUXpresso IDE provides quick access to a range of project settings via the QuickStart Panel
as shown below:

~ Miscellaneous

& Edit project settings

. MCUXpresso Config Tools>>
@2 Quick Sett
& Export pra
.@ Export pra
e Build all pt

1 & Defined symbols [frdmk64f_bubble Debug]

2 B Undefined symbols [frdmk64f_bubble Debug]
3 4 Include paths [frdmk64f_bubble Debug]

4 % Library search paths [frdmk64f_bubble Debug]
5 & Libraries [frdmk64f_bubble Debug]
6
7
8

(&2 SDK Debug Console >
(% Set Floating Point type >
(2 Set library/header type >

Figure 12.5. Quick Settings

Note: These settings apply to the selected project’s selected build configuration only and simplify
access to commonly used settings normally accessed from Properties -> C/C++ Build -> Settings
Also note Quick Settings changes may be made to multiple projects if more than one project is
selected (where their settings are compatible).

. Defined symbols — select to edit the (-D) symbols

. Undefined symbols — select to edit the (-U) symbols

. Include paths — select to edit the (-I) the include paths

. Library search paths — select to edit the (-L) the library

. Libraries — select to edit the (-I) the linker libraries search

. SDK Debug Console — select the SDK Debug Console’s PRINTF output to be via UART or
to redirect via the C libraries printf function

« selecting printf will increase the size of the project binary compared to UART output

« for semihosted printf output to be generated, the project must be linked against a suitable
library

OOk, WDNPRE
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« for more information see the section on

7. Set Floating Point type — select to switch between the available Floating Point options
« for more information see the section on

8. Set Library/Header type — select to switch the current C/C++ Library
« for more information see the section on
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13. MCUXpresso Config Tools

This chapter provides an introduction to the features of the MCUXpresso Config Tools installed
by default with MCUXpresso IDE. The Config Tools present new perspectives in addition to the
IDE’s Develop and Debug perspectives.

=5 v [ | [ : ) Update Project Code ~Functional Group | BOARD InitPins -@oas N R R SR S Quick Access }| [ | & 45 [
FH Pins 57 | [ Peripheral Signals = O i Package 0 QQQdEE = O [HRegisters 12 [ 5
[EEO ¥ @ weeitertes | NPT + | [£] Show moified registers only
Pin  Pinname Label - type fifter text
1 JL5[P8)/SOHCD | SetValue
2 J15[P7)/SDHCD | et
3 J15[PS}/SDHCD |
4 115[P3)/SDHCD | *
5 115[P2)/SDHCD | soc 0t can
6 J15[P1)/SDHCO| ﬁg}g:::g:; & CcuPo oMPl ChiP2 Ws”“;;
7 nSIGLYSD_CAl “a0C0_DP2! o (=) owa P M1PTCSH
- bt o X
s voDis P3V3K4F i BT £ EEH e
V19 vss17 GND BTES/SPIT_RCSI, F8 Fmvo FTMt ADCO_SEIGRTCOY.
Pt BT PressR_posat AT iy Iy | iosseR S £
(]
/ ssiT PTBIIISPII_SCHS
1 UsB0.M 12212)/K64_MIC| Lk sPi0E e ne s
12 vours VOUT33 K64 Useo Dt e e = FTBBICAND Rl
13 VREGIN VREGIN_KB4 S Ly LPTRD 0sc D
714 ADCO_DP1 1] ADCE_DP1 POBO RCM RTC i~ UARTO_RY
15 ADCO_DML e A some o sPo wooits
16 ADCLDPL i) ADC1 DM st 3P SUPPLY ADCI_SEI8PTON
Ao 00! T o1 e ADE1_SE14PTO10
17 ADCLDMI M e RN B ! PTBRIEPI_PESIF
718 ADCO_DPO/ADC.. 12[5] ADCT_DPDY. Wt WE i [T ADCO_SE134RTBI/.
19 ADCODMO/AD.. 12[7] e \U/:';? YER Peripheral UART3 ke
/X ADCLDPO/ADC.. 12011] e Serial Communication Interface }/
21 ADCI DMO/AD..  12[13] Vs sA Non pin routed 132
V22 VDDA P3V3_K64F MKBAFMNAMOVLL 12 - LAFP 100 patrege J
V23 VREFH VREFH
724 VREFL GND S s eE s
V12 VREF.OUT/CMP.. J2(17]
A2 DACO.OUT/CM.. M11] R g
/B XTALR VILIXTALZZ_F type filter text
/B EXTALR2 VIL2VEXTAL32.
V30 VBAT VBAT Routed Pins for BOARD InitPins 3
El J2[20/UB[41/12¢ = Peripheral  Signal Routeto  Label Identifier Direction  Slewrate  Open drain
:i E[im;ﬁi[slﬁ( Bl uaro RX UARTORX  UPI4JUARTORX  DEBUG_UARTRX Input Fast Disabted
= 19[4]’,5“@[ ]cu( 63 UARTO 1% UARTOTX  UIO[LVUARTOTX  DEBUG_UART_TX Not Specified Fast Disabled
= 11{51‘ = 68 GPIOB GPI0,22  PTB2 DI2[1/LEDRGB_RED LED_RED Not Specified  Fast Disabted
3% N2/ BIEYTR
- mremn ma T i o =
< [an +
&\ Problems 52
type filter text
Level Issue Qrigin Target Resource Type
% Warning Peripheral UARTO is not initialized Pins: BOARD InitPins Peripherals: BOARD InitPeripherals  UARTO Validation
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Please refer to the MCUXpresso IDE Config Tools User Manual for detailed information.

Using the Config Tools

MCUXpresso IDE includes the following Config Tools:

Pins Tool
« allows you to configure pin routing and generates ‘pin_mux.c & .h’ source files
¢ Clocks Tool
« allows you to configure system clocks and generates ‘clock_config.c & .h’ source files
« Peripherals Tool
« allows you to configure other peripherals and generates ‘peripherals.c & .h’ source files
MCUXpresso Config Tools can be used to review or modify the configuration of SDK example

projects or new projects based on SDK 2.x. To open the tool, simply right click on the project in
Project Explorer and select the appropriate Open command:
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=

[ infig Tools # Open Pins

#7 Run C/C++ Code Analysis N Open Clocks

Team ¥ Open Peripherals
Compare With Import Configuration (*.mex)

'Y ¥

Figure 13.2. Config Tools Launch

If the project does not contains any configuration file (.mex) yet, it is automatically created by
importing the existing source files (from YAML comments from pin_mux.c, clock_config.c and/or
peripherals.c). If there are no source files in the project, a default configuration is created. The
configuration is stored in the root of project folder with “.mex” file extension.

13.1.1 Tool Perspectives

Each tool is displayed in separate perspective. Once the configuration is opened, you can switch
between perspectives to review/modify configuration of each tool — using the toolbar on the upper
right part of the IDE window:

B E<®W®

If your workspace contains multiple projects, please be aware that the MCUXpresso Config Tools
only support one configuration to be opened at a time and that configuration must be opened
explicitly for each project using the Open command from the popup menu. Switching perspectives
does not switch the selected configuration.

13.1.2 Ppins Tool

The Pins Tool allows you to display and configure the pins of the MCU. Basic configuration can
be done in either of these views Pins, Peripheral Signals or Package. More advanced settings
(pin electrical features) can be adjusted in Routed Pins view.

13.1.3 Clocks Tool @

The Clocks Tool allows you to display and modify clock sources and outputs settings in Table
view. More advanced settings can be adjusted via Diagram view and Details view. Global settings
of the clocking environment such as run modes, MCG modes and SCG modes can be modified
via main application toolbar.

13.1.4 peripherals Tool @

You can use the Peripherals tool to configure initialization of selected peripherals and generate
code for them. In the Peripherals view, select the peripheral to configure and confirm addition
of the configuration component. Then you can select the mode of the peripheral and configure
the settings within the settings editor.

13.1.5 Generate Code

To update sources in the project, simply hit “Update Project Code” button on the toolbar. The
command opens dialog with list of files that will be re-generated and allows to select which tools
will generate the code.

Alternatively, it is also possible to export select source file by hitting export button in the Sources
view.
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13.1.6 SDK Components

Generated code uses the API of the SDK components to configure peripherals. SDK components
missing in the IDE project are reported in problems view. It is possible to add component into
IDE project by right click on the reported problem and selecting the proposed quick fix.
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14. The GUI Flash Tool

Introduced in MCUXpresso IDE version 10.2.0, the rearchitected GUI Flash tool provides flash
programming capabilities for all supported debug solutions.

As well as implementing seamless programming of Flash when starting a debug session,
MCUXpresso IDE enables the Flash programming capabilities of the supported debug solutions
to be accessed directly, both via the GUI and from the command line (which might be useful for
performing small production runs).

These flash programming capabilities can be accessed from three distinct places with the IDE.

Firstly, the most feature capable (advanced) variant is launched via the IDE button (and will be
described in this section) :

L 20 Ear Ay "8 2k 2 b R A

GUI Flash Tool

Clicking this will launch a dialogue similar to:

Figure 14.1. GUI Flash Tool

[ ] ] GUI Flash Tool
GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes
Program file into flash: MK64FN1MOxxx12_Project.axf

Target: MKE4FN1MOxxx12

Probe Options
Probe specific options

Connect script kinetisconnect.scp B Workspace.. | File System..
Reset Handling Default B
Flash Reset Handling Default ﬂ

Use JTAG Interface Reset the target on connection

Target Operations
Select the target flash operation to perform

lwyasa Resurrect locked Kinstis devica | |

Actions
Select the action to perform

© Program Program (mass erase first)
Verify only Check file areas blank
Options

Select the options to apply

File to program I 1MOxxx12_Project/D: 1MOxxx12_Project.axf | l Workspace. File System.

Format to use for programming () axf bin
Base address

Reset target on completion

General Options
Flash programming tool options

Additional options

Repeat on completion (| Preview command [ Clear console

corcel  (CTEE

MCUXpresso IDE User Guide -

Note: This dialogue will vary subtly for each debug solution.

Secondly, project launch configurations now contain a GUI Flash Tool Tab providing project
specific flash operations. Please see for more information.

Finally, the QuickStart panel Debug Shortcuts provide easy access for simple project flash
programming. Please see for more information.
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14.1 The Advanced GUI Flash Tool

The operations below are supported for each debug solution.

1. Programming an .axf or .bin file into flash

2. Flash Mass Erase

3. Various debug solution specific features

When launched, each debug solution will present a dialogue similar to the LinkServer variant —

described below:

[ BN ) GUI Flash Tool

GUI Flash Tool for:
MCUXpresso IDE LinkServer (inc. CMSIS-DAP) probes

Program file into flash: MK64FN1MOxxx12_Project.axf

Target: MK64FN1MOxxx12

Probe Options
Probe specific options

Connect script kinetisconnect.scp @ ﬂ Workspace... File System...
Reset Handling Default O H
Flash Reset Handling Default O B
Use JTAG Interface Reset the target on connection
Target Operations
elect the target llash operation to perform
[mrase | Resurrect locked Kinetis device
Actions
Select the action to perform
© Program Program (mass erase first)
Verify only Check file areas blank
Options
Select the options to apply
File to program I S(wurkspace_\oc){MK64FN1M(]xxx1Z_Prniecl]Debug[MKﬁaFN1N()xmﬂ?_Pm]énl.axlﬁ Workspace... File System...

Format to use for programming| .

Base address

Reset target on completion

General Options
ash programming 100! options
Additional options .
Repaat on completion Claar console

Figure 14.2. GUI Flash Tool major features

cancel (I
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Note: Probe options (highlighted above) will be different for each debug solution, where as Target
and General Options (also highlighted) will be broadly similar.

Tip

@ A project must first be selected before the Advanced GUI Flash Tool can be
launched. The device and other project configurations (such as flash driver) will be
inherited from this selected project. The advanced GUI Flash tool will not create or
use information within project associated launch configurations.

1. Connect Script: The device default connect script will be automatically selected. A different
connect script can be selected if required using the Workspace or File System shortcut

buttons.

2. Reset Handling: The device default reset handling can be overridden from the selection:

Default, SYSRESETREQ, VECTRESET, SOFT
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3. Flash Reset Handling: The flash drivers default reset handling can be overridden from the
selection: Default, SYSRESETREQ, VECTRESET, SOFT

4. Program/Erase/Resurrect locked Kinetis Device

* Program view (displayed) should be selected to program an application of binary into flash.
Only the Program options will be described below.

e Erase view should be selected for options to erase a flash device to its blank state
« offers options to Mass erase, Erase by sector, Check blank (to verify a blank flash).

< generally flashes do not need to be erased, since program operations automatically erase
sections of the flash as required. However on occasion it can be useful to erase a flash
most often because the image in flash is causing problems.

» Erase by sector is not recommended for Kinetis parts since this will leave the device fully
erased and therefore in a locked state — should this occur, use the option below ...

* Resurrect locked Kinetis device view should be selected to recover a locked device.
5. Programming actions:

* Program: the default action will program the selected application or binary erasing only the
required sections of the flash device.

e Program (mass erase first): will erase the whole device before program the selected
application or binary. This will ensure that any previous flash contents are erased.

« Verify only: this option will compare the contents of flash with the selected application or
binary. Note: most flash programming operations are verified at the programming stage.
Flash contents are not changed.

¢ Check file area blank: this can be used to verify that a program operation will not overwrite
any data already programmed into flash. Flash contents are not changed.

6. File selection: if the selected project contains a built .axf file, then this will automatically be
selected. Alternatively a different file can be selected using the Workspace and File System
shortcut buttons.

7. Format: these radio buttons will be preset by the File to Program type. However, if an .axf file
is selected, clicking bin will automatically generate a .bin from the selected .axf.

« for file types containing no base address information, such as .bin, a base address must
be specified.

8. Preview command: select this option to be presented with a preview programming command
to be issued and a script that can perform this action independently of the IDE (see below)

« the previewed command can be edited if required, changes will be reflected within the script

« various shell script flavours can be selected, and finally the script can be copied to the
clipboard with a single click

Finally, click Run to execute the flash programming operation, a dialogue displaying the success
of the operation will be displayed once the program operation has completed.

Advanced GUI Flash Tool command Preview

As discussed in point 8 above, the GUI Flash Tool can optionally display the command to be
issued — allowing the opportunity of editing the command before execution.
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® e Program file into flash: MKE4FN1MOxxx12_Project.axf

1 Command to be executed...

crt_emu_cm_redlink --flash-load-exec "/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace/
MKGBAFN1MOxxx12_Project/Debug/MKE4FN1MOxxx12_Project.axf" -g --debug 2 --vendor NXP -p
MKB4FN1MOxxx12 --ConnectScript kinetisconnect.scp -ProbeHandle=1 -Corelndex=0 -x /Users/nxp/
mcuxpresso/01/.mcuxpressoide_packages_support/MKE64FN 1MOxxx12_support --flash-dir /Users/nxp/
mecuxpresso/01/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support/Flash

Command to use in a seript

MCUX_WORKSPACE_LOC=/Users/nxp/Documents/MCUXpressolDE_10.2.0/workspace
MCUX_FLASH_DIR=/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/ MKB4FN1MOxxx12_supp
ort/Flash
MCUX_IDE_DIR=/Applications/MCUXpressolDE_10.2.0_740/ide .
MCUX_IDE_BIN=$MCUX_IDE_DIR/bin =l
SMCUX_IDE_BIN/crt_emu_cm_redlink --flash-load-exec (=)
"fUsers/nxp/Documents/MCUXpressolDE_10.2.0/workspace/MKB4FN1MOxxx12_Project/Debug ™ === = ===~
xxx12_Project.axf" -p MK64FN1M0xxx 12 --ConnectScript kinetisconnect.scp -x C Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MK84FN1MOxxx12_support --fl ¥ Bourne Shell
/Users/nxp/mcuxpresso/01/.mcuxpressoide_packages_support/MK64FN1MOxxx12_support/Fla  Powershell
Command Shell

Canicel e

Figure 14.3. GUI Flash Tool Command Preview

In addition to displaying the command to be issued, the dialogue also contains a script that can
be issued independently of the IDE to perform the flash programming operation. Changes the
command to be executed will also be reflected within the script.

Notes

« The script will setup the local environment to be independent of your local shells configuration.
However components of MCUXpresso IDE are of course referenced so the script can only be
used if MCUXpresso IDE is installed and any referenced workspace files are present.

« Debug probes may install drivers when first seen by a host, this driver installation may take
some time to complete.

* MCUXpresso IDE is able to maintain connection to multiple debug probes, while the IDE can
dynamically maintain knowledge of connected probes, any generated commandline will be
a shapshot of a given instance. Therefore it is essential that only a single debug probe is
connected if the command script is to be captured for re-use.

¢ Typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft loaded
automatically by the IDE when a debug operation is first performed. Therefore to use these
debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_link1 for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT
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14.1.2 Advanced GUI Flash Tool logged Output

When a GUI Flash Tool operation is performed, the low level output will be logged into the debug
log. A snippet of a LinkServer successful program operation is shown below:

Loadi ng ' MK64FN1MDxxx12_Proj ect . axf' ELF 0x00000000 | en 0x3CF8
Opening flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Witing 15608 bytes to address 0x00000000 in Fl ash

1of 1 ( 0) Witing pages 0-3 at 0x00000000 with 15608 bytes
( 0) at 00000000: O bytes - 0/15608

( 26) at 00000000: 4096 bytes - 4096/ 15608

( 52) at 00001000: 4096 bytes - 8192/ 15608

( 78) at 00002000: 4096 bytes - 12288/ 15608

(100) at 00003000: 4096 bytes - 16384/ 15608

Erased/ Wote page 0-3 with 15608 bytes in 693nsec

Cl osing flash driver FTFE_ 4K cfx

(100) Finished witing Flash successfully.

Fl ash Wite Done

Loaded Ox3CF8 bytes in 1081ns (about 14kB/s)

Reset target (system

Starting execution using systemreset

14.1.3 Advanced GUI Flash Tool Programming an arbitary Binary

The GUI Flash tool will usually be used to program a binary generated from a Project’s .axf file.
However on occasion, it might be required to program a binary file generated elsewhere. This
can be achieved by generating a project with the required memory/chip conbination and simply
dropping the .bin file into this project. When the GUI Flash tool is invoked, the user can browse
for the required binary file and program this in the usual way.
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15. LinkServer Flash Support

15.1
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Note: Quad SPI (QSPI) and SPIFI are used interchangeably within this section. The term SPIFI
(SPI Flash Interface) is commonly used to reference LPC use of QSPI.

Please refer to the section on for details of the LinkServer debug solution.

MCUXpresso IDE’s LinkServer based debug connections makes use of a RAM loadable Flash
driver mechanism. Such a Flash driver contains the knowledge required to program the internal
Flash on a particular MCU (or potentially, family of MCUs). This knowledge may be either
hardwired into the driver, or some of it may be determined by the driver as it starts up (typically
known as a ‘generic’ Flash driver).

At the time a debug connection is started by MCUXpresso IDE, the LinkServer debug session
running on the host will typically download a Flash driver into RAM on the target MCU. It will
then communicate with the downloaded Flash driver via the debug probe in order to program the
required code and data into the Flash memory.

In addition, the loadable Flash driver mechanism also provides the ability to support Flash drivers
which can be used to program external Flash memory (for instance via the SPIFI Flash memory
interface on LPC18x, LPC40xx, LPC43xx and LPC5460x families). The sources for some of
these drivers is provided in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory.

LinkServer Flash drivers have a .cfx file extension. For Preinstalled MCUs, the Flash driver
used for each part/family will be located in the /bin/Flash subdirectory of the MCUXpresso IDE
installation. For SDK installed MCUs, the Flash driver will generally be supplied within the SDK,
although copies may also provided in the /bin/Flash subdirectory.

Important Note: LinkServer flash drivers are fully integrated into the MCUXpresso IDE Managed
Linkerscript build mechanism and specified within SDK metadata. Other debug solutions invoke
MCU specific flash programming strategies based on their debug implementation’s knowledge
of the MCU being debugged.

Default vs Per-Region Flash Drivers

By default, for legacy reasons, Preinstalled MCUs are configured to use what is called a ‘Default’
Flash driver. This means that this Flash driver will be used for all Flash memory blocks that are
defined for that MCU (i.e. as displayed in the Memory Configuration Editor).

For most users, there is never any need to change the automatically selected Flash driver for
the MCU being programmed.

However, MCUXpresso IDE also supports the creation and programming of projects that span
multiple Flash devices. In order to allow this to work, Flash drivers can also be specified per
memory region.

For example, this allows a project based on an LPC43xx device with internal Flash to also make
use of an external SPIFI Flash device. This is achieved by removing the default Flash driver from
the memory configuration and instead explicitly specifying the Flash driver to use for each Flash
memory block (per-region Flash drivers). A typical use case could be to create an application
to run from the MCU'’s internal Flash that makes use of static constant data (e.g. for graphics)
stored in external SPIFI device. An example memory configuration is shown below:
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Figure 15.1. Per Region Drivers

‘@ MCUXpresso IDE

Memory configuration editor
Edit configuration for LPC4337 m

Memory configuration

Default flash driver Browse...

Type MName Alias Location Size Driver -
Flash MFlashA512 Flash 0Ox1a000000 Ox80000] LPC18x7_43x7_2x512_BootA.c v
Flash MFlashB512 Flash2 Ox1b000000 Ox80000] LPC18x7_43x7_2x512_BootA.c
Flash Flash_SPIFI Flash3 Ox14000000 O0x10000@ LPC18_43_SPIFI_GENERIC.cfx

RAM RamLoc3Z RAM  Ox10000000 OxBO0O
RAM RamLoc40 RAM2 Ox10080000 0xaO00
RAM RamAHB32 RAM3 0x20000000 0x8000
RAM RamAHB16 RAM4 Ox20008000 Ox4000

!'_E |

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

cancel (TSN

15.2

15.2.1
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Note: SDK installed MCUs always use Per-Region Flash drivers.

Advanced Flash Drivers

Most wizard generated projects or projects imported from SDKs (or LPCOpen) will be pre-
configured with an appropriate LinkServer flash driver for the target flash device. As a result,
in many cases users need to pay little attention to the actual flash driver being used. However,
for MCUs supporting complex flash strategies or external flash devices, the situation is more
complex. This section discusses these situations but note, even in these cases, the flash driver
may be automatically selected and so require no user attention.

LPC18xx / LPC43xx Internal Flash Drivers

A number of LPC18/43 parts provide dual banks of internal Flash, with bank A starting at address
0x1A000000, and bank B starting at address 0x1B000000.

* LPC18x3/LPC43x3 : Flash = 2x 256KB (512 KB total)
* LPC18x5/ LPC43x5 : Fl ash 2x 384KB (768 KB total)
* LPC18x7/LPCA3x7 : Flash = 2x 512KB ( 1 MB total)

When you create a new project using the New Project Wizard for one of these
parts, an appropriate default Flash driver (from LPC18x3 43x3 2x256 BootA.cfx /
LPC18x5_43x5 2x384 BootA.cfx /LPC18x7_43x7_2x512_ BootA.cfx) will be selected which
after programming the part will also configure it to boot from Bank A Flash.

If you wish to boot from Bank B Flash instead, then you will need to manually configure the
project to use the corresponding “BootB” Flash driver ( LPC18x3_43x3_2x256_BootB.cfx /
LPC18x5_43x5_2x384 BootB.cfx / LPC18x7_43x7_2x512_BootB.cfx). This can be done by
selecting the appropriate driver file in the “Flash driver” field of the Memory Configuration Editor.
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15.2.2

Note: you will also need to delete Flash Bank A from the list of available memories (or at least
reorder so that Flash Bank B is first).

LPC SPIFI QSPI Flash Drivers

A number of parts provide support for external SPIFI Flash, sometimes in addition to internal
Flash. Programming these Flash memories provides a number of challenges because the size
of memory (if present) is unknown, and the actual memory device is also unknown. These issues
are handled using Generic Drivers which can interrogate the memory device to find its size and
programming requirements.

At the time of writing, these LPC devices comprise:

Table 15.1. SPIFI details

LPC Part SPIFI Address Bootable Flash Driver
LPC18xx/LPC43xx  0x14000000 Yes LPC18_43_SPIFI_GENERIC.cfx
LPC40xx 0x28000000 No LPC40xx_SPIFI_GENERIC.cfx
LPC5460x 0x10000000 No LPC5460x_SPIFI_GENERIC.cfx
LPC540xx 0x10000000 Yes LPC540xx_SPIFI_GENERIC.cfx

MCUXpresso IDE User Guide -

During a programming operation, the Flash driver will interrogate the SPIFI Flash device to
identify its configuration. If the device is recognised, its size and name will be reported in the
MCUXpresso IDE Debug log - as below:

I nspected v.2 External Flash Device on SPI using SPIFl |ib LPC18_43_SPI Fl _GENERI C. cf x
| mage ' LPC18/43 Generic SPIFI Mar 7 2017 13:14:25'

Openi ng flash driver LPC18_43_SPI FI _GENERI C. cf x

flash variant ' MX25L8035E detected (1MB = 16*64K at 0x14000000)

Note: Although the Flash driver reports the size and location of the SPIFI device, the IDE’s view
of the world is determined by the project memory configuration settings. It remains the users
responsibility to ensure these setting match the actual device in use.

Flash devices supported by our LPC SPIFI Flash Drivers

Below is a list of SPIFI Flash devices supported by our supplied Generic SPIFI Flash drivers.
Note: additional devices which identify as one of the devices below are also expected to work.
However if a device is not supported by our supplied Flash Drivers, sources to generate these
drivers are supplied in the Examples/Flashdrivers subdirectory within the MCUXpresso IDE
installation directory. Users may thus add support for new SPIFI devices if needed.

@25@B2C
MI25QL128AB
MI25Q512A
MI25@56A
N25Q256
N25Q128
N25Q64
N25Q82
PM25LQV32C
MX25L1606E
MX25L1635E
MX251.3235E
MX25R6435F
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15.2.3

MX25L6435E
MX25L12835E
MX25V8035F
MX25L8035E
S25FL016K
S25FL032P
S25FL064P
S25FL129P 64kSec
S25FL129P 256kSec
S25FL164K
S25FL256S 64kSec
S25FL256S 256kSec
S25FL512S
VR5Q40CV
VR5Q@B2FV
VR5Q64FV
V25Q128FV
VW5QR56FV_Unt est ed
V25QB0BV

i.MX RT QSPI and Hyper Flash Drivers

I.MX.RT MCUs support external flash via a QSPI/Hyperbus interface, a range of LinkServer flash
drivers supporting devices fitted to EVK development boards are included with MCUXpresso IDE
version 10.3 (as described below).

Note: these drivers are also supplied in source project form so they may be used as a base
for development of drivers for other external flash parts. These driver projects can be found at
Examples/Flashdrivers/NXP/iIMXRT

Table 15.2. Flash details

iMX RT Part

i.MX RT 1050
i.MX RT 1050
i.MX RT 1050
i.MX RT 1020

Base Address Bootable Flash Driver

0x6000000 Yes MIMXRT1050-EVK_S26KS512S.cfx
0x6000000 Yes MIMXRT1050-EVK_1S25WP064A.cfx
0x6000000 Yes MIMXRT1050-EcoXiP_ATXP032.cfx
0x6000000 Yes MIMXRT1020-EVK_1S25LP064.cfx
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When used with the approriate SDK for your development board, the correct driver will
be automatically selected

Important Note: For an application to Boot and execute in place (XIP) from these flash devices
(post reset), a correct header for the specific device MUST be programmed into the flash
(as part of the Project). SDK examples will build to include an approriate header automatically
however, MCUXpresso IDE will not prevent users programming projects without headers into
these devices. If this occurs the application will not boot and susequent flash programming
operations may fail.

Should this occur, the recommended recovery procedure is to change the boards boot strategy
(via DIP switches) to prevent booting from QSPI or hyperflash. Power cycle the board and then
perform a Mass Erase of the flash. Next, reprogram with an image that has appropriate header,
restore the boot strategy and power cycle again.

Tip
@ In addition, these drivers are complemented by a range of self configuring drivers
supporting all current iMX RT EVK boards , please see

for more information on the drivers and this methodology.

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.3.0 — 16 November, 2018 132



NXP Semiconductors MCUXpresso IDE User Guide

15.2.4

Flash Drivers using SFDP protocol (LPC and iMX RT)

As discussed above, the programming these Flash memories provides a number of challenges
because the size of memory (if present) is unknown, and the actual memory device is also
unknown

LinkServer Generic flash drivers attempted to solve this problem by recognising specific devices
(via their JEDEC ID) and then setting their sizes and programming parameters accordingly.
However, this mechanism only works if the device is recognised by the flash driver, and in
consequence will fail if any device is not recognised.

This issue, combined with the sheer volume of devices available has forced a different approach
to be taken. Fortunately, modern flash devices typically contain a data block describing their
properties including device size, low level structure and programming details etc. These data
blocks and their use are collectively known as Serial Flash Discovery Protocol or SFDP. The
standard for these blocks are described by JEDEC JESD216 standard(s).

Introduced in MCUXpresso IDE version 10.2.0 are a range of Generic flash drivers built to self
configure via SFDP data and these have been extended for MCUXpresso IDE version 10.3. The
current list of supported SFDP drivers is shown below:

Table 15.3. SFDP Flash details

Part Base Address Bootable Flash Driver

LPC18xx/LPC43xx 0x14000000 Yes LPC18 43 SPIFI_SFDP.cfx

LPC5460x 0x10000000 No LPC546x_SPIFI_SFDP.cfx

LPC540xx 0x10000000 Yes LPC540xx_SPIFI_SFDP.cfx

i.MX RT 1064 0x7000000 Yes MIMXRT1064.cfx

i.MX RT 1060 0x6000000 Yes MIMXRT1060_SFDP_HYPERFLASH.cfx
i.MX RT 1060 0x6000000 Yes MIMXRT1060_SFDP_QSPI.cfx

i.MX RT 1050 0x6000000 Yes MIMXRT1050_ SFDP_HYPERFLASH.cfx
i.MX RT 1050 0x6000000 Yes MIMXRT1050_ SFDP_QSPI.cfx

i.MX RT 1020 0x6000000 Yes MIMXRT1020_SFDP_QSPI.cfx
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Note: for IMX RT parts, the SFDP drivers cannot detect whether QSPI or Hyperflash is fitted,
therefore it is the responsibility of the user to ensure the correct driver is used — typically however,
the SDK will automatically select and use the correct driver.

Note: The IMX RT 1064 MCU incorporates a flash device within the MCU package itself however,
the flash driver still uses the SFDP mechanism to detect the device and hence is listed in the
table above.

QSPI SFDP issues and Limitations

Some (usually older) QSPI parts do not support the SFDP mechanism and therefore will not be
programmable via this protocol. However since some of these QSPI devices are fitted to NXP
(LPC) manufactured development boards, some basic assumptions are made by these drivers
if SFDP data is not found. In such a case, the device and its size will be assumed to be 1MB and
some standard programming mechanisms will be used. This scheme should ensure that NXP
LPC development boards with QSPI can be used with this driver type.

Note: this information is correct at the time of writing and only applies to LPC Drivers — future
development of these drivers may change their capabilities.

Flash programming log

When programming code or data into flash, a portion of the debug log will display the flash
programming operations (as below):

I nspected v.2 External Flash Device on SPl using SFDP JEDEC | D LPC18_43_SPI FI _SFDP. cfx —(1)
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I mage ' LPC1843_JEDEC SFDP May 1 2018 15:32:05'

Opening flash driver LPC18_43_SPIFI _SFDP. cfX  --------mmmmmm i (2)
Sendi ng VECTRESET to run flash driver
flash variant 'JEDEC SFDP_EF4014' detected (1MB = 16*64K at 0x14000000) ---------------- (3)

Cl osing flash driver LPC18_43_SPI Fl _SFDP. cf x
NXP: LPC43S37

Connected: was_reset=true. was_stopped=fal se
Awai ting telnet connection to port 3330 ...
GDB nonst op node enabl ed

Opening flash driver LPC18_43_SPIFI _SFDP.cfx (already resident) -------------ommmmmonoon (4)
Sendi ng VECTRESET to run flash driver

Witing 1046900 bytes to address 0x14000000 in Flash ---------ccmmmmmmmm o (5)
Erased/ Wote page 0-15 with 1046900 bytes in 7548MBEC -------------mmmmmmmmm o (6)

Cl osing flash driver LPC18_43_SPI Fl _SFDP. cf x

Fl ash Wite Done

Fl ash Program Sunmary: 1046900 bytes in 7.55 seconds (135.45 KB/seC) ------------------- (7)
St opped: Breakpoint #1

Note: when accessing unknown flash devices, the driver will be called twice. First to identify the
device and secondly to perform the required programming. In a situation where multiple devices
are being programmed, the flash driver(s) may be (re)loaded for each use.

Where:

1. SFDP JEDEC ID is the method used to access the flash and LPC18_43_ SPIFI_SFDP.cfx is
the flash driver used
2. the driver named above is loaded and initialised (this step will setup clocks, pin muxing, and
perform some investigation of the connected device)
3. the driver returns a string JEDEC_SFDP indicating that SFDP data was found and successfully
read
» the devices JEDEC ID was read as EF4014, in this case corresponding to a Winbond
25Q80DVSIG (as fitted to the LPC-Link2 board used in Target mode)
 the devices size was read as 1MB divided up into 16 64KB Sectors/Blocks — these blocks
are the erase size that will be used for programming and so any operation to program this
flash must start on an address aligned to this 64KB size
4. the driver is opened a second time (without reloading since it remains from the previous call)
5. the project that referenced this driver requested that 1046900 bytes of data were written to
the address starting 0x14000000, as set within the projects memory configuration
6. the write operation is performed via 16 page writes
« Note: this flash driver (like many LinkServer drivers) uses a virtual page size that is much
larger than the actual flash device page size to optimise driver operation
7. finally, a summary of the operation is printed showing the flash programming performance

Note: If the driver fails to find SFDP data, it will attempt to program the device with standard
routines. If this occurs, the size will be assumed to be 1MB and the flash variant will be reported
as ID rather than SFDP as shown below:

flash variant ' JEDEC | D EF4014' detected (1MB = 16*64K at 0x14000000)

On occasion, some devices that report the same JEDEC ID will actually be different, in this
particular case the device is a very similar Winbond 25Q80BVSIG i.e. ..BV rather than ..DV

QSPI Programming and Booting

When dealing with external flash, it is important to understand the difference between the
flash programming operation performed by the flash driver and the subsequent use of the
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flash for executing code and/or providing data. Essentially the flash drivers responsibility ends
with a successful program operation, after this point, correct operation of the MCU/SPI flash
combination lies elsewhere.

Thus, once the MCU is reset (or power cycled), the responsibility for the devices configuration and
operation lie entirely outside of MCUXpresso IDE and instead lie with one or all of the following:

» development board/MCU boot settings
« these may be DIP switches or Jumpers providing inputs to the MCU boot flow, alternatively
these could be OTP bits programmed within the MCU
*« MCU’s BootROMs ability to understand and setup the device

* BootROMs on devices such as the LPC1800 and LPC4300 have inbuilt understanding of
certain QSPI devices allowing them to be configured for boot. However, this boot process
may fail with some QSPI flash despite the fact that it has been correctly programmed

* BootROMs on devices such as the LPC540xx and RT10xx rely on correct header (XIP)
information being programmed (as part of the Application) into the QSPI flash itself. If this
data is incorrect (or not present), the boot/reset will fail.

¢ Devices that incorporate both internal boot flash and external SPIFI/QSPI flash such as the
LPC546xx typically place the responsibilities for QSPI configuration to the users application,
where this might include

e Setup of pinmuxing
e QSPI/SPIFI clock setup
 Flash interface initialisation
* QSPI initialisation (this may be QSPI device specific)
* including setup of appropriate waitstates for QSPI operation at the selected QSPI clock
frequency

Kinetis Flash Drivers

Kinetis MCUs make use of a range of generic drivers, which are supplied as part of the SDK
part support package. When a project is created or imported, the appropriate Flash driver is
automatically selected and associated with the project.

Kinetis Flash drivers generally follow a simple naming convention i.e. FTFx_nK_xx where:

¢ FTFx is the Flash module name of the MCU, where x can take the value E, A or L

¢ nK represents the Flash sector size the Flash device supports, where n can take the value
1,2,4,8
* a sector size is the smallest amount of Flash that can be erased on that device

e XX represents an optional additional characters for special case drivers e.g. __ Tiny for use on
parts with a small quantity of RAM

« an further optional _D suffix is used to show the driver is written to target Data Flash rather
than the more common Program Flash

So for example a K64F MCU's Flash driver will be called FTFE_4K, because the K64F MCU
uses the FTFE Flash module type and support a 4KB Flash sector size.

When a debug session is started that programs data into Flash memory, the IDE’s debug log
file will report the Flash driver used and parameters it has read from the MCU. Below we can
see the driver identified a K64 part and the size of the internal Flash available. It also reports the
programming speed achieved when programming this device. These logs can be useful when
problems are encountered.

Note: when the Flash driver starts up, it will interrogate the MCU and report a number of data
items. However, due to the nature of internal registers with the MCU, these may not exactly
match the MCU being debugged.
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Inspected v.2 On chip Kinetis Flash nmenory nodul e FTFE_4K. cf x

I mage ' Kinetis Sem Generic Feb 17 2017 17:24:02'

Openi ng flash driver FTFE 4K cf x

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Cl osing flash driver FTFE 4K cfx

Connect ed: was_reset=true. was_stopped=true

Awai ting tel net connection to port 3330 ...

GDB nonst op node enabl ed

Openi ng flash driver FTFE 4K cfx (already resident)

Sendi ng VECTRESET to run flash driver

Fl ash variant 'K 64 FTFE Generic 4K detected (1MB = 256*4K at 0x0)
Witing 25856 bytes to address 0x00000000 in Fl ash

00001000 done 15% (4096 out of 25856)

00002000 done 31% (8192 out of 25856)

00003000 done 47% (12288 out of 25856)

00004000 done 63% (16384 out of 25856)

00005000 done 79% (20480 out of 25856)

00006000 done 95% (24576 out of 25856)

00007000 done 100% (28672 out of 25856)

Erased/ Wote sector 0-6 with 25856 bytes in 301lnsec

Cl osing flash driver FTFE 4K cfx

Fl ash Wite Done

Fl ash Program Sunmary: 25856 bytes in 0.30 seconds (83.89 KB/ sec)

Flash drivers for a number of Kinetis MCUs are listed below:

K64F FTFE_4K (1MB)

K22F FTFA 2K (512KB)
KL43 FTFA_1K (256KB)
KL27 FTFA_1K (64KB)
K40  FTFL_2K (256KB)

Configuring projects to span multiple Flash Devices

https://community.nxp.com/thread/388979

The LinkServer GUI Flash Programmer

The LinkServer GUI Flash Programmer has been replaced by the debug solution independent

The LinkServer Command Line Flash Programmer

While the information below is still current, for most users this functionality has been replaced
by features within the

Command Line Programming

Flash programming is usually invoked automatically when a debug session is launched from
within MCUXpresso IDE, but flash programming operations can also be accessed directly using
a command line utility (also known as the LinkServer debug stub). This can be useful for things
like programming the Flash for devices with limited production runs.

The MCUXpresso IDE Flash programming utility is located at:
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<install _dir>/ide/bin/

To run a Flash programming operation from the command line, the correct Flash utility stub for
your part should be called with appropriate options. For boards containing Cortex-M MCUs the
utility is called crt_emu_cm_redlink.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-load "LPC11U68_App. axf"

will load the AXF file LPC11U68 App.axf into Flash on an LPC11U68.

Note: typically, LPC-Link2 or LPCXpresso V2 and V3 boards have debug probe firmware soft
loaded automatically by the IDE when a debug operation is first performed. Therefore to use
these debug probes from the command line they must either have their firmware softloaded or
have probe firmware programmed into the Flash. Probe firmware can be soft-loaded from the
command line by use of scripts boot_linkl for LPC-Link and boot_link2 for LPC-Link2, these
are located at mcuxpresso_install_dir/ide/bin. To program debug probe firmware into the Flash
memory of an LPC-Link2 debug probe, please see: http://www.nxp.com/LPCSCRYPT

Programming an image into Flash

In the simplest case the Flash programming utility takes the following options if the file to be
flashed is an AXF (or ELF) file:

crt_emu_cmredlink -p target --flash-load "filename" [--flash-driver "flashdriver"]

it is also possible to flash binary files using:

crt_emu_cmredlink -p target --flash-l1oad "fil ename" --1o0ad-base base_address [--flash-driver /

"flashdriver"]

Where:

e crt_emu_cm_redlink is the name of the Flash utility

 target is the target chip name. For example LPC1343, LPC1114/301, LPC1768 etc. (see
‘Finding Correct Parameters...” below)

« --flash-load can actually be one of a few different options. Use:
» --flash-load to write the file to Flash,
» --flash-load-exec to write it to Flash and then cause it to start running,
» --flash-mass-load to erase the Flash and then write the file to the Flash, and

» --flash-mass-load-exec to erase the Flash, write the file to Flash and then cause it to start
running.
« filename is the file to Flash program. It may be an executable (axf) or a binary (bin) file. If using
a binary file, the base_address also must be specified. Using enclosing quotes is optional
unless the name includes unusual characters or spaces.

* base_address is the address where the binary file will be written. It can be specified as a hex
value with a leading Ox.

If you are using Flash memory that is external to the main chip you will need to specify an
appropriate Flash driver that supports the device. This usually takes the name of a .cfx file held
in a default location. In unusual circumstances it is possible to specify an absolute file system
name of a file. Using enclosing quotes is optional unless the name includes unusual characters
or spaces (see ‘Finding Correct Parameters...” below).
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WARNING: When crt_emu_cm_redlink Flash drivers program data that they believe will form
the start of an execute-in-place image they determine where the image’s vector table is and
automatically inserts a checksum of the initial few vectors, as required in many LPC parts. This
may not be the value held in that location by the file from which the Flash was programmed. This
means that if the content of the Flash were to be compared against the file a difference at that
specific location may be found.

WARNING: Flash is programmed in sectors. The sizes and distributions of Flash sectors is
determined by the Flash device used. Data is programmed in separate contiguous blocks — there
may be many contiguous blocks of data specified in an EFL (.AXF) file but there is only one in
a binary file. When a contiguous data block is programmed into Flash data preceding the block
start in its Flash sector is preserved. Data following data in the block in the final sector, however
is erased.

Programming Flash with SDK Part Support

The above method works for parts supported with preinstalled part support. If SDK part support
is required, then additional options must be passed to the utility.

e sdk_parts_directory - the place where the utility can find SDK part information; and
« sdk_flash_directory - the place where the utility can find Flash drivers provided by the SDK.

These are supplied to the utility by adding the following two options

-x "sdk_parts_directory" --flash-dir "sdk_flash_directory"

on to the command line already described. For example:

crt_emu_cmredlink -p LPC54018 --flash-1oad "LPC54018_app. axf" \
-x ~/ mcuxpresso/ 01/ . ncuxpr essoi de_packages_support/LPC54018_support \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash

Since this is quite a lot to type you might wish to put the location of your SDK support directory
into an environment variable as follows:

Windows:

set DIR_SDK ...\ ntuxpresso\01l\. ntuxpressoi de_packages_support\ LPC54018_support
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x %O R_SDK% \
--flash-dir %O R _SDK% Fl ash

MacOS or Linux:

export DI R_SDK="~/.nctuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support"
crt_emu_cmredlink -p LPC54018 --flash-load "LPC54018_app. axf" -x $DI R_SDK \
--flash-dir $D R_SDK/ Fl ash

Use “Finding Correct Parameters from MCUXpresso IDE”, below, to determine what values you
require for these options.

Programming Flash taking MCUXpresso IDE project Memory edits into Account

MCUXpresso IDE allows the user to modify the default definition of the memory areas (including
the specification of different named Flash regions) used in a hardware using the Edit... button
found in the project’s properties at C/C++Build -> MCU Settings under the heading “Memory
details”. The editor can create multiple named Flash regions.
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In order to use these updates to the project’s part information the utility must use the directory
where MCUXpresso IDE stores the project’s products for whatever configuration has been
modified (typically the configuration will be called ‘Debug’) as the source of its part information.

To find the location of this directory in MCUXpresso expand the project in the Project Editor view,
select the directory with the required configuration name (e.g. ‘Debug’), right click on it to bring
up its properties and see the ‘Resource’ heading.

Supply this directory name as the sdk_parts_directory to the utility by adding the options:

-x "sdk_parts_directory"

Even if the part is supported by an SDK this will be the correct option to use for -x.
Programming Flash for complex debug connections

Some boards or chips occasionally need additional steps to occur before a stable debug
connection can be established. Such debug connections are set up by small BASIC like programs
called Connect Scripts. A good indication as to whether your chip or board normally requires a
connect script can be discovered when “Finding Correct Parameters from MCUXpresso IDE” (see
below).

Connect scripts are distributed within the product and do not normally need to be written from
scratch.

If a connect script is required it can be supplied by adding the following option to the command
line already described:

--connectscript "connectscript”

If you are using --flash-load-exec rather than --flash-load you may also find that the part that you
are using requires its own “reset script” to replace the standard means of starting the execution of
the flashed image. Again you may discover whether one is necessary as below. When required
it can be supplied by adding the following option to the command line:

--resetscript "resetscript"

(As usual the quotes are required only if the script file name contains a space or other unprintable
character.)

Finding the correct parameters from MCUXpresso IDE

Note: A simple way of finding the correct command and options is to use the GUI Flash
Programmer described above, the completion dialog shows the exact command line invoked by
the GUI. On this line the IDE will have chosen the correct

 target name

« a default Flash driver, flashdriver

e aconnect script to be run, if needed

« aresetscript to be run, if needed with --flash-load-exec

¢ an sdk_parts_directory where XML information about the part being used (if it is provided via
an SDK) can be found

« an sdk_flash_directory where flash drivers supporting the part being used (if it is provided via
an SDK) can be found

Note: that the details will only appear and be relevant only if a project supporting the relevant
chip or board is selected in the project explorer view.

For example the command line produced might be:
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crt_emu_cmredlink "/Wrkspace/frdnk64f_driver_exanpl es_blinky.axf" -g --debug 2 --vendor NXP \
-p MK64FN1MDxxx12 - ProbeHandl e=1 - Corel ndex=0 -- Connect Scri pt ki netisconnect.scp -x \
/ User s/ nxp/ ncuxpr esso/ 01/ . ncuxpr essoi de_packages_support / MK64FNLMOxxx12_support --flash-dir \

/ User s/ nxp/ ncuxpr esso/ 01/ . ntuxpr essoi de_packages_support/ MK64FNLMOxxx12_support/ Fl ash

Looking at this the target name follows -p; the flashdriver follows --flash-driver; a connectscript
follows --connectscript; a resetscript follows --resetscript; any sdk_flash_directory is provided
following --flash-dir and any sdk_parts_directory is provided following -x.

If the target does not require a connect script or reset script the relevant options will not appear.
If the project is not based on an SDK -x and --flash-dir do not appear.

Dealing with Errors during Flash operations

If your board requires a connect script to be run in order to provide a stable environment for Flash
drivers you may see errors when you undertake a Flash operation without using it. You can use
‘Finding Correct Parameters from MCUXpresso IDE’, above, to check whether a connect script
is required.

On some boards it is possible to run an image which is incompatible with the Flash driver (which
crt_emu_cm_redlink runs on the target to help it manipulate a Flash device). This incompatibility
is likely to show in the form of programming errors signalled as the operation progresses. Often
they are due to unmaskable exceptions (such as watchdog timers) being used by the previous
image that interfere with a Flash driver's operation.

There are a number of ways to address this situation:

¢ Does your board support In System Processing (ISP) Reset? Using it will usually reset the
hardware and stop in the Boot ROM, thus ensuring a stable environment for Flash drivers. If
present it can usually be activated with one or more on-board switches. You may have to refer
to the board’s documentation.

¢ Use the --vc option with crt_emu_cm_redlink. This option causes a reset when the utility’s
connection to the board’s debug port is established. Most chips will be left having executed
part of the Boot ROM and usually the resulting state is suitable for running a Flash driver.
(There are exceptions however.)

¢ Erase the contents of Flash (see below) or program a (e.g. small) image that ensures no non-
maskable exceptions are involved. Naturally these solutions have the problem that they are as
likely to fail (and for the same reason) as the programming operation. It is sometimes the case
that an incompatible image will allow the Flash drivers to operate for a short period in which
there is a chance that one of these ‘solutions’ can be used.

Validating the Content of Flash

The Flash programming utility can validate the content of Flash programmed as an AXF (or ELF)
file:

crt_emu_cmredlink -p target --flash-verify "filename" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-verify "filenane" --I|oad-base base_address \

[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:
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crt_emu_cmredlink -p LPC11U68 --flash-verify "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.

Erasing the Flash

The Flash programming utility can also delete the content of Flash. To do so it takes the following
options:

crt_emu_cmredlink -p target --flash-nmass-erase [--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --fl ash-nmass-erase

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Validating that Flash has been Erased

The Flash programming utility can validate that the content of Flash has been erased:

crt_emu_cmredlink -p target --flash-check --area flash " [--flash-driver "flashdriver"]

For example:

crt_emu_cmredlink -p LPC11U68 --flash-check --area flash

It is also possible to check that just the specific areas that would have been programmed by a
given AXF or binary file are blank.

crt_emu_cmredlink -p target --flash-check-file "filenane" [--flash-driver "flashdriver"]

it is also possible to verify binary files using:

crt_emu_cmredlink -p target --flash-check-file "fil ename" --1oad-base base_address \

[--flash-driver "flashdriver"]

Where target and Flash driver have the same meaning as above.

For example:

crt_emu_cmredlink -p LPC11U68 --flash-check-file "LPC11U68_App. axf"

Note: the issues described in ‘Dealing with Errors During Flash Operation’ still apply when
executing this command.)

Examples
To load the binary executable file app.bin at location 0 on an LPC54113J128 target using LPC-

Link2, use the following command line:
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crt_emu_cmredlink -p LPC54113J128 --1o0ad-base 0 --flash-1oad-exec app.bin

To load the executable file app.axf and start it executing on an LPC1768 target using LPC-Link2,
use:

crt_emu_cmredlink -p LPC1768 --flash-1o0ad-exec "app. axf"

To erase Flash, program the executable app.axf into an LPC18S37 board, which has no internal
Flash but supports external Flash on the board, and then run it:

crt_emu_cmredlink -p LPC18S37 --flash-nmass-1oad-exec "app.axf" --flash-driver \
LPC18x7_43x7_2x512_Boot A. cf x

To erase then program app.axf into a Kinetis MK64FN1MOxxx12, which is supported through an
SDK, and requirings a connect script (on MacOS/Linux):

crt_emu_cmredlink -p MK64FNIMDxxx12 --flash-nass-1oad "app.axf" \
--connectscript kinetisconnect.scp \
-x ~/ mcuxpresso/ 01/ . ntuxpr essoi de_packages_support/ MK64FNLIMOxxx12_support \
--flash-dir ~/ ntuxpresso/ 01/ . ncuxpressoi de_packages_support/ MK64FN1IM)xxx12_support/ Fl ash

To delete the Flash on an LPC1343:

crt_emu_cmredlink -p LPC1343 --flash-nass-erase

To delete the Flash on an LPC54113J128 using vector catch to ensure that the currently booted
code does not interfere with the Flash driver:

crt_emu_cmredlink -p LPC54113J128 --fl ash-erase --vc

To check that the Flash is blank on an LPC54018 which is supported by an SDK and which
has modified its memory layout stored in the MCUXpresso SDK example project held at ~/ws/
Ipcxpresso54018 driver_examples_gpio_gpio_led_output:

crt_emu_cmredlink -p LPC54018 --flash-check -x \
~/ws/ | pcxpresso54018_dri ver _exanpl es_gpi o_gpi o_| ed_out put/ Debug \
--flash-dir ~/ ncuxpresso/ 01/ . ncuxpressoi de_packages_support/LPC54018_support/Fl ash
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MCUXpresso IDE ships with three different C/C++ library families. This provides the maximum
possible flexibility in balancing code size and library functionality.

Overview of Redlib, Newlib and NewlibNano

¢ Redlib Our own (non-GNU) ISO C90 standard C library, with some C99 extensions.
¢ Newlib GNU C/C++ library
« NewlibNano a version of the GNU C/C++ library optimized for embedded.

By default, MCUXpresso IDE will use Redlib for C projects, NewlibNano for SDK C++ projects,
and Newlib for C++ projects for preinstalled MCUs.

Newlib provides complete C99 and C++ library support at the expense of a larger (in some cases,
much larger) code size in your application.

NewlibNano was produced as part of ARM’s “GNU Tools for ARM Embedded Processors”
initiative in order to provide a version of Newlib focused on code size. Using NewlibNano can
help dramatically reduce the size of your application compared to using the standard version of
Newlib — for both C and C++ projects.

If you need a smaller application size and don't need the additional functionality of the C99 or C+
+ libraries, we recommend the use of Redlib, which can often produce much smaller applications.

Redlib extensions to C90

Although Redlib is basically a C90 standard C library, it does implement a number of extensions,
including some from the C99 specification. These include:

 Single precision math functions
 Single precision implementations of some of the math.h functions such as sinf() and cosf()
are provided.
 stdbool.h
* An implementation of the C99 stdbool.h header is provided.
* itoa
« itoa() is non-standard library function which is provided in many other toolchains to convert
an integer to a string. To ease porting, an implementation of this function is provided,
accessible via stdlib.h. More details can be found later in this chapter.

Newlib vs NewlibNano

Differences between Newlib and NewlibNano include:

« NewlibNano is optimized for size.

¢ The printf and scanf family of routines have been re-implemented in NewlibNano to remove
a direct dependency on the floating-point input/output handling code. Projects that need to
handle floating-point values using these functions must now explicitly request the feature
during linking.

e The printf and scanf family of routines in NewlibNano support only conversion specifiers
defined in C89 standard. This provides a good balance between small memory footprint and
full feature formatted input/output.

* NewlibNano removes the now redundant integer-only implementations of the printf/scanf
family of routines (iprintf/iscanf, etc). These functions now alias the standard routines.

¢ In NewlibNano, only unwritten buffered data is flushed on exit. Open streams are not closed.

« In NewlibNano, the dynamic memory allocator has been re-implemented
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Library Variants

Each C library family is provided in a number of different variants : None, Nohost and Nohost-nf,
Semihost and Semihost-nf (Redlib only). These variants each provide a different set of ‘stubs’
that form the very bottom of the C library and include certain low-level functions used by other
functions in the library.

Each variant has a differing set of these stubs, and hence provides differing levels of functionality:

¢ Semihost(-mb)
 This library variant provides implementation of all functions, including file I1/0. The file 1/O will
be directed through the debugger and will be performed on the host system (semihosting).
For example, printf/scanf will use the debugger console window and fread/fwrite will operate
on files on the host system. Note: emulated I/O is relatively slow and can only be used when
debugging.
¢ Semihost(-mb)-nf (no files)
« Redlib only. Similar to Semihost, but only provides support for the 3 standard built-in streams
— stdin, stdout, stderr. This reduces the memory overhead required for the data structures
used by streams, but means that the user application cannot open and use files, though
generally this is not a problem for embedded applications.
¢ Nohost and Nohost-nf
 This library variant provides the string and memory handling functions and some file-based
I/O functions. However, it assumes that you have no debugging host system, thus any file
I/0 will do nothing. However, it is possible for the user to provide their own implementations
of some of these 1/O functions, for example to redirect output to the UART.
* None
e This has literally no stub and has the smallest memory footprint. It excludes low-level
functions for all file-based 1/0 and some string and memory handling functions.

Note: -mb library variants are not selected by default durung any wizard project creation however
they may optionally be selected for enhanced semihost performance with the penalty of slightly
larger RAM usage. Please see for additional information.

In many embedded microcontroller applications it is possible to use the None variant by careful
use of the C library, for instance avoiding calls to printf().

If you are using the wrong library variant, then you will see build errors of the form:

* Linker error "Undefined reference to ‘xxx

For example for a project linking against Redlib(None) but using printf() :

...libcr_c.a(fpprintf.o):

In function “printf':

fpprintf.c:(.text.printf+0x38):
fpprintf.c:(.text.printf+0x4c):

undefined reference to
undefined reference to

__sys_ wite'
*__Ciob'

...libecr_c.
_deferredl
...libecr_c.
_writebuf.
_writebuf.
_writebuf.
...libecr_c.
alloc.c: (.
alloc.c: (.
...libecr_c.
fseek.c: (.
fseek.c: (.

a(_deferredl azyseek.0): In function ~_ flsbuf':

azyseek. c: (.text.__fl sbuf +0x88):
a(_witebuf.o): In function ~_Cwitebuf':
c:(.text._Owitebuf+0x16):
c:(.text._Owitebuf+0x26):
c:(.text._Owitebuf+0x3c):
a(alloc.o0):

In function ~_Csys_alloc':

text._Csys_al |l oc+Oxe): undefined reference to °

text._Csys_all oc+0x12): undefined reference to

a(fseek.0): In function “fseek':

text.fseek+0x16): undefined reference to

text.fseek+0x3a): undefined reference to

undefined reference to

undefined reference to
undefined reference to
undefined reference to

©__sys_appexit'

T__sys_|
T__sys_|

T __sys_istty'

*__sys_ flen'

' __sys_seek’

__sys_wite'

sys_wite'

istty'
flen'
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Or if linking against NewlibNano(None):

...libc_nano.a(lib_a-witer.o0): In function ~_wite_r":
witer.c:(.text._wite_r+0x10): undefined reference to ~_wite'
...libc_nano.a(lib_a-closer.o0): In function ~_close_r":
closer.c:(.text._close_r+0xc): undefined reference to " _close'
...libc_nano.a(lib_a-1seekr.o0): In function "~_lseek_r":

| seekr.c: (.text._| seek_r+0x10): undefined reference to " _I|seek’
...libc_nano.a(lib_a-readr.o): In function ~_read_r':

readr.c: (.text._read_r+0x10): undefined reference to ~_read
...libc_nano.a(lib_a-fstatr.o): In function ~_fstat_r":
fstatr.c:(.text._fstat_r+0xe): undefined reference to ~_fstat'
...libc_nano.a(lib_a-isattyr.o): In function "~ _isatty_r':

isattyr.c:(.text._isatty_r+0xc): undefined reference to "_isatty'

In such cases, simply change the library hosting being used (as described below), or remove the
call to the triggering C library function.

Switching the selected C library

Normally the library variant used by a project is set up when the project is first created by the
New Project Wizard. However it is quite simple to switch the selected C library between Redlib,
Newlib and NewlibNano, as well as switching the library variant in use.

To switch, highlight the project in the Project Explorer view and go to:
Quickstart -> Quick Settings -> Set library/header type

and select the required library and variant.

Manually Switching
Alternatively, you can make the required changes to your project properties manually as follows...

When switching between Newlib(Nano) and Redlib libraries you must also switch the headers
(since the 2 libraries use different header files). To do this:

1. Select the project in Project Explorer

2. Right-click and select Properties

3. Expand C/C++ Build and select Settings

4. In the Tools settings tab, select Miscellaneous under MCU C Compiler. Note: Redlib is not
available for C++ projects

5. In Library headers, select Newlib or Redlib

. In the Tools setting tab, select Architecture & Headers under MCU Assembler

7. In Library headers, select Newlib or Redlib

»

Repeat the above sequence for all Build Configurations (typically Debug and Release).

To then change the libraries actually being linked with (assuming you are using Managed linker
scripts):

. Select the project in Project Explorer

. Right-click and select Properties

. Expand C/C++ Build and select Settings

. In the Tools settings tab, select Managed Linker Script under MCU Linker

. In the Library drop-down, select the Newlib, NewlibNano or Redlib library variant that you
require (None, Nohost, Semihost, Semihost-nf).

a b wnNBE
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Again repeat the above sequence for all Build Configurations (typically Debug and Release).
Note: Redlib is not available for C++ projects.

What is Semihosting?

Semihosting is a term to describe application 10 via the debug probe. For this to operate, library
code and debug support are required.

Background to Semihosting

When creating a new embedded application, it can sometimes be useful during the early stages
of development to be able to output debug status messages to indicate what is happening as
your application executes.

Traditionally, this might be done by piping the messages over a serial cable connected to a

MCUXpresso IDE offers an alternative to this
scheme, called semihosting. Semihosting provides a mechanism for code running on the target
board to use the facilities of the PC running the IDE. The most common example of this is for the
strings passed to a printf being displayed in the IDE’s console view.

The term “semihosting” was originally termed by ARM in the early 1990s, and basically indicates
that part of the functionality is carried out by the host (the PC with the debug tools running on
it), and partly by the target (your board). The original intention was to provide 1/O in a target
environment where no real peripheral-based 1/0 was available at all.

Semihosting Implementation

The way it is actually implemented by the tools depends upon which target CPU you are running
on. With Cortex-M based MCUs, the bottom level of the C library contains a special BKPT
instruction. The execution of this is trapped by the debug tools which determine what operation
is being requested — in the case of a printf, for example, this will effectively be a “write character
to stdout”. The debug tools will then read the character from the memory of the target board —
and display it in the console window within the IDE.

Semihosting also provides support for a number of other 1/0O operations (though this relies upon
your debug probe also supporting them)... For example it provides the ability for scanf to read its
input from the IDE console. It also allows file operations, such that fopen can open a file on your
PC's hard drive, and fscanf can then be used to read from that file.

Semihosting Performance

It is fair to say that the semihosting mechanism does not provide a high performance 1/0O system.
Each time a semihosting operation takes place, the processor is basically stopped whilst the data
transfer takes place. The time this takes depends somewhat on the target CPU, the debug probe
being used, the PC hardware and the PC operating system. But it takes a definite period of time,
which may make your code appear to run more slowly.

In MCUXpresso IDE version 10.2.0 semihosting performance has been enhanced to deliver
roughly double the speed when compared with the previous IDE release. Furthermore, a new
MB library variant is been supplied that delivers a significant further improvement in performance
when combined with LinkServer debug connections. This library along new LinkServer debug
support provides the added benefit of no impact on code execution performance.

Important notes about using Semihosting

When you have linked with the semihosting library, your application will no longer work
standalone — it will only work when connected to the debugger.
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Semihosting operations cause the CPU to drop into “debug state”, which means that for the
duration of the data transfer between the target and the host PC no code (including interrupts) will
get executed on the target. Thus if your application uses interrupts, then it is normally advisable to
avoid the use of semihosting whilst interrupts are active — and certainly within interrupt handlers
themselves. If you still need to use printf, then you can retarget the bottom level of the C library to
use an alternative communication channel, such as a UART or the Cortex-M CPU’s ITM channel.

Semihosted printf and Debugging

Semihosting is common to all supported debug solutions so the implications of this mechanism
should be understood:

Projects linked against semihosting libraries that perform semihosted operations e.g. printf, can
not execute without a debugger connected. This is because semihosted operations make use of
a BreakPoint instruction that is intercepted by the debug tools to trigger the desired behaviour
(typically the printf string appearing within the IDE console). Without a debug connection, these
BreakPoint instructions will not be trapped and a Hard Fault exception will occur. By default, the
supplied Hard Fault handler implementation will be an infinite loop. Therefore if an ‘attach’ is
performed to such a target, the user will observe the code running within the hard fault handler. To
avoid this occurring, ensure that the project makes no use of semihosted operations via sending
output to a UART, using the ITM feature, commenting out semihosted operations etc.

In consequence, if for example a user had created an LED blinky application that also performed
semihosted printf operations, then without a debug connection the blinky would stop when the
first printf was executed.

Introduced in MCUXpresso IDE version 10.1.0: New projects and newly imported SDK example
projects will automatically include a semihost hardfault handler (as can be seen in the image
below). The purpose of this handler is to prevent the problem described above. Now, if a
semihosted operation is performed without debug tools attached, the new semihost hardfault
handler will be entered. The handler will check to see if a semihosted operation cause it to be
entered and if so, simply return.

v 5 MKL28Z51 2xxx7_Project

» 34 Binaries

F nit Includes

> 2 CMSIS

b 2 board

v 2 source
b [£] MKL2BZ51 2xxx7_Project.c
b [§ mth.c
» £ semihost_hardfault.c

k2 startup

In consequence, if the user creates an LED blinky application that also performs semihosted
printf operations, then without a debug connection the blinky will continue regardless of any printf
operation that may occur.

This functionality can be disabled if required by either simply deleting the handler file, or by
defining a symbol:

__ SEM HOST_HARDFAULT DI SABLE

Note: Previously created projects imported into MCUXpresso IDE (such as LPCOpen projects),
will not inherit this feature.
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Introduced in MCUXpresso IDE version 10.2.0: The inclusion of the hardfault handler can be
controlled via a preference preferences -> MCUXpresso IDE -> SDK Options -> Include semihost
hardfault handler ..., where the default is to include.

Redlib Semihost MB

@ Introduced in MCUXpresso IDE version 10.2.0: is the optional Redlib Semihost
MB library variant. This library provides enhanced semihosting performance from
LinkServer debug connections (other debug solutions will perform as before) with
the added benefit of no impact on code execution performance. There is a small
penalty of slightly larger code and data sizes compared to other Redlib Semihost
libraries. This optional library is recommended for users needing high semihosting
performance and/or have slow debug probe performance

Semihosting Specification

The semihosting mechanism used within MCUXpresso IDE is based on the specification
contained in the following document available from ARM'’s website... => ARM Developer Suite
(ADS) v1.2 Debug Target Guide, Chapter 5. Semihosting

Use of printf

By default, the output from printf() (and puts()) will be displayed in the debugger console via the
semihosting mechanism. This provides a very easy way of getting basic status information out
from your application running on your target.

For printf() to work like this, you must ensure that you are linking with a “semihost” or “semihost-
nf’ library variant.

Note: If you only require the display of fixed strings, then using puts() rather than printf() will
noticeably reduce the code size of your application.

Redlib printf Variants

Redlib provides the following two variants of printf. Many of the MCUXpresso New project wizards
provide options to select which of these to use when you create a new project.

Character vs String output

By default printf() and puts() functions will output the generated string at once, so that a single
semihosted operation can output the string to the console of the debugger. Note: these versions
of printf() /puts() make use of malloc() to provide a temporary buffer on the heap in order to
generate the string to be displayed.

It is possible to switch to using “character-by-character” versions of these functions (which do
not require heap space) by specifying the build define “CR_PRINTF_CHAR” (which should be
set at the project level). This can be useful, for example, if you are retargeting printf() to write
out over a UART (as detailed below)- as in this case it is pointless creating a temporary buffer to
store the whole string, only to then print it out over the UART one character at a time

Integer only vs full printf (including floating point)

The printf() routine incorporated into Redlib is much smaller than that in Newlib. Thus if code
size is an issue, then always try to use Redlib if possible. In addition, if your application does
not pass floating point numbers to printf, you can also select a “integer only” (non-floating point
compatible) variant of printf. This will reduce code size further.

To enable the “integer only” printf from Redlib, define the symbol “CR_INTEGER_PRINTF”" (at
the project level). This is done by default for projects created from the SDK new project wizard.
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NewlibNano printf Variants

By default, NewlibNano uses non-floating point variants of the printf and scanf family of functions,
which can help to dramatically reduce the size of your image if only integer values are used by
such functions.

If your codebase does require floating point variants of printf/scanf, then these can be enabled
by going to:

Project -> Properties -> C/C++ Build -> Settings -> MCU Linker -> Managed Linker Script and
selecting the " Enable printf/scanf float" tick box.

Newlib printf variants

Newlib provides an “iprintf” function which implements integer only printf.

Printf when using LPCOpen

If you are building your application against LPCOpen, you may find that printf output does not
get displayed in MCUXpresso IDE’s debug console by default. This is due to many LPCOpen
board library projects by default redirecting printf to a UART output.

If you want to direct printf output to the debug console instead, then you will need to modify your
projects so that:

1. Your main application project is linked against the “semihost” variant of the C library, and
2. You disable the LPCOpen board library’s redirection of printf output by either:
« locating the source file board.c within the LPCOpen board library and comment out the line:
#include retarget.h, or
« locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING

Printf when using SDK

The MCUXpresso SDK codebase provides its own printf style functionality through the macro
PRINTF. This is set up in the header file fsl_debug_console.h such that it can either point to the
printf function provided by the C library itself, or can be directly to the SDK function pseudo-printf
function : DbgConsole_Printf() . This will typically cause the output to be sent out via a UART
(which may be connected to an on-board debug probe which will sent it back to the host over a
USB VCOM channel). This is controlled by the macro SDK_DEBUGCONSOLE thus:

e |f SDK_DEBUGCONSOLE ==
e PRINTF is directed to C library printf()
» |f SDK_DEBUGCONSOLE ==
e PRINTF is directed to SDK DbgConsole_Printf()

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer
the option to configure a project so that PRINTF is directed to C library printf() by setting
SDK_DEBUGCONSOLE appropriately.

In addition, if PRINTF is being directed to the C library printf(), then if
SDK_DEBUGCONSOLE_UART is also defined, then printf output will still be directed to the
UART. Again the Advanced page of the SDK new project wizard and Import SDK examples
wizard offer an option to control this.

Retargeting printf/scanf

By default, the printf function outputs text to the debug console using the “semihosting”
mechanism.
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In some circumstances, this output mechanism may not be suitable for your application. Instead,
you may want printf to output via an alternative communication channel such as a UART or — on
Cortex-M3/M4 — the ITM channel of SWO Trace. In such cases you can retarget the appropriate
portion of the bottom level of the library.

The section “How to use ITM Printf” below provides an example of how this can be done.

Note: when retargeting these functions, you can typically link against the “nohost” variant of the
C Library, rather than the “semihost” one.

Redlib

To retarget Redlib’s printf(), you need to provide your own implementations of the function
__sys_write():

int __sys_ wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

Similarly if you want to retarget scanf(), you need to provide your own implementations of the
function __sys_readc():

int __sys_readc(void)

Function returns character read
Note: these two functions effectively map directly onto the underlying “semihosting” operations.
Newlib / NewlibNano

To retarget printf(), you will need to provide your own implementation of the Newlib system
function _write():

int _wite(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of unwritten bytes if error, otherwise 0 for success

To retarget scanf, you will need to provide your own implementation of the Newlib system function
_read():

int _read(int iFileHandl e, char *pcBuffer, int ilLength)

Function returns number of characters read, stored in pcBuffer

More information on the Newlib system calls can be found at: https://sourceware.org/newlib/
libc.html#Syscalls

How to use ITM Printf

ITM Printf is a scheme to achieve application 10 via a debug probe without the usual semihosting
penalties.

ITM Overview

As part of the Cortex-M3/M4 SWO Trace functionality available when using an LPC-Link2 (with
NXP’s CMSIS-DAP firmware), MCUXpresso IDE provides the ability to make use of the ITM :
The Instrumentation Trace Macrocell (ITM) block provides a mechanism for sending data from
your target to the debugger via the SWO trade stream. This communication is achieved through
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a memory-mapped register interface. Data written to any of 32 stimulus registers is forwarded to
the SWO stream. Unlike other SWO functionality, using the ITM stimulus ports requires changes
to your code and so should not be considered non-intrusive.

Printf operations can be carried out directly by writing to the ITM stimulus port. However the
stimulus port is output only. And therefore scanf functionality is achieved via a special global
variable, which allows the debugger to send characters from the console to the target (using
the trace interface). The debugger writes data to the global variable named ITM_RxBuffer to be
picked up by scanf.

Note: MCUXpresso IDE currently only supports ITM via stimulus port 0.

Note: For more information on SWO Trace, please see the MCUXpresso IDE LinkServer SWO
Trace Guide.

ITM printf with SDK

The Advanced page of the SDK new project wizard and Import SDK examples wizard offer the
option to configure a project so as to redirect printf/scanf to ITM. Selecting this option will cause
the file retarget_itm.c to be generated in your project to carry out the redirection.

ITM printf with LPCOpen

To use this functionality with an LPCOpen project you need to: Include the file retarget_itm.c in
your project — available from the Examples subdirectory of your IDE installation Ensure you are
using a semihost, semihost-nf, or nohost C library variant. Then simply add calls to printf and
scanf to your code.

If you just linking against the LPCOpen Chip library, then this is all you need to do. However if you
are also linking against an LPCOpen board library then you will likely see build errors of the form:

../src/retarget.h:224: nultiple definition of ~__sys wite'

../src/retarget.h:240: nultiple definition of ~_ sys_readc’

locating the file board.h and enable the line: #define DEBUG_SEMIHOSTING, or locating
the source file board.c within the LPCOpen board library and comment out the line: #include
"retarget.h"

itoa() and uitoa()

itoa() is non-standard library function which is provided in many other toolchain to convert an
integer to a string.

Redlib

To ease porting, MCUXpresso IDE provides two variants of this function in the Redlib C library....

char * itoa(int value, char *vstring, unsigned int base);
char * uitoa(unsigned int value, char *vstring, unsigned int base);

which can be accessed via the system header....

#i ncl ude <stdlib. h>

itoa() converts an integer value to a null-terminated string using the specified base and stores
the result in the array pointed to by the vstring parameter. Base can take any value between 2
and 16; where 2 = binary, 8 = octal, 10 = decimal and 16 = hexadecimal.
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If base is 10 and the value is negative, then the resulting string is preceded with a minus sign (-).
With any other base, value is always considered unsigned. The return value to the function is a
pointer to the resulting null-terminated string, the same as parameter vstring.

uitoa() is similar but treats the input value as unsigned in all cases.

Note: the caller is responsible for reserving space for the output character array — the
recommended length is 33, which is long enough to contain any possible value regardless of
the base used.

Example invocations

char vstring [33];
itoa (value,vstring,10); // convert to decinal
itoa (value,vstring, 16); // convert to hexadeci mal

itoa (value,vstring,8);; // convert to octal

Standards compliance

As noted above, itoa() / uitoa() are not standard C library functions. A standard-compliant
alternative for some cases may be to use sprintf() - though this is likely to cause an increase in
the size of your application image:

sprintf(vstring,"%l",value); // convert to decimal
sprintf(vstring,"%",value); // convert to hexadeci mal
sprintf(vstring,"%",value); // convert to octal

Newlib/NewlibNano

Newlib and NewlibNano now also provide similar functionality though with slightly different
naming - itoa() and utoa().

Libraries and linker scripts

When using the managed linker script mechanism, as described in the chapter “Memory
configuration and Linker Script Generation”, then the appropriate settings to link against the
required library family and variant will be handled automatically.

However if you are not using the managed linker script mechanism, then you will need to define
which library files to use in your linker script. To do this, add one of the following entries before
the SECTION line in your linker script:

¢ Redlib (None), add
* [C project only]: GROUP (libcr_c.a libcr_eabihelpers.a)
* Redlib (Nohost), add
 [C projects only]: GROUP (libcr_nohost.a libcr_c.a libcr_eabihelpers.a)
¢ Redlib (Semihost-nf), add
* [C projects only]: GROUP (libcr_semihost_nf.a libcr_c.a libcr_eabihelpers.a)
* Redlib (Semihost), add
e [C projects only]: GROUP (libcr_semihost.a libcr_c.a libcr_eabihelpers.a)

« NewlibNano (None), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_none.a)

* [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a libcr_newlib_none.a)
* NewlibNano (Nohost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_nohost.a)
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o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++_nano.a libm.a
libcr_newlib_nohost.a)

NewlibNano (Semihost), add

¢ [C projects]: GROUP (libgcc.a libc_nano.a libm.a libcr_newlib_semihost.a)

o [C++ projects]: GROUP (libgcc.a libc_nano.a libstdc++ _nano.a libm.a
libcr_newlib_semihost.a)

Newlib (None), add

* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_none.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_none.a)
Newlib (Nohost), add

e [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_nohost.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_nohost.a)
Newlib (Semihost), add

* [C projects]: GROUP (libgcc.a libc.a libm.a libcr_newlib_semihost.a)

e [C++ projects]: GROUP (libgcc.a libc.a libstdc++.a libm.a libcr_newlib_semihost.a)

In addition, if using NewlibNano, then tick box method of enabling printf/scanf floating point
support in the Linker pages of Project Properties will also not be available. In such cases, you
can enabling floating point support manually by going to:

Project Properties -> C/C++ Build -> Settings -> MCU Linker -> Miscellaneous
and entering -u _printf_float and/or -u _scanf_float into the “Linker flags” box.

A further alternative is to put an explicit reference to the required support function into your project
codebase itself. One way to do this is to add a statement such as:

asm (“.global _printf_float”);

to one (or more) of the C source files in your project.
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17. Memory Configuration and Linker Scripts

17.1

Introduction

A key part of the core technology within MCUXpresso IDE is the principle of a default defined
memory map for each MCU. For devices with internal Flash, this will also specify a Flash driver
to be used to program that Flash memory (for use with LinkServer “native” debug probes).

For preinstalled MCUs, the definition of the memory map is contained within the MCU part
knowledge that is built into the product. For MCUs installed into MCUXpresso IDE from an SDK,
the definition of the memory map is loaded from the manifest file within the SDK structure.

But in both cases, the defined memory map is used by MCUXpresso IDE to drive the “managed
linker script” mechanism. This auto-generates a linker script to place the code and data from
your project appropriately in memory, as well as being made available to the debugger.

A project’s memory map can be viewed and modified by the user to add, remove (split/join) or
reorder blocks using the in place Memory Configuration Editor. For example, if a project targets
an MCU that supports external Flash (e.g. SPIFI), then it's memory map can be easily extended
to define the SPIFI memory region (base and size). In addition, an appropriate Flash driver can
be associated with the newly defined region.

Figure 17.1. Memory Configuration

Memory details (MK6E4FN1MOxxx12)*

Default LinkServer Flash Driver:

Default LinkServer Flash Driver Browse...
Type Name Alias Location Size Driver —
Flash PROGRAM_FLASH Flash Ox0 0x100000 FTFE_4K.cfx v

RAM  SRAM_UPPER RAM 0x20000000 0x30000

RAM  SRAM_LOWER RAMZ  Ox1fff0O000 0x10000 s

RAM FLEX_RAM RAM3  0x14000000 0x1000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...

Refresh MCU Cache

17.2

MCUXpresso IDE User Guide -

New in MCUXpresso IDE v10.3.0 Memory configurations can be edited directly in place rather
than requiring a separate Edit to launch a separate dialogue. In place editing of memory
configurations is incorporated within all project wizards and project properties views.

Managed Linker Script Overview

By default, the use of “managed linker scripts” is enabled for projects. This mechanism allows
MCUXpresso IDE to automatically create a script for each build configuration that is suitable
for the MCU selected for the project, and the C libraries being used. It will create (and at times
modify) three linker script files for each build configuration of your project:

<proj nane>_<bui l dconfig>_lib.ld
<proj nane>_<bui | dconfi g> nmem | d

<proj nane>_<bui | dconfig>.1d
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This set of hierarchical files are used to define the C libraries being used, the memory map of
the system and the way your code and data is placed into the memory map. These files will be
located in the build configuration subdirectories of your project (typically — Debug and Release).

Figure 17.2. Project Explorer Debug folder Linker Scripts

[(5 Project Ex &2 |2, Peripheral ! Registers 1. SymbolVi =
=l
b 4 Binaries
b il Includes
» EECMSIS
b 2 accel
» 2 board
» L drivers
» 2 source
b E startup
b (2 utilities
¥ = Debug
b =accel
¥ (= board
F = CMSIS
b (=drivers
> = source
F = startup
b = utilities
b %5 frdmk64f demo_apps bubble.axf - [arm/le
=| frdmk64f_demo_apps_bubble_Debug_library.ld
frdmk64f_demo_apps_bubble_Debug_memory.ld
=| frdmk64f demo_apps_bubble Debug.ld
= frdmk64f_demo_apps_bubble.map
| & makefile
| & objects.mk
| @ sources.mk
» = doc
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The managed linker script mechanism also automatically takes into account memory map
changes made in the Memory Configuration Editor as well as other configuration changes, such
as C/C++ library settings.

How are Managed Linker Scripts Generated?

MCUXpresso IDE passes a set of parameters into the linker script generator (based on the
“FreeMarker” scripting engine) to create an appropriate linker script for your project. This
generator uses a set of conditionally parsed template files, each of which control different aspects
of the generated linker script.

It is possible to modify certain aspects of the generated linker script by providing one or more
modified template files locally within linkscripts folder of project directory structure. Any such
templates that you provide locally will then override the default ones built into MCUXpresso IDE.
A full set of the default linker templates (.Idt) files are provided inside \Wizards\linker subdirectory
of your IDE install.
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17.4 Default Image Layout

Code and initial values of initialised data items are placed into first bank of Flash (as show in
memory configuration editor). During startup, MCUXpresso IDE startup code copies the data into
the first bank of RAM (as show in memory configuration editor), and zero initializes the BSS data
directly after this in memory. This process uses a global section table generated into the image
from the linker script.

Other RAM blocks can also have data items placed into them under user control, and the startup
code will also initialise these automatically. See later in this chapter for more details.

Figure 17.3. Default Memory Layout
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Note: The above memory layout is simply the default used by the IDE’s managed linker script
mechanism. There are a number of mechanisms that can be used to modify the layout according
to the requirements of your actual project — such as simply editing the order of the RAM banks
in the Memory Configuration Editor. These various methods are described later in this chapter.

The default memory layout will also locate the heap and stack in the first RAM bank, such that:

« the heap is located directly after the BSS data, growing upwards through memory
« the stack located at the end of the first RAM bank, growing down towards the heap

Again this heap and stack placement is a default and it is very easy to modify the locations for
a particular project, as will be described later in this chapter.

Note: When you import a project, you may find that the defaults have already been modified.
Check the Project Properties to confirm the exact details.
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17.5 Examining the layout of the generated image
Looking at the size of the AXF file generated by building your project on disk does not provide any
information as to how much Flash/RAM space your application will occupy when downloaded
to your MCU. The AXF file contains a lot more information than just the binary code of
your application, for example the debug data used to provide source level information when
debugging, that is never downloaded to your MCU.
17.5.1 Linker --print-memory-usage

MCUXpresso IDE projects use the --print-memory-usage option on the link step of a build to
display memory usage information in the build console of the following form:

Menory regi on Used Size Regi on Si ze %ge Used

PROGRAM_FLASH: 26764 B 1 MB 2.55%

SRAM_UPPER: 8532 B 192 KB 4. 34%

SRAM_LOVNER: 0 & 64 KB 0. 00%

FLEX_RAM 0 & 4 KB 0. 00%

Fi ni shed building target: frdnk64f_deno_apps_bubbl e. axf
The memory regions displayed here will match up to the memory banks displayed in the memory
configuration editor when the managed linker script mechanism is being used.
By default, the application will build and link against the first Flash memory found within the MCU'’s
memory configuration. For most MCUSs there will only be one Flash device available. In this case
our project requires 26764 bytes of Flash memory storage, 2.55% of the available Flash storage.
RAM will be used for global variable, the heap and the stack. MCUXpresso IDE provides a flexible
scheme to reserve memory for Stack and Heap. This build has reserved 4KB each for the stack
and the heap contributing 8KB to the overall 8532 bytes reported.
If using the 'LPCXpresso style' of heap and stack placement (described later in this chapter), the
RAM consumption provided by this is only that of your global data. It will not include any memory
consumed by your stack and heap when your application is actually executing.
Note: project imported into MCUXpresso IDE may not have been created with this option. To add
this, right click on the project and select C/C++ Build ->Settings -> MCU Linker -> Miscellaneous
then click ‘+’ and add --print-memory-usage

17.5.2 arm-none-eabi-size
In addition, a post-build step will normally invoke the arm-none-eabi-size utility to provide this
information in a slightly different form....
text dat a bss dec hex filenane
2624 524 32 3180 c6e LPCXpressol768_systi ck_tw nkl e. axf
¢ text - shows the code and read-only data in your application (in decimal)
« data - shows the read-write data in your application (in decimal)
* bss - show the zero initialized (‘bss’ and ‘common’) data in your application (in decimal)
e dec - total of ‘text’ + ‘data’ + ‘bss’ (in decimal)
¢ hex - hexadecimal equivalent of 'dec’
Typically:
MCUXpresso IDE User Guide - All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.
User Guide Rev. 10.3.0 — 16 November, 2018 157



NXP Semiconductors MCUXpresso IDE User Guide

17.5.3

17.5.4

MCUXpresso IDE User Guide -

 the Flash consumption of your application will then be text + data
« the RAM consumption of your application will then be data + bss

Again if using the 'LPCXpresso style' of heap and stack placement (described later in this
chapter), the RAM consumption will not include any memory allocated for your stack and heap
when your application is actually executing.

You can also manually run the arm-none-eabi-size utility on both your final application image, or
on individual object files within your build directory by right clicking on the file in Project Explorer
and selecting the Binary Utilities -> Size option.

Linker Map Files

The linker option “-map” option, which is enabled by default by the project wizard when a new
project is created, allows you to analyse in more detail the contents of your application image.
When you do a build, this will cause a file called projectname.map to be created in the Debug (or
Release) subdirectory, which can be loaded into the editor view. This contains a large amount
of information, including:

¢ Alist of archive members (library objects) included with details

¢ Alist of discarded input sections (because they are unused and the linker option --gc-sections
is enabled).

« The location, size and type of all code, data and bss items that have been placed in the image

Symbol Viewer

The Symbol Viewer provides a simple way of displaying the symbols in an object, library archive
or executable. By default, this is located in the top left of the MCUXpresso IDE window, in parallel
with the Project Explorer view.

Viewing Symbols in the Viewer

To open an image in the Symbol Viewer, either highlight it in the Project Explorer Views and
use the context sensitive menu ‘Tools->View Symbols’ menu, or use the Browse button on the
Toolbar within the Symbol Viewer windows itself

The Symbol Viewer can display object files (.0), libraries (.lib .a) and executables (.axf or .elf)
The image will be processed and displayed in the Symbol Viewer as shown in the next section.

It is possible to open multiple Symbol Viewers by pressing the ‘Green +' icon in the toolbar. The
symbols for different images can then be displayed simultaneously.

Using the Symbol Viewer

When first opening a file, the viewer will display the sections found in the file (e.g. .text, .bss etc).
Expanding a section will show the symbols within that section. Clicking on the symbol name will
open the source file in an editor window at the symbol definition (if source is available).

The columns of the symbol viewer show information about the symbols:

¢ Symbol Name:
¢ Address: The address (or value) of the Symbol

¢ Size: The size of the symbol, in bytes. For functions this would be the size of the function. For
variables, this would be the size occupied by the variable

* Flags: The type of the Symbol. Typically this would be Local or Global and Function or Object
(data variable)

All information provided in this document is subject to legal disclaimers © 2018 NXP Semiconductors. All rights reserved.

User Guide

Rev. 10.3.0 — 16 November, 2018 158



NXP Semiconductors

MCUXpresso IDE User Guide

[(5 Project Explorer = Peripherals+ 1} Registers | £ Symbol Viewer 2 = el
E Q;;ca "'='€> R
Symbol Address (Range) Size Flags
¥MKB4FN1MOxxx12_Project.axf
» text (00000000-000... 8212 Local Debug
¥ .data (20000000-200... 4 Local Debug
SystemCoreClock 20000000 4 Global Object
_data 20000000 0 Global
_edata 20000004 0 Global
.data_RAM2 [ODOODDOD 000... O Local Debug
E_I
A bss (2000{}004 200 19 Local Debug
i.5865 20000004 4 Local Object
ermo 20000010 4 Global Object
_ebss 2000008 0 Global
_bss 20000004 0 Global
__heaps 20000008 4 Global Object
__end_of_heap 2000000¢ 4 Global Object
__Ciob 20000014 180 Global Object
¥ .uninit_RESERVED (00000000-000... O Local Debug
_end_uninit_ RESERVED 20000000 0 Global
noinit_ BAM2 (00000000-000... O Local Debug
noinit_BAM3 (00000000-000... O Local Debug
» .noinit (00000000-000... O Local Debug
¥ .heap (00000000-000... O Local Debug
_pvHeapLimit 200010c8 1] Global
_pvHeapStart 200000c8 0 Global
heap2stackfill (00000000-000... O Local Debug
b .stack (00000000-000... O Local Debug
F*ABS* (00000000-000... O Local Debug

Figure 17.4. Symbol Viewer

Note: The symbols displayed are a snapshot of the symbols for a particular build, therefore these
should be refreshed when a new build is performed. This can easily be done using the Reload
icon in the Symbol Viewer window.

Other Utilities

The arm-none-eabi-nm utility is effectively a command line version of the Symbol Browser. But
it can sometime be useful when looking at the size of your application, as it can produce some
of the information provided in the linker map file but in a more concise form. For example:

ar m none- eabi

-nm-S --size-sort -s project.axf

produces a list of all the symbols in an image, their sizes and their addresses, listed in size order.
For more information on this utility, please see the GNU binutils documentation.

Note: you can run arm-none-eabi-nm as a post-build step, or else open a command shell using
the status bar shortcuts (at the bottom of the IDE window).

17.6 Other Options affecting the Generated Image

17.6.1 LPC MCUs — Code Read Protection

Most of NXP’s LPC Cortex-M based MCUs which have internal Flash memory contain “Code
Read Protection” (CRP) support. This mechanism uses one of a number of known values being
placed in a specific location in Flash memory to provide a number of levels of protection. When
the MCU boots, this specific location in Flash memory is read and depending upon its value, the
MCU may prevent access to the Flash memory by external devices. This location is typically at
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0x2FC though for LPC18xx/43xx parts with internal Flash, the CRP location is at an offset of
0x2FC from the start of the Flash bank being used.

CRP : Preinstalled MCUs

Support for setting up the CRP memory location is provided via a combination of the Project
Wizard, a header file and a number of macros. This support allows specific values to be easily
placed into the CRP memory location, based on the user’s requirements.

The New Project wizard contains an option to allow linker support for placing a CRP word to be
enabled when you create a new project. This is typically enabled by default. This wizard option
actually then controls the “Enable CRP” checkbox of the Project Properties linker Target tab.

In addition, the wizard will create a file, ‘crp.c’ which defines the ‘CRP_WORD’ variable which will
contain the required CRP value. A set of possible values are provided by the NXP/crp.h header
file that this then includes. Thus for example ‘crp.c’ will typically contain:

#i ncl ude <NXP/crp. h>
__CRP const unsigned int CRP_WORD = CRP_NO CRP ;

which is then placed at the correct location in Flash by the linker script generated by the managed
linker script mechanism:

. = 0x000002FC ;
KEEP(*(.crp))

Note: the value CRP_NO_CRP ensures that the Flash memory is fully accessible. When you
reach the stage of your project where you want to protect your image, you will need to modify
the CRP word to contain an appropriate value.

Important Note: You should take particular care when modifying the value placed in the CRP
word, as some CRP settings can disable some or all means of access to your MCU (including
debug). Before making use of CRP, you are strongly advised to refer to the User Manual for the
LPC MCU that you are using.

CRP : MCUs installed by Importing an SDK

The support for CRP in LPC parts imported into MCUXpresso IDE from an SDK, is generally
similar to the Preinstalled MCUs. However rather than having a separate crp.c file, the
CRP_WORD variable definition is generally found within the startup code.

Kinetis MCUs — Flash Config Blocks

Kinetis MCUs provides an alternative means of protecting the user’s image in Flash using the
Flash Configuration Block. The Flash Configuration Field is generally located at addresses
0x400-0x40F and unlike the LPC CRP mechanism only specific values give access, whereas
any other values are likely to lock the part.

The value of the Flash Configuration block for a project is provided by the following structure
which will be found in the startup code:

_attribute__ ((used,section(".FlashConfig"))) const struct {
unsi gned int wordil;
unsi gned int word2;
unsi gned int word3;
unsi gned i nt word4;

} Flash_Config = {OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFF, OxFFFFFFFE};
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which is then placed appropriately by the linker script generated by the managed linker script
mechanism.

/* Kinetis Flash Configuration data */
= 0x400 ;

PROVI DE(__FLASH CONFI G START__ = .) ;

KEEP(* (. Fl ashConfi g))

PROVI DE(__FLASH CONFIG END__ = .) ;

ASSERT( ! (__FLASH CONFI G_START__ == __FLASH CONFI G_END__),
"Li nker Flash Config Support Enabled, but no .FlashConfig
section provided within application");

/* End of Kinetis Flash Configuration data */

Important Note: The support for placing the Flash Configuration Block can be disabled by

unticking a checkbox of the Project Properties linker Target tab. However this is generally not
advisable as it is very likely to result in a locked MCU.

@@ Properties for frdmk&4f_demo_apps_bubble
Settings o -
*Resource
Tgbjgiirzuild Configuration: | Debug [ Active ] k4 | Manage Configurations...
Build Variables
Environment
Logging A Build steps Build Artifact [ Binary Parsers @ Error Parsers
MCU settings
?Etch‘:ghS r v i MCU C Compiler Manage linker script
ol Chain Editor 3
» C/C++ General %:Dlalecl Enable automatic placement of Flash Configuration field in image )
2 Preprocessor - =
Project References glnclzdes Link application to RAM
Run/Debug Settings 2 Optimization Stack offset 0
»Task Repository = . =
i (2 Debugging . - i 7 ;
WikiText @Warnings Library Redlib (semihost-nf) ﬁ
EMiscellanecus
# Architecture
¥ & MCU Assembler E :
@ General Linker script
(& Architecture & Headers Script path
¥ i3 MCU Linker —
(EGeneral Heap and Stack placement = MCUXpresso Style [T
@ Libraries Region Location Size
@Mmcelianleous ) Heap Default Post Data Default
(¥ Shared Library Settings  gtack Default End Default
(E Architecture
# Managed Linker Script
EMulticore
Restore Defaults Apply
Figure 17.5. Linker Settings

17.6.3 Placement of USB Data

For MCUs where part support is imported from an SDK, the managed linker script mechanism
supports the automatic placement of USB global data (as used by the SDK USB Drivers),
including for parts with dedicated USB_RAM (small or large variants).
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17.6.4

Plain Load Image

The LPC540xx family provides no built-in flash, but rather offers a quad SPI Flash Interface
(SPIFI) so that external flash can be used. The most straight forward way of using external flash
is that the image is built to be programmed into the external flash and executed directly from the
same location (XIP — eXecute In Place).

However the LPC540xx boot rom also offers an alternative way of using the external flash — such
that the application is programmed into the flash, but the boot rom will relocate it into a bank of
the onboard SRAM for execution. Generally it is expected that the SRAMX bank (at address 0x0)
will be used for this. An application that runs in this manner is known as a “plain load image”.

MCUXpresso IDE’s managed linker script mechanism offers a simple way of configuring an
application project so that it will build as a plain load image. This can be controlled for a particular
build configuration via:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

v @E;'I’CU Assembler Link application to RAM
& - - -
QG"”?‘*" Plain load image SRAMX <]
(=2 Architecture & Headers .

i MCU Linker H Generate an image suitable for relocating by a Style ﬂ
\M General bootloader from its load address in Flash toan ¢
(5 Libraries Iote:ute addressr:r' f:eds:‘;uc:asltho "plain
T i "on
E}M\SCEHEDEDUS load image” on the XX devices

=4 . 3 Region Location Size
(% Shared Library Settings

17.6.5
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4 3 Heap Default Post Data Default
g:ﬂr:::::;ui;km Script Stack Default End Default
E'_};Mu!ticore
Figure 17.6. Plain Load Image
Please see also the shortcuts.

Enabling the “Plain load image” option will:

1. Modify the generated linker script so that the main code section is located so that it will be
programmed into flash, but expect to be copied into specified RAM bank by the boot rom
before being executed

2. Modify the startup code, using symbols provided from the generated linker script, so that the
appropriate data is placed into the image so that the boot rom know that it needs to relocate
the image from flash into RAM.

Note 1: This functionality requires the application project to be based on the LPC540xx part
support from SDK v2.4.0 (or later).

Note 2: The size of the application image (including the initialised global data) must be less than
the size of the RAM bank that the code will execute from.

Note 3: LPC540xx supports plain load images being executed from either address 0x0 or address
0x20000000. However if the RAM at 0x20000000 is used then the debugger will not be able to
stop on the default breakpoint on main(). This is because a hardware breakpoint needs to be
used (as the copying of the code from flash into RAM by the boot rom would overwrite a software
breakpoint), but the Cortex-M4 cannot set a hardware breakpoint this high in the memory map.

Link Application to RAM

The MCUXpresso IDE managed linker mechanism defaults to placing the code and initialised
data values to first Flash region listed within a projects memory configuration as discussed in the
section.
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On occasion, it can be useful to debug a project directly from RAM since this offers some benefits
such as avoiding the flash programming element of the debug session etc. Linking to RAM could
be achieved by deleting the Flash memory regions from the projects memory configuration and
rebuilding the application — however this is not the most convenient approach!

Therefore MCUXpresso IDE offers the option to tell the managed linker script mechanism to
simply ignore any flash regions listed in the projects memory configuration via a simple checkbox
at:

Project -> Properties -> C/C++ Build -> Settings -> Tools Settings -> MCU Linker -> Managed
Linker Script

¥ i MCU Assembler

17.7

MCUXpresso IDE User Guide -

(EGeneral Link application to RAM
(£ Architecture & Headers L
¥ B3 MCU Linker Link all sections to RAM (i.e. ignore Flash)
# General
@ Libraries Heap and Stack placement | MCUXpresso Style 7|
L{-;EMiscaI\anenus Stack offset 0
(¥ Shared Library Settings
(B Architecture Region Location Size
-;_‘i?Managed Linker Script Heap Default Post Data Default
(% Multicore Stack Default End Ox4
Figure 17.7. Link to RAM
Please see also the shortcuts.

With this option is set, the application will instead link to the first RAM region listed within the
projects memory configuration.

There are two important considerations when developing with RAM based projects:

1. They require support from the debug environment to be run and so may not execute in the
exactly the same manner as a true application running from an MCU reset. Please see the
section for more information. Please note: if you are
using debug solutions other than LinkServer, additional user setup may be required.

2. Unlike project running from Flash, global variable load and execute addresses will by default
be the same. The consequence of this is that global variables values will persist at their
current value if an application is restarted. Therefore this is not recommended, and instead a
restart should be achieved by terminating and restarting the whole debug session. See also:

Note: Some MCU/development boards make use of SDRAM. These memories are typically
initialised by the MCU BootROM during reset and this initialisation may require user supplied
configuration data to be programmed into flash. Therefore you must ensure that any SDRAM
regions are correctly initialised before they are used for RAM based debug operations.

Modifying the Generated Linker Script / Memory Layout

The linker script generated by the managed linker script mechanism will be suitable for use,
as is, for many applications. However in some circumstances you may need to make changes.
MCUXpresso IDE provides a number of mechanisms to allow you to do this whilst still being able
to use the managed linker script mechanism. These include:

« Changing the layout and order of memory using the Memory Configuration Editor

« Changing the size and location of the stack and heap using the Heap and Stack Editor

» Decorating the definitions of variables and functions in your source code with macros from the
cr_section_macros.h to cause them to be placed into different memory blocks

« Providing project specific versions of FreeMarker linker script templates to change particular
aspects of how the managed linker script mechanism creates the final linker script
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17.8

The following sections describe these in more detail.

Using the Memory Configuration Editor
The Memory Configuration Editor is accessed via the MCU settings dialog, which can be found at
Project Properties -> C/C++ Build -> MCU settings

This lists the memory details for the selected MCU, and will, by default, display the memory
regions that have been defined by MCUXpresso IDE itself (from installed or SDK part support).

[ ] @ Properties for LPC4337
| MCU settings -
| »Resource
Builders . Available parts
¥ C/C++ Build __IDE )
Build Variables
Environment .
Loaging SDK MCUs Preinstalled MCUs
MCU settings MCUs from installed SDKs MCUs from preinstalled LPC and generic
Settings Target Cortex-M part support
Tool Chain Editor > K32W0x2S NXP LPC4337
»C/C++ General »KBx LPC4337
Project References FKL2x LPC4337-MO
Run/Debug Settings »LPC5411x LPC4350
Task Tags »LPC548xx LPC4350-M0
» Validation »LPC55xx LPC4353
»LPCBNO4 LPC4353-M0
»MIMXRT1050 LpC4357
»MIMXRT1064 LPC4357-M0
LPC4367
LPC4367-M0
1 DrA2TN
Target architecture: cortex-mé
Preserve memary configuration
Memory details (LPC4337)
Detault LinkServer Flash Driver | LPC18x7_43x7_2x51 Z_EnotA,chd Browse...
( Type Name Alias Location Size Driver .
| Flash MFlashA512 Flash 0x1a000000 0x80000 x
Flash MFlashB512 Flash2 0x1b000000 0x80000
RAM RamLoc32 RAM 0x10000000 0x8000
] RAM RamLoc40 RAM2 0x10080000 0xa000
RAM RamAHB32 RAM3 0x20000000 0x8000
RAM RamAHB16 RAM4 0x20008000 0x4000
RAM RamAHB_ETB16 RAMS 0x2000¢000 0x4000
Add Flash Add RAM Split Delete
Import... Merge... Export... Generate...
Refresh MCU Cache
Restore Defaults Apply
@ Cancel

Figure 17.8. LPC4337... default memory regions

17.8.1
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Editing a Memory Configuration

In the example below, we will show how the default memory configuration for an LPC4337... can
be changed.

New in MCUXpresso IDE v3.0, the memory configuration can simply be edited in place to create
the desired memory map.
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Default LinkServer Flash Driver LPC18x7_43x7_2x512_BootA.cfx Browse...
Type Name Alias Location Size Driver —
Flash MFlashA512 Flash 0x1a000000 0x80000 L
Flash MFlashB512 Flash2  0x1b000000 0x80000 =
RAM RamLoc32 RAM 0x10000000 0x8000 -
RAM RamLoc40 RAM2 0x10080000 Oxa000

RAM RamAHB32 RAM3 0x20000000 0x8000

RAM RamAHB16 RAM4 0x20008000 0x4000

RAM RamAHB_ETB16 RAMS 0x2000c000 0x4000

Add Flash Add RAM Split Delete

Import... Merge... Export... Generate...

Figure 17.9. Memory configuration editor

Known blocks of memory, with their type, base location, and size are displayed. Entries can be
created, deleted, etc by using the provided buttons.

For simplicity, the additional memory regions are given sequential aliases, starting from 2, so
RAM2, RAM3 etc (as well as using their “formal” region name — for example RamAHB32).

Table 17.1. Memory editor controls

Button Details

Add Flash Add a new memory block of the appropriate type.

Add RAM Add a new memory block of the appropriate type.

Split Split the selected memory block into two equal halves.

Join Join the selected memory block with the following block (if the two are contiguous).

Delete Delete the selected memory block.

Import Import a memory configuration that has been exported from another project,
overwriting the existing configuration.

Merge Import a partial memory configuration from a file, merging it with the existing memoryj

configuration. This allows you, for example, to add an external Flash bank definition
to an existing project.

Export Export a memory configuration for use in another project.

Up / Down Reorder memory blocks. This is important: if there is no Flash block, then code will
be placed in the first RAM block, and data will be placed in the block following the|
one used for the code (regardless of whether the code block was RAM or Flash).

Generate Generates local part support for the selected MCU.

Driver Highlighted in blue, shows the selection of a per-Flash region Flash driver. Click
this field to see a drop down of all available drivers. Please see:

Browse(Flash driver) Select the appropriate driver for programming the Flash memory specified in
the memory configuration. For more information please see the section on

The name, location, and size of this new region can be edited in place. Note: When entering
the size of the region, you can enter full values in decimal or in hex (by prefixing with ox), or by
specifying the size in kilobytes or megabytes. For example:

¢ To enter a region size of 32KB, enter 32768, 0x8000 OF 32k.
« To enter a region size of 1MB, enter 0x100000 OF 1m

Note: Memory regions must be located on four-byte boundaries, and be a multiple of four bytes

in size.
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